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In virtual reality, we're placing the viewer inside a moment or a
story... made possible by sound and visual technology that's
actually tricking the brain into believing it's somewhere else.

Na realidade virtual, estamos colocando o espectador
dentro de um momento ou de uma histéria... tornada
possivel pela tecnologia sonora e visual que realmente estd
iludindo o cérebro para acreditar que esta em outro lugar.

Chris Milk
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RESUMO

PERGHER, Bruno. S. Sistematizagdo de criagdo de conteudo interativo 3D (WebGL)
aplicado ao Design Virtual. 2017. 229 f. Disserta¢do (Mestrado em Design) — Escola de

Engenharia, Universidade Federal do Rio Grande do Sul, Porto Alegre, 2017.

Na medida em que surgem novas tecnologias de criagdao de ambientes tridimensionais
virtuais, como o WebGL, ampliam-se as possibilidades de uso destes e possibilita-se um
aprimoramento da qualidade grafica e das formas de interagdo com os mesmos. A
presente pesquisa objetiva aproximar designers e a promissora tecnologia WebGL,
ainda muito ligada a conhecedores da programacao computacional escrita e distante de
grande parte dos designers. Com isso, visa-se melhorar a qualidade de criacdo e
distribuicdo dos trabalhos de Design Virtual. Para tal, propde-se uma sistematica de
criacdo de conteudos interativos tridimensionais utilizando o padrdo WebGL, balizada
por requisitos estipulados com base na revisdo bibliografica do assunto. Dentre os
principais requisitos estdo a utilizacdo de softwares e recursos que ndao exijam
conhecimentos prévios de linguagem escrita de programacdo, a compreensao dos trés
principais pilares dos ambientes virtuais 3D (modelagem, animacdo e interacao) e a
exportacdo facilitada do conteudo criado em um arquivo (HTML) executavel nos
principais navegadores web, empregando o padrdao WebGL, sem o uso de qualquer
complemento (plug-in). Apds a andlise de 34 ferramentas, escolheu-se o conjunto de
programas Blender + Blend4Web para ser utilizado na sistematica. Como resultado,
obteve-se uma sistemdtica de criacdo de ambientes virtuais tridimensionais com
recursos bastante diversificados, que se mostrou util na atualizacdo dos conhecimentos

de estudantes e profissionais de Design Virtual.

Palavras-chave: Design Virtual; Ambientes Tridimensionais; WebGL.
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ABSTRACT

PERGHER, Bruno. S. Sistematizagdo de criagdo de conteudo interativo 3D (WebGL)
aplicado ao Design Virtual. 2017. 229 f. Disserta¢do (Mestrado em Design) — Escola de

Engenharia, Universidade Federal do Rio Grande do Sul, Porto Alegre, 2017.

As new technologies for the creation of three-dimensional virtual environments, such as
WebGL, the possibilities of their use are expanded and it is possible to improve the
graphic quality and the ways of interacting with them. The present research aims to
approach designers and the promising WebGL technology, still very much related to the
knowledge of the written and distant programming of most of the designers. With this,
it aims to improve the quality of creation and distribution of the Virtual Design works.
For this, a systematic creation of three-dimensional interactive contents using the
WebGL standard is proposed, based on requirements stipulated based on the
bibliographic review of the subject. Among the main requirements are the use of
software and resources that do not require prior knowledge of written programming
language, understanding the three main pillars of 3D virtual environments (modeling,
animation and interaction) and facilitating the export of content created in a file (HTML)
executable in major web browsers, employing the WebGL standard, without the use of
any plug-in. After the analysis of 34 tools, the set of Blender + Blend4Web programs was
chosen to be used in the systematics. As a result, a systematic creation of three-
dimensional virtual environments with very diversified resources was obtained, which

proved useful in updating the knowledge of students and professionals of Virtual Design.

Keywords: Virtual Design; Three-dimensional Environments; WebGL.






X

$
UFRGS

PG D ES |G N Programa de Pés-Graduagao ONTERSIDADS FEDERAL
Mestrado | Doutorado DO RIO GRANDE DO SUL

LISTA DE FIGURAS

Figura 1 - Ivan Sutherland, o precursor da tecnologia CAD. ........cccceevvveeeiniiieeesnciieee e 8
Figura 2 - Visualizagao externa dos prédios do Campus Central da UFRGS em realidade
1V AU | OSSP PPPP 12

Figura 3 - Sagudo do prédio da Faculdade de Arquitetura da UFRGS em realidade virtual.

................................................................................................................................. 13
Figura 4 - Versao final do Oculus Rift, destinada ao consumidor final........................... 14
Figura 5 - Primeira versdo do Google Cardboard lancada em 2014. ........ccceeeeeeernnnnneen. 15

Figura 6 - Modo VR Editor da Unreal Engine que utiliza um editor em realidade virtual
para construir ambiente para a Propria RV.....coccveeeeeieeiieiciireeeieee e e 16
Figura 7 - Exemplo de visualizagdo de mobilidrios sobrepostos a um ambiente fisico a
partir da Realidade AUMENTada.......ccueviiieeii i e 18
Figura 8 - Google Glass, uma das apostas da Google com dispositivos inteligentes
vestiveis @ qUe UtIliZa @ RA.......oeiiie ettt e 19
Figura 9 - A ideia do Google Glass é sobrepor a visdo do mundo real do utilizador com
informacgdes Uteis e respostas as SUAS ACOES. ....uvrrreeeeeeeerciiurreereeeeeeeeiirrrereeeesssenanns 20
Figura 10 - Lenovo Phab2 Pro, primeiro smartphone com a tecnologia Project Tango,
realizando a medicao de objetos a distancia.......cccceeeeeiiecciiiiiiiiee e 21
Figura 11 - O HoloLens pode ser um instrumento profissional importante................... 21
Figura 12 - Graficos tridimensionais sendo visualizados por meio da realidade
[0 g 1T o =T - TR PP P R POPPPPRROPPPPRIN 22
Figura 13 - Exemplo de ambiente virtual (cidade) composto por objetos 3D (edificios) e
inserido em um espaco tridimensional delimitado. ..........cccovveveeeiiiiciciiieeeeee e, 24
Figura 14 - Dedo do personagem se deforma de forma realista com o sistema de colisdes
utilizado pelos EStUAIOS PiXar. ....ccccuuieeieciiiie ettt e e e e e 27
Figura 15 - No caso desta animacdo os 14 desenhos (quadros) que compdem o

movimento foram desenhados um seguido do outro em animagao direta. .......... 28



vi

Figura 16 - Neste caso, os desenhos chaves ou pontas precisam ser interpolados....... 29

Figura 17 - Conjunto de volante, transmissdo e pedais para simuladores virtuais de

(oo Y [ - 1SR UPPRPTUPRN 31
Figura 18 - Interagdo em ambientes imersivos através de teclado e mouse
(oo] g )VZ=T s [ei o] g = 11T PP PP PPPPPPPPPPPPPPPPPPPRE 32

Figura 19 — Exemplo da estrutura de uma interacao construida com a Blueprint,
linguagem visual de programacao presente na Unreal Engine........ccoocvveeveeeeenennns 39
Figura 20 - A esquerda, a representacdao do pensamento procedural, basicamente uma
lista de procedimentos sequenciais. A direita, a representacdo da modularidade da
orientacdo a objetos, onde se divide o todo em partes para facilitar o seu
entendimento € CONSTIUGAO0. ..uuiiiiiiiieiciieee e e e e e e rrre e e e e e eeas 42
Figura 21 - Ledo, tigre, lobo, cachorro e gato pertencem a classe Animal e naturalmente
possuem as mesmas propriedades e comportamentos basicos de sua classe pai. 43
Figura 22 - Exemplo de estrutura de blocos (Blueprint) que compartilham dados entre si
PAra formMar @ lOZICa. .. ..ceie e e 44
Figura 23 - Parte de um cddigo escrito, representando a criagcdo de uma cena virtual para
futura adicdao de elementos tridimensionais.........cccccviieeeee e, 45
Figura 24 - Parte de um software construido em blocos coloridos com a ferramenta
online Scratch, um bom exemplo de ambiente visual de programacao voltado ao
E T oY =Yg Ve [ 2= Yo [ TSP 46
Figura 25 — Linha do tempo das tecnologias mais importantes de representacdo de
conteldo 3D voltado Para Web. ........eeeeiiiii i 48
Figura 26 - Conjunto de ferramentas presentes no software 3ds Max 2017, destinadas
especificamente a criacdo de cenas €M VRML.......ccccuveeiiiiiieiiciiiieecceee e 50
Figura 27 - Parte de um cédigo VRML com especificacdes de um modelo 3D inserido em
UM @aMDBIENTE VIFTUAL. ..eviieiiiiiii e e e s s 51
Figura 28 - Parte de cddigo que descreve uma cena simples em X3D, criado com o
SOFtWAIrE BIENET. ..uviiiiiiiieie e s e e e s sbre e e s sbeeeesnnaee 54
Figura 29 - Aplicacdo interativa em WebGL com texturas e objetos detalhados,

desenvolvida pela Disney para promover o filme "O Magico de Oz". .................... 56



vii

Figura 30 - Corpo de cdédigo HTML com a descricdo de uma cena simples em WebGL
utilizando a biblioteca TR, S. ..ccovviiirieiiee e 57

Figura 31 - Jogo transportado de plataformas moveis para execugdo direta em

navegador web através do WeEbGL.........c..ueeiveiiie e 58
Figura 32 - Demonstragao promocional de veiculo em ambiente virtual. ..................... 58
Figura 33 - Software online de escultura digital inteiramente em WebGL. ................... 59
Figura 34 - Interface grafica de edicdo online de conteddo WebGL da Three.js............ 64

Figura 35 — Etapas do Design Science Research adaptadas para o método de pesquisa
UBITIZAAO. weiieieeee ettt s 66
Figura 36 - Método de pesquisa utilizado........cccuvveeeeeiiiicccee e 67
Figura 37 - Visualiza¢ao geral de uma estrutura¢ao de blocos utilizando a linguagem
embarcada no conjunto de softwares Blender + BlenddWeb. ..........ccoovurrrvvenee..n. 77
Figura 38 - Parte de ambiente demonstrativo evidenciando o modelo de um carro com
a paleta de possiveis cores para ele e a direita um espaco de estar. ........ccceee...... 78
Figura 39 - Espaco de estar com interagdo nos objetos sobre a mesa e palavras na parede
gue acionam a troca do tiPO d& CAMEIA......cevieeiiiiccirieeeiee e 78
Figura 40 — Tela inicial do software de modelagem tridimensional Blender. ................ 80
Figura 41 — Processo bdasico de criacdo de ambientes 3D virtuais com animacdo e
[ gL =] - Lot [ PP PPPPPP 85

Figura 42 - A sistematica deve satisfazer trés principais questées: modelagem, animacgao

[T (=] - Tt~ [ TSP 86
Figura 43 — Panorama geral da sistematica proposta........cccccccuveeeeiiieeeeeciiee e e 87
Figura 44 — Alteragdao do motor de renderizagao. ......cccoccvveeeercieeeeeiieeee s 89
Figura 45 — Barra de icones que identifica a janela de propriedades do Blender.......... 89

Figura 46 — Opcoes a serem habilitadas no menu Scene antes do inicio da criacdo. ....90
Figura 47 — Localizacdo do recurso Fast PrevieW.......ccccoeccciivieeiei e 91

Figura 48 — Scene Viewer aberto pelo comando Fast Preview para a realiza¢do de testes.

Figura 49 — Exemplo da sinalizacdo da presenca de erros por cores na tela do Scene
VA TE T T T T PP 92
Figura 50 — Aba Console da janela de ferramentas de desenvolvedor do navegador

[CToTo)=4 [ @ T¢oT 0 o T<T N UTTRP 93



viii

Figura 51 — Localizagao da barra INfo. ......ccocvieiiiiiiiiiiie e 94
Figura 52 — Localizacdo da janela 3D VIEW. ..cccuuuveeeeeiieiiiiiiiieeeeee ettt 94
Figura 53 — Localizagdao da janela OULINEr. .....ccovviiieiiiiiieecee e 95
Figura 54 — Localizacao da janela Properties. .....cocccveeeeeccciiiieeee et 95
Figura 55 — Localizagdao da janela TiIMeliNe. .....ccoovuiiiiiiiiiieciiee e 96
Figura 56 —Janela do Node Editor. ......ceeiei i e 96

Figura 57 — Ampliacdo e localizacdo dos triangulos localizados nos cantos inferior

esquerdo e superior direito da janela 3D VIEW. c....uuueveeiieiecccciiiiieee e 97
Figura 58 — Duas janelas 3D View abertas lado a 1ado. ......cccceeeeeeeiieciciineeeeiee e, 98
Figura 59 — Cépia da janela 3D View destacada das demais. .......ccceccvrvvveeeeeeeecccnnnnnnnnn. 98

Figura 60 — Menu (ampliado) com a opgdo Split Area, que se abre com o clique do botao
direito do mouse entre duas Janelas. .......ccceeeevvieiiiriiiee e 99
Figura 61— Linha de divisao de janelas que acompanha o ponteiro do mouse e determina
0 ponto de divisa0 da JANEla......cooiiiiiiiiiiee e 99
Figura 62 — Diferentes localizagdes dos botdes de troca de janela (ampliados), de acordo
COM O tIPO A JANCIA. coeeieeireeeee e e e e s e e e e e e eeas 100

Figura 63 — Menu de selecdo de janela ativa (ampliado) com sele¢do na op¢do 3D View.

Figura 64 — Duas janelas 3D View. A de baixo estd no lugar original da Timeline que foi
substituida e redimensionada. .........coceeriiiiieiiie e 101
Figura 65 — Duas janelas 3D View. A da esquerda com seu menu lateral esquerdo
ocultado e em seu lugar um icone ‘+’ (ampliado). ....cccceeeeerveeeeiiiiiie e, 102
Figura 66 — icone (ampliado) indicando linha limite entre janelas. ........c.cccocvevevevenenee. 102
Figura 67 — Menu (ampliado) com a opg¢do Join Area, que se abre com o clique do botao
direito do mouse entre duas Janelas. ........eeeeeveeiccireeeiee e 103
Figura 68 — Indicacdo da janela, selecionada com o ponteiro do mouse, que serd fechada
a0 cligue do botdo esquerdo do MOUSE. ........couvcviveeeiee e 103
Figura 69 — Menu View com marcacdo das opc¢des de alteracdo da posicdo de
(IVE ][4 [or- T X F- W ol=1 1 F- TR0 USSP PRP 104
Figura 70— Menu Viewport Shading com as diferentes opcdes de exibicdo dos elementos

(o = 1oL =1 0 I= P RRTRR 105



Figura 71 — Os trés tipos de Gizmo segundo sua fungdo. Da esquerda para a direita:
Translacdo, ROtagdo € ESCala. ...cccccuuvveeeeiiiiiiiiiiteeeee e e 106
Figura 72 — Localizacdo do botdo que mostra ou oculta a visualizacdo do Gizmo e os que
alternam entre 0s trés tipos de GiZMO. ........ceeeiuiiieieciiie e e e 106
Figura 73 — Menu de configuracao do posicionamento do Gizmo no espaco virtual..107
Figura 74 — Representacdes de Gizmos posicionados com a opgao Active Element ativa.
Na esquerda, com somente um objeto selecionado e, na direita, trés objetos
selecionados €M CONJUNTO. ....c..uuuiiiiiiee e e et e e e e e e nneeees 107
Figura 75 — Representacdes de Gizmos posicionados com a opcdo Median Point ou
Individual Origins ativa. Na esquerda, com somente um objeto selecionado e, na
direita, trés objetos selecionados em conjuNto. ......ccccuvveeeiiieeeccciiee e, 108
Figura 76 — Representacdes de Gizmos posicionados com a opcdo 3D Cursor ativa. Na
esquerda, com somente um objeto selecionado e, na direita, trés objetos
selecionados €M CONJUNTO. ..uiiiiiiiee ittt re e e e s saaeee s 108
Figura 77 — Representacdes de Gizmos posicionados com a opg¢ao Bounding Box Center

ativa. Na esquerda, com somente um objeto selecionado e, na direita, trés objetos

selecionados €M CONJUNTO. ........uuiiiiiiee e e e e e e e e 109
Figura 78 — Menu de configuracdo da orientacdo do Gizmo.........cceecvrveveeeeeeeencnnnnnen. 109
Figura 79 — Representacao de um suporte Gimbal. .......cccccovvieeieiiinicciiiieeee e, 110

Figura 80 — Localizagdo dos botdes Translate, Rotate e Scale no menu lateral da janela
] B Y SR 111
Figura 81 — Indicacao da localizagao do circulo central do Gizmo de rotacgao. ............ 112
Figura 82 — Representacdes dos icones que surgem quando se transforma a Rotacdo
(esquerda) e a Escala (direita) de elementos pelo clique no circulo central do Gizmo
€ MOVIMENTACAO O MOUSE. ..uvveeeiieiiiiiiiireeeiee et e e e eesrare e e e e e e eeensarraeeeeeeens 112
Figura 83 — Localizagdo dos campos com os valores (editaveis) referentes a posicao,
Rotacdo e Escala do objeto selecionado. .......ccoccvvveeeeieeiieiciiirieeeeeee e 113
Figura 84 — Dentre os trés objetos da cena (cilindro, esfera e cubo) apenas o cubo esta
=] =Tol o] o - T Lo TN PP U R PPUPOROPRPPI 114
Figura 85 — Janela Outliner (ampliada) com o elemento Esfera selecionado. ............. 114
Figura 86 — Exemplo de desenho de forma livre para selecionar, no caso, o cilindro e a

LY (<] = TR 115



Figura 87 — Localizagdo da ferramenta (De)select All na janela 3D View > menu Select.

Figura 89 — Localizacdo da opcdo Delete no menu lateral Tools > Edit, dentro da janela
3D VW, ettt ettt sttt b e et e et e et e e b e e st e e ne e e nreenneesanean 117
Figura 90 — Opc¢do Delete (ampliado) no menu Object da Janela 3D View.................. 117
Figura 91 — Localizacdo das op¢Oes de grupos no menu Relations > Group, na janela 3D
VIBW. it 119

Figura 92 — Localizacdo das opc¢des de grupos no menu Object > Group (ampliado), na

barra inferior da janela 3D VIEW......cocuiie ittt 119
Figura 93 — Menu para escolha do nome do grupo recém-criado. .......cccuveeerriuveeennnne 120
Figura 94 — Menu suspenso que se abre ao utilizar o atalho SHIFT + G....................... 121

Figura 95 — Menu suspenso secundario para escolha do grupo que se pretende

selecionar, no caso do elemento selecionado estar inserido em mais de um grupo.

............................................................................................................................... 121
Figura 96 — Localizagao do botdo Join na janela 3D View > menu Tools > Edit............ 122
Figura 97 — Vértice do cubo selecionado. ........cueeeeveeieeieinieeiiee e 123

Figura 98 — Localizacao da opcado by loose parts no menu Mesh > Vertices > Separate,
dentro da janela 3D View em modo de ediga0. ......ceeeeeeeeeicceiiieieeeeeeecciieeeee e 124
Figura 99 — Em cima, retdngulo demarcando area para ampliacdo e embaixo area
F T 0] o - o F- PRSP 126
Figura 100 — Localizacdo da opcao Do Not Render na janela Properties > menu Object >
RENAEING PrOPErtiEs. . uuviiiieieei ettt ee e et ee e e e eescrrrre e e e e e e s e sneraeaeeeeeeeesnnnnnes 127
Figura 101 — Localizacdo da opcao Do Not Export na janela Properties > menu Object >
EXPOrt OPLiONS. cooeeeeeeeeeeee e, 128
Figura 102 — Os quatro tipos de luzes do Blender suportados pelo Blend4Web. (A) Point,
(B) Spot, (C) SUN € (D) HEMI. ..uuiiieieee ettt et e e et e e e e 131
Figura 103 — Elemento Text, com texto padrdo, sendo editado no Blender................ 133

Figura 104 — Exemplo de aplicacdo de anotacdes aos elementos do ambiente virtual.



xi

Figura 105 — Céu do tipo Procedural com simulagao de sol.......cccceecuveeieniiieiiiiiiveeennne 134
Figura 106 — Sombras projetadas pela coroa, célice e dados em um outro objeto. ....135

Figura 107 — Pré-visualizacdo, no Blender, de um material com alto grau de refletividade.

Figura 108 — A Mist faz com que a cena perca visibilidade a medida que se afasta a
camera dela, devido a névoa que fica cada vez mais densa. .......ccccceeeeeeeeecnnnnnnen. 136
Figura 109 — Simulacdo de adgua gerada a partir do recurso Water. ......cccccceeevevnnnnneen. 137
Figura 110 — Exemplo de efeito de agua estatico aplicado em uma piscina virtual.....137
Figura 111 — Exemplo de aplicacdo do efeito emissdo de particulas (neve caindo sobre
V1= 1] o) RSP UPUPR 138
Figura 112 — Exemplo de utilizagdao do recurso Wind na simulagao de uma bandeira ao
vento (3 quadros da aniMaga0). .c..eeeceeeeiiee e eciee e e e 139
Figura 113 — Exemplo de céu estrelado circundando a cena composta por um cubo. 139
Figura 114 — Dois quadros de uma animacao de objetos simulando um pér do sol através
da alteragao da localizag¢do da luz do tipo Sun ao longo do tempo. ...........cceee.... 140
Figura 115 — Quadros de uma animacdo simulando tecido, utilizando a animacgdo de
VBITICES. ittt ettt e et e e bt e e e b e e e bt e e et e e e e e hb e s nb e s ne e s ne e sanee 141
Figura 116 —Uma bola e um caminho (curva), pelo qual ela percorrerd por meio da
animacao de seguimento de CaminNO.......cccceeeieicciiiiieee e 142
Figura 117 — Quadros da animagado de um cubo e uma esfera caindo e colidindo em um
0] F=1 3 o TSP PPPRRP 143
Figura 118 — Vasos em cima da mesa possuem um contorno que os realga, indicando
gue algo acontecerd caso sejam clicados pelo USUArio.........ccccveeeeeeeeecccinvieeeennnn. 144
Figura 119 — Exemplo de interagdo simples representada de trés diferentes formas. De
cima para baixo, conjunto de blocos da linguagem utilizada nos programas,
diagrama simplificado do conjunto de blocos (cinza) com a¢bes do usudrio e, por
ultimo, diagrama com as acgoes literais de cada bloco (cinza) e do usuario. ........ 145

Figura 120 — Selegdo da janela Node Editor pelo menu de janela ativa, acessado pelo

icone Area Type no canto inferior esquerdo da janela 3D view. .......cccccuvvvveeeneen. 146
Figura 121 — Indicagao do botao utilizado para abertura de uma nova janela. ........... 146
Figura 122 — Janela Node Editor criada separada das demais..........cccccvvvveeeeeeeeccnnnnnen. 147

Figura 123 — Local de criaco da Arvore de NOS. .......cc.cveucveieeiveeeeeeeeeeeeeeseesee e 148



xii

Figura 124 — Local de ativac3o da Arvore de Nds na janela Node Editor. .................... 148
Figura 125 — Janela Node Editor ja com o bloco de Ponto Inicial.......cccccvveeeeiiennnnennn.. 149
Figura 126 — Menu de adicdo de blocos divido em submenus (Atalho: SHIFT + A). ....150
Figura 127 — Bloco Entry Point (Ponto Inicial). .....cccceeeeeiiiiiioeiee e, 151

Figura 128 — Bloco Switch Select (Interruptor de Selecdo) e caminho de retorno com

PONTOS REIOULE. ..uuiiiiiiiiiiiiiiicie ettt e e e et e e e s e e e e e eeaaabareeeseeeaeassens 152
Figura 129 — Bloco Conditional Jump (Pulo Condicional). .........cccoeeeeimveerieeeeeicnreenen. 153
Figura 130 — Bloco Play Animation (Reproduzir ANiMmagao). .....ccceeeveeeeeecuvieeeecivreeeeenne 154
Figura 131 — Bloco Stop Animation (Parar ANiMacgao)......cccceeeeeeeeeeiiinnreereeeeeesennreenenn. 155
Figura 132 — Bloco Move Camera (Mover CAMEra)......cccueeeeeiveeeeeiieeeeeeeieeeeeevveeeeenns 156

Figura 133 — Bloco Set Camera Move Style (Definir Estilo de Movimento da Camera).

............................................................................................................................... 157
Figura 134 — Bloco Set Camera Limits (Definir Limites de Camera). .......cccceeeeevvveeennns 159
Figura 135 — Bloco Show Object (Mostrar Objeto)......cccccuveeveeeeciieeniie e 160
Figura 136 — Bloco Hide Object (Ocultar Objeto). .....cccccureeeeiiiieeeeiieee e 160
Figura 137 — Bloco Transform Object (Transformar Objeto).......ccccccvvvveevreeeeeiccnnneenn.. 161
Figura 138 — Bloco MoVe TO (MOVEN Para). .....ccccecueeeeeeiiieeeeeiieeeeecteeeeeeaveee e eevaeee e 162
Figura 139 — Bloco Outling (CONTOINO). ...ccoeevcurriieeiiee ettt esenareeeeeas 163
Figura 140 — Bloco Inherit Material (Herdar Material). ........cccouveeeeiiieeeeeieee e 164

Figura 141 — Exemplo de aplicagdao do bloco Inherit Material. Ao clicar em um dos

guadrados da paleta de cores (esquerda), seu material é instantaneamente

aplicado a carenagem dO CArTO. ..occuviiei ittt raaee e 164
Figura 142 — Bloco Variable Store (Armazenar Variavel).......ccccccveeeceeecciee e 165
Figura 143 — Bloco Math Operation (Operagdo Matematica). .......cccceeeeecveeeeeciieeeennns 166
Figura 144 — Bloco String Operation (Operacdo de Sequéncias de Caracteres)........... 167
Figura 145 — Bloco Play Sound (Reproduzir SOmM). .......ccccueeieeeiiieeeeiiieeeeecieee e 168
Figura 146 — Bloco Stop Sound (Parar SOM). .....eeeeeeeeeeeiecinieeeeeeeeeieiiineeeeeeeeeesennreeeeens 168
Figura 147 — Bloco Page Redirect (Redirecionamento de Pagina). ......c.ccccevveevruveennnne. 170
Figura 148 — BlOCO Delay (ALras0).....ueeeeeieeiieiiiiireeieeeeeeieiirreeeeeeeeesesisrereeseeeeessessnnressens 170

Figura 149 — Bloco Console Print (Impressdo de Console). ......cceeveeccvveeeeeeeeeeiecnnreennn. 171



xiii

Figura 150 — Exemplo de mensagem impressa (ultima linha) na aba Console do
navegador, utilizando 0 bloco Console Print.......ccceeevieeiiiiciiiiieeeeeeeee e, 172
Figura 151 — Bloco EMPty (VAzZi0). .ueecveieeiiieciie ettt s 172
Figura 152 — Exemplo de utilizagdo de pontos Reroute no redirecionamento de
CAMINNIOS. . st 173
Figura 153 — Bloco Frame (QUAAI0). ....ccuuieiiiiiiieeeecieeeeeceee et e e ecree e e e tree e e e enreeeeenes 174

Figura 154 — Exemplo de um Frame emoldurando um grupo de blocos responsaveis pelo

controle de uma iNteragdo da CENA. ....ccoccuuiiiiiiei e 175
Figura 155 — Menu de propriedades do bloco Frame. .......ccccceeeeeeeeiecciiieeeee e, 175
Figura 156 — Indicacao dos pontos de entrada e de saida de um bloco....................... 176
Figura 157 — Exemplo de cinco conjunto de blocos, um para cada interagao. ............ 176
Figura 158 — Exemplo de caminho ciclico no bloco Switch Select.......ccccoccvvviiiiieennnn. 178

Figura 159 — Exemplo de estrutura de blocos onde o caminho ciclico é utilizado do ultimo
ponto de saida até o primeiro ponto de entrada......cccccceeeveciriiieeieiiicccceeee, 179
Figura 160 — Esquema da interacdo de exemplo decomposta nas menores partes
POSSIVEIS. .eviieeieietrrreerieeeeeieiiiereeeeeeeeeiesrreeeeeeeeesesssrraaeseeeeeeiasstraneeeeeessenassrrsnreeeeens 180
Figura 161 — Substituicdo das a¢cdes que compdem a interacdo de exemplo por blocos
(em cinza) da linguagem visual de Programacao. .....ccccccceeveecrrverereeeeieneirreeeeeeen 181

Figura 162 — Esquema das a¢les da segunda interacdo exemplo utilizando varidveis.

Figura 163 — Substituicdo das acdes que compdem a segunda interacdo de exemplo por
blocos (em cinza) da linguagem visual de programagao. .........cccceeeeecveeeeeeciveeennns 183
Figura 164 — Caminho até a opgdo de exportagdao em HTML. .....ccoeveveveiviieeieininenennne 184
Figura 165 — Exemplo de tela apresentada para a escolha do nome do arquivo e do local
(o 1 T =) {0 To ] - [or- [ 185

Figura 166 — Exemplo de tela apresentando um erro encontrado durante a exportacao.

Figura 167 — Visdo geral do ambiente externo durante o dia. ......ccccceeevvieeiiieerineeennne 188

Figura 168 — Detalhes do céu procedural (A) e das sombras projetadas pela luz do sol

Figura 169 — Detalhes dos reflexos da luz do sol no oceano, na dgua da piscina (esquerda)

e Na bandeira (dir€ita). ....ccooeeirreeeiee e 189



Xiv

Figura 170 — Detalhes do oceano (A) e da dgua da piscina (B).......cccceeeeecvieeeecinveeeeenns 189
Figura 171 — Trés quadros da animacao de vértices que simula o tecido de uma bandeira
(olo] 0 s Y/ =T a1 o o] o =TT 190

Figura 172 —Visualizagao da bola e do caminho (curva) da animagao ainda no modo de

(=T Lo o TP 190
Figura 173 — Emissao de particulas simulando a dgua que sai do bebedouro............. 191
Figura 174 — Dois quadros da animacao de por do SOl ......ccceeeeeeeeeiccinreeeeee e, 191

Figura 175 — Visdao das quatro posi¢cdes da camera quando sdo clicados os objetos:

bandeira (A), dgua da piscina (B), bebedouro (C), banco (D). .....ccccevvvveereeeeerennns 192
Figura 176 — Visdo geral do ambiente externo durante a noite.......ccccccveeeeievccnnnennnn. 193
Figura 177 — Detalhe do céu em degradé com as estrelas e a lua. ....ccccccvveeeviiveeeenns 194

Figura 178 — Detalhes do efeito de neblina, que fica mais ou menos densa conforme a

distancia entra a camera e o centro do cenario; sombras projetadas pela luz da lua.

Figura 179 — Detalhes dos reflexos das luzes no oceano (A) e na dgua da piscina (B). 195
Figura 180 — Dois quadros da animacao de vértices, que simula o tecido de uma bandeira

COM VENTO FrAC0. .eiiiiiiiiiie ettt 195
Figura 181 — Emissdo de particulas simulando a 4gua que sai do bebedouro............. 195
Figura 182 — Visdo das trés posicdes da camera quando sao clicados os objetos: bandeira

(A), agua da piscina (B), bebedouro (C). ....ccccueieeicieie e 196
Figura 183 — Visao geral do ambiente interno.......cccceeeeciieiiiciiiee e 197
Figura 184 — Luzes provenientes do sol (A) e dos spots acima dos expositores (B).....198
Figura 185 — Sombras projetadas pelos objetos em um dos expositores. ................... 198
Figura 186 — Objetos com um numero significativamente maior de poligonos em relagao

A0S dEMAIS A CONA....eiiiiiiieieeeee et e e 199

Figura 187 — Detalhe da textura de rugosidade aplicada ao objeto de museu digitalizado.

Figura 188 — Coroa e taga refletindo objetos préximos (dados e expositor), devido aos
materiais altamente reflexivos. ... 200
Figura 189 — Reflexos da iluminacdo em objetos como o pido; contorno, no pido,

indicando a presenga de iNtEraga0......ccciceieeieecccciiiieee e e e e e e 200



XV

Figura 190 — Anotacdo com titulo (A) e descricdo (B), explicando uma das interacdes da

Figura 191 — Visdo geral do Ambiente Interno nos trés diferentes formatos: (a) WebGL,
(b) VRML (3ds Max), (c) VRML (BIENEN). ccceeieeiierrreeeeiee ettt 203
Figura 192 — Visdo geral do Ambiente Externo Dia nos trés diferentes formatos: (a)
WebGL, (b) VRML (3ds Max), (c) VRML (Blender). ....ccooveeereiiiiiiinreeeeeeeee e, 204
Figura 193 — Visdo geral do Ambiente Externo Noite nos trés diferentes formatos: (a)
WebGL, (b) VRML (3ds Max), (c) VRML (Blender). ....ccooveeereeiiiiiirreeeeee e, 205
Figura 194 — Mesmo ambiente (Ambiente Externo Dia) sendo executado em diferentes

dispositivos (Computador € Smartphone)........cccceeeeeeieeeccciiee e, 206






X

$
UFRGS

PGDESIGN | g fabisamanse UNNERSIRARE FERsA:
LISTA DE TABELAS

Tabela 1 - Caracteristicas do software 3ds Max, versao 2017.......ccccvvveeeeeeeeeccnnreeeeennn. 36

Tabela 2 - Caracteristicas do software Blender, versao 2.78C. .....cccccceeeevcvveeeescveeeeennnn 37

Tabela 3 - Caracteristicas do software Unity, versao 5.4.1........ccccoevveeeiviiveeeenineeeennnne 38

Tabela 4 - Caracteristicas do software Unreal Engine, versao 4.13........cccccceeevvveeeennee. 40

Tabela 5 — Modeladores, editores e exportadores de cenas 3D analisados. ................. 70

Tabela 6 - Critérios a serem considerados para a escolha das ferramentas que farao parte
da SiStEMALICA PrOPOSTA.....ccccvirieeiee e e e e e e 71

Tabela 7 - Requisitos da sistematica de criacdo de ambientes 3D interativos por meio do

Tabela 8 - Taxas minimas e maximas de quadros por segundo (FPS) durante a execugdo
do ambiente WebGL nos trés principais navegadores. Quanto maior, melhor......82
Tabela 9 — Configura¢des de hardware exigidas para o funcionamento adequado dos
softwares Blender e BIeNd4AWEeD. ..........ooveeiiiiiicee et 88
Tabela 10 — Sintese da comparacdo entre as tecnologias VRML (Blender), VRML (3ds
1Y I AT =] o L1 R 207
Tabela 11 — Tamanhos, em megabytes (MB), dos arquivos das cenas utilizadas para

(o0 31 0= = o}~ o JA 212






X

PGDESIGN |

2D

3D

API
AV3D
CEO
DOS
GPS
GPU
HTML
IHC
ISO
MIT
00
OPENGL
POO
RA

RV
UFRGS
VRML
WEBGL
X3D
XML
HD
SSD

Programa de Pés-Graduagao
Mestrado | Doutorado

LISTA DE ABREVIATURAS

$
UFRGS

UNIVERSIDADE FEDERAL
DO RIO GRANDE DO SUL

Duas Dimensdes / Bidimensional
Trés Dimensdes / Tridimensional
Application Programming Interface
Ambiente Virtual Tridimensional
Chief Executive Officer

Disk Operating System

Global Positioning System

Graphics Processing Unit

Hypertext Markup Language
Interface Humano-Computador
Internacional Standards Organization
Massachussets Institute of Technology
Orientacdo a Objetos

Open Graphics Library

Programacao Orientada a Objetos
Realidade Aumentada

Realidade Virtual

Universidade Federal do Rio Grande do Sul
Virtual Reality Modeling Language
Web Graphics Library

Extensible 3D Graphics

Extensible Markup Language

Hard Disk

Solid-state Drive






Eﬂ UF%GS

PG DES |G N Programa de Pés-Graduagao ONTERSIDADS FEDERAL
Mestrado | Doutorado DO RIO GRANDE DO SUL

LISTA DE APENDICES

Apéndice A — Tabela de Softwares Analisados






X

$
UFRGS

PGDESIGN | ezl B RAR Rt
SUMARIO
(6 o 11 1] Lo 0 R PRSPPI 1
T e T o T LU Tk T R 1
1.1.  Problema de PeSQUISA ...ccivcuriieiiiiiiee ettt ceitee e et e e stae e e s ssre e e s e sbaee e e ssaeeeesenas 2
00 0 o 1] 4 1Y/ Y-SR 3
0 TR 1= [ 4 1) - T o F PP USPPROPPPP 3
1.4, JUSEIFICAtIVA oo e 4
1.5, Estrutura do Trabalho.......occoiiiiiiiie e 5
(67T o 1 (U1 Lo T AU SERRR 7
DESIZN 4+ WEDGL c.ceeiieiiiieeieeie ettt e e e s e e e e e e e sesabbreeeeeeeeeesnsssraeeeeeeens 7
2.1. Arepresentagdo tridimensional virtual N0 DeSIgN.......cccccuveeeiviieeeiriiiee e, 7
2.2, Avrealidade VIrtual ......coooviiiiiiiiii 9
2.3, Avrealidade aumentada ........cceeiiiiiiiiiniie s 17
2.3.1. Elaboracgdo de conteldo para a Realidade Aumentada ...........ccccecvveennee 22
2.4. Os ambientes tridimensionais Virtuais .........ccceevueeeriiieniieeiiiee e 23
2.4.1. Aanimacdo em ambientes virtuais 3D ......ccccceeeeiiiiiiiiiiiiie e, 26
2.4.2. Ainteracdo em ambientes Virtuais 3D ......cccceeeeeeeiiiiiiiieeeei e, 30
2.4.3. Acriacdo de conteudos tridimensionais por designers.........cccccccvvveeeennnn. 33
2.4.3. 1. 305 M@Xuuuiiiiiiiiiierieeee e e 35
2.4.3.2.  BleNAEr ..o e 36
24330 UNIY i s 37
2434, UNreal ENGINe..cii ittt 38
2.5. A programacao orientada a 0bjetos (POO).....ccccceeeureeeeeiiiee e 40
2.5.1. Programacdo Escrita e Programacado Visual ........ccceeeevvrvveereeeeeiccinnveneeenn. 44
2.6. Tecnologias de representacdo e disseminagao de conteudo 3D virtual.......... 47
2.6.1.  VRML (Virtual Reality Modeling Language)..........ccccceevuveeeieeeieieciiivveneenenn 49

2.6.2.  X3D (Extensible 3D GraphiCs) ........uuuccueeeeeciieeeeeiieeeeecieeeeeeceee e eeraeee e 52



XXiV

2.6.3. WEDGL ..ottt 55

2.7. O WebGLEeM detalnes......cccooiiiiiiiieieeeeee e 59
2.7. 1. BiblIOtECAS .ceueeieeieeeie e s 62

(0F o1 U] [o T TP PSPPSRt 65
Materiais @ MELOUOS.....ccouuiiiiiieiiee ettt st sneee s 65
3.1, MBLOAOS ettt 67
3.1.1. Revisdo bibliografica de entendimento......cccccccceevecvrveeeeee e, 67
3.1.2. Revisao bibliografica de aprofundamento..........cccccceeiiiiiicciiieeeec e, 69
3.1.3.  Levantamento de ferramentas .......ccccvceriieerieeiienie e 69
3.1.4.  Critérios de avaliagao.......cccueeieieeiieiciiieeee e 71
3.1.5. Requisitos da SisteMALICA......ccccciiieiiiiiie e 74
3.1.6.  SeleGA0 dOS SOftWAIES.......uvveiiieiieieeeiieeeeeieee e eritee e e e e saee e s s saeaeeseaes 75

3.2, MAteri@iS..cieeiiiiiiiiiiic e 83
3.2.1.  Revisdo bibliografica ......ccccuviiiiiiiii i 83
3.2.2.  Andlise de ferramentas e avaliagdo da sistematica........ccccoccveeevciieeennnns 84

(07T o111V Lo 3 SO TRRRRRRPP 85
SISEEMIATICA ..ttt e 85
4.1. Obtencdo e instalagcado dOS SOftWArES .........ccccvuuveeeieeieeieciirreeeee e e 88
4.2. Preparacdo para o uso do Blend4Web........ccccuuvieeieiiiiccciiiiieee e 89
4.2. 1. FASE PrEVIEW ......ceviiiiiiiiiiiiiiiiic ittt 91
4.3, INtErface SEral .ccu i 93
4.3.1. Criagdo e Manipulagao das Janelas de Exibicdao (Viewports).................... 97
4.3.2. Manipulacdo de Elementos (Objetos 3D, Luzes, Cameras...) ................. 105
4.3.3.  Comandos IMPOrtantes .....ccoocccciiieeeee e e e e 113
4.4. Obtencdo e otimizacdo de modelos 3D ......cococvvvvieeieeieiiciiieeeeee e 128
A4 L. OUiMIZACOES . .uuuuuuuuuuuiti i naan 129
4.5.  Materiais @ teXtUras ......ccccvviriiiiiiiiiiii 130
4.6. Insercdo de Elementos (luzes, cameras, sons, textos e anotagdes) .............. 130
4.6.1.  LUZES (LAMIP) weveeeieiiereeeeee ettt eeirre e e e e s e e eabraaee e e e e e s seaasraneeeas 131

L ST B O 1 o =T - [ (e [ 1 1= ¢+ ) TR 132

4.6.3.  SONS (SPEAKEI) ...vveeeeieee ettt e et e e et e e e e eare e e e e snaeea s 132



XXV

4.6.4. TEXEOS (TEXL) .uueeeeeerieeeeeiteee e ettt e e et e e e ettt e e e e te e e e e ettae e e e earaeeeeenreeeeennnees 132
4.6.5.  ANOLACOES (ANCAON) ...cccoeciireeeiei ettt e e e e seearaer e e e e e e seanes 133
4.7. Configuragao do ambiente ......cccuieiiiiiiiiiiiee e 134
B.7.0 CBU (SKY) eveeereeeeeereeeeeeeseeeeeseeeieteseeseseseseesesseesseesesessesessesseseesesseeessesnenaens 134
4.7.2.  SOMDIras (SAAAOWS) .....ccueeeiuiieeiiieciieeecte et s aae e e 135
4.7.3.  Reflexos (REfIECLIONS) .......oeeeeuueeeeeiieee ettt 135
4.8. Efeitos ao ar livre (OUtdOOr EffECts) ....cuueeeeeeeeeicciirreeeieeeeeeeeciireeeee e 136
L T O (=AY Y= (1Y 12 o ISR 136
B.8.2.  AGUA (WGLEE) ettt et en e 137
4.8.3. Emissdo de Particulas (Particles EMItter)......ccccovuveeeiiiiiiicciiiieeeneeeeeiienns 138
4.8 4. VeNtO (Wind) .uueeeeeeiiiiiieiieeeie ettt et searaee e e e e e s seanes 138
s T X 0] F T Y 7 /) P 139
VIS I O g F- Tor- To o [T o 110 0 F- Tolo 1= SR 140
4.9.1. Animacdo de Objetos (Object Animation) ..........ccccueeeceeeecreeeeireessveennnns 140
4.9.2. Animacao de Vértices (Vertex Animation)............ccccocueeeeceveeeescineeeennnnnn 141
4.9.3. Animacdo de Seguimento de Caminho (Path Animation) .............cc....... 141
49.4. Animacado de Efeitos de Fisica (PAYSICS) ...uuveeecvueeeeeeiieeeeeciiee e 142
4.9.5. Contorno de Objetos (Object OULNING) .......cccceevvveeeeiieiieieciiiieeeeeeeeeeeans 143
4.10. O a 1o [oXe [l [0} £ - [ofo 1T U 144
4.10.1. AceSS0 a0 NOAE EQILOr .....cccuueieiuiiiiiiiiiiiiiiieeeieeeee e 145
4.10.2. Arvore de NOS (NOUE Tree).......cceeueeveeeeeeeeeeeeeeeeeeeereeeeseess e, 147
4.10.3. BIOCOS/NOS (NOGES) ....cccuveeeieetreieeeeiiee et eecee et 149
4.10.4. Construgao de INtEragles . ..ccuveeeereiireeeeecieeeeerree e st e erre e e e e e e e aeees 175
4.11. EXPOrtagao ..ccciiiiiiiiiiii 183
(07T 011 (U1 o J1= TP P T UPURTRRN 187
RESUITAA0S € TESTES ..ciuiiiiiiiieeiiee ettt s s s s 187
5.1, AMDIenteS-TESTE ..oovuiiiiiiieeeeee e 187
5.1.1. Ambiente externo durante o dia (Figura 167) .....ccccccceeevveeeecireeeeecnnennn. 188
5.1.2. Ambiente externo durante a noite (Figura 176).....ccccccccveeieevccnnreenennnnn. 193
5.1.3. Ambiente interno (Figura 183)......ueeeiiieciiiieeeeee et 197
5.2.  Comparacdo WebGL € VRIML .......uuuiiiiieiiiicecceeeeee et vrnen e 202

oI R C1<ToY o =] f g 1= 208



XXVi

5.2.2. Materiais € TEXTUIASs ....cccoviiiiiiiiiiiiiiiiirt e 208
5.2.3.  HUMINGGE0 i ittt e e e e s rer e e e e e s sensbaaeeeeeeeeens 208
5,204, SONS ..ttt e e e 209
LI T - 114 =T - TSP U PSPPI 209
5.2.6.  ANIMAGOES ittt ittt ettt et e e e e s e aeeeeeeens 210
T R | o | (=] - [ oo 1T PPNt 210
5.2.8.  ReCUIS0S EXTra.....ccooiiiiiiiiiiiiiiiiiiiiiciiicc e 211
5.2.9. Qualidade Geral x Tamanho de ArquiVo......cccccceeeccuiiieieeeee e, 212

5.3.  Diagramas das INtEIraCOES .......ccccvrreeeeeeeeeieiiirreeeeeeeeeescirrreeeeeeeeesenarrreeeeeeeeeens 213
07T o1 (U] [ 3N XSRS 215
00T o1y o [=T = Tolo LT o T = LSRR 215
6.1. Sugestdes para trabalhos fULUrOS ......cccvvviiiiiiieii e, 219
(07 o1 41| Lo TNy AR 221
Referéncias BibliografiCas .......ccoviuiiiiiiiiiii e e 221
Yo T=T g Vo LT NP 231

Tabela de Softwares ANAlISAUOS ........ccoovieciurieeiiee e e e e e ee e e 231



Capitulo 1

INTRODUCAO

Os ambientes virtuais tridimensionais tém seu campo de aplica¢des cada vez
mais estendido a medida que o avanco da tecnologia computacional aprimora as
capacidades tecnolégicas para criacdo e utilizacdo deles. Mesmo tendo surgido
décadas atrds, a Realidade Virtual (RV) é hoje concreta e vidvel. Tornou-se uma
grande aposta tecnoldgica para os proximos anos, convertendo-se ja em 2016 num
nicho de mercado biliondrio. O qual faturou, segundo a empresa de auditoria,
assessoria e consultoria empresarial Deloitte, aproximadamente 700 bilhGes ddlares
em vendas de hardware e 300 bilhdes em vendas de conteldo para computadores,
videogames e plataformas méveis (LEE; STEWART, 2016).

Espera-se ainda que a venda de aparelhos de realidade virtual cres¢ca em um
ritmo anual de 84,5% até 2020 (GUERRA, 2016). E por de tras dos numeros de
faturamento estd toda uma cadeia de desenvolvedores de conteldo virtual que
necessita aliar conhecimentos de diferentes areas para garantir o crescimento do

mercado de RV, principalmente no Brasil.

Sem contelddo ndo ha crescimento, porque ndo ha o que ser consumido.
Neste processo, os estudios de produgdo imersiva tém um papel
fundamental e ao mesmo tempo desafiador: criar em quantidade e com
qualidade para atender a demanda, diz Anténio Rabello, diretor do VR

Studios (REVISTA EXAME, 2016).

Para melhorar progressivamente a qualidade dos conteludos de realidade
virtual sdo necessdrios conhecimentos de Design e sem duvida os designers se
apresentam como importantes profissionais no desenvolvimento de ambientes
virtuais, em especial os tridimensionais. No entanto, esta € uma industria

multidisciplinar, destacando-se os que possuem um conhecimento mais abrangente,



ndo so de Design, mas também das tecnologias de criagao que hoje estao muito mais
préximas dos programadores.

Algumas das principais tecnologias de descricdo de cenas para web foram
desenvolvidas até o ponto que usuarios sem conhecimento algum de programacao
também pudessem gerar conteldo. Isso aconteceu com o VRML por exemplo e foi
essencial para sua popularizagdao e crescimento das pesquisas entorno do assunto.
Hoje estamos diante do WebGL, um padrdo de processamento de imagens e efeitos
graficos acelerados pela Unidade de Processamento Grafico (GPU, sigla em inglés)
de computadores e dispositivos moéveis, tudo isso interagindo com os elementos
padrdo de paginas web (HTML) (SUZUKI, 2015).

Muito mais poderoso, o WebGL traz consigo um salto de qualidade grafica e
de processamento, possibilitando a distribuicdao de jogos, animacgdes, simulacdes
cientificas, apresentacdes e tantas outras aplicacdes interativas pela internet para
muitas plataformas. Como o esperado desde o inicio de seu desenvolvimento, todos
os principais dispositivos modveis (smartphones e tablets) ou “de mesa”
(computadores e videogames) e sistemas operacionais (Windows, Mac OS, Linux) ja
possuem a capacidade de exibir conteddo 3D online e off-line por meio desta
tecnologia.

Ainclusdo de designers nesse meio parece natural e necessaria para alcancar
o aprimoramento constante da qualidade dos produtos digitais. Resta apenas propor
caminhos para que o WebGL inicie a sua aproximacdo destes profissionais,
proporcionando-lhes mais conhecimento e aperfeicoamento de suas capacidades

técnicas e inventivas.

1.1. PROBLEMA DE PESQUISA

Como aliar a tecnologia WebGL aos conhecimentos de criacdo de objetos e
ambientes tridimensionais virtuais dos designers, a fim de melhorar a apresentacao,

a distribuicdo e o alcance de seus trabalhos?



1.2. OBIJETIVOS

O objetivo geral desta pesquisa é propor para uso no Design, uma sistematica?
de criagdao de ambientes tridimensionais interativos que possam ser apresentados e
distribuidos, a partir da internet ou ndo, utilizando a tecnologia de representacao

virtual WebGL, beneficiando-se de suas vantagens.
Os objetivos especificos sdo:

a. Compreender em que consiste e como funciona o WebGL, bem como as suas
vantagens e desvantagens em relagdo a tecnologias anteriores;
b. Detectar em quais pontos o WebGL pode ser util aos projetos de Design

Virtual (animacgao, jogos, simulagdes...);

1.3. DELIMITACAO

Apesar da possibilidade de desenvolvimento de novas ferramentas e recursos
utilizando a tecnologia WebGL com o objetivo de gerar ambientes virtuais 3D, esta
pesquisa delimita-se a trabalhar com softwares ja existentes de criacdo e exportacao
de conteudos tridimensionais virtuais para compor a sistematica relacionando o
WebGL aos projetos de Design. Ainda, o processo ndo tem a intencdo de abranger
ensinamentos, conceitos e técnicas a respeito da modelagem tridimensional nos
programas utilizados ou em quaisquer outros. Assim, trabalha-se aqui com objetos

3D modelados previamente pelo usudrio ou obtidos ja prontos por outros meios.

! Sistematica é o resultado de um processo de sistematizacdo, que por sua vez é uma “interpretagdo critica
de uma ou varias experiéncias que, a partir de seu ordenamento e reconstrugao, descobre ou explicita a
I6gica do processo vivido, os fatores que intervieram no dito processo, como se relacionaram entre si e
porque o fizeram desse modo” (HOLLIDAY, 2006, p. 24).



1.4. JUSTIFICATIVA

E fato que a criacdo e manipulacdo de objetos tridimensionais virtuais s3o
habilidades de muitos designers e projetistas em geral, especialmente animadores,
desenvolvedores de jogos digitais ou ainda de produtos. Ainda que inerente a estes
profissionais, quando acompanhada de novas tecnologias esta aptiddo pode ser
aprimorada em diversos sentidos.

S3o os beneficios proporcionados pela tecnologia WebGL aos trabalhos de
Design que motivam esta pesquisa. Pode-se por exemplo, elevar a qualidade visual
de apresentacdo dos projetos de Design Virtual, com visualiza¢gGes interativas
inseridas em contextos em plena evolugcdo como a Realidade Virtual. Ou ainda,
facilitar a distribuicdo de um conteddo digital em formato HTML, devido a sua
capacidade de execugdo multiplataforma, inclusive em dispositivos moveis
(smartphones e tablets), sem a necessidade de complementos especificos e por meio
de simples navegadores web (ZHANG; GRACANIN, 2013, p. 195).

Uma das grandes chaves para que esta mistura de tecnologias funcione é a
existéncia de softwares que trabalham de maneira muito semelhante aos ja
utilizados para modelagem tridimensional no Design, como por exemplo 3ds Max,
Blender, SolidWorks e tantos outros, porém possuem a funcionalidade de acréscimo
de interacdes e animacdes aliado a exportacdo deste conteudo para esta Interface
de Programacdo de Aplicativos (em inglés, Application Programming Interface - API)
denominada WebGL (ver item 2.7).

Acredita-se que a aproximacdo destes softwares, utilizados no Design, que
trabalham com criagdao de objetos tridimensionais virtuais e essa API, por meio de
uma sistematica destinada a aplicacdo na area criativa por designers, pode facilitar
o desenvolvimento e divulgagdao dos ambientes virtuais com maior qualidade grafica
e com formas de interacdo mais intuitivas, proporcionando uma ampliacdo de suas
capacidades e resultando em um maior alcance na visibilidade e no uso dos mesmos.
A aproximag¢ao da tecnologia WebGL dos designers, além de populariza-la e trazer
beneficios aos profissionais da area, pode também ajudar na sustentacdo da prépria
tecnologia como um duradouro padrdao de descrigao de cenas tridimensionais se
considerar que segundo Danchilla (2012, p. 301), um dos pilares para alcancar este
patamar é a ado¢do macica da comunidade de desenvolvimento, onde se incluem os

designers.



Corroborando com esta ideia, é notdrio que diversas tecnologias amplamente
difundidas hoje comecaram a se popularizar a partir do momento que tiveram seu
entendimento e utilizacdo facilitados para o usuario. Como exemplo, a plataforma
de streaming de videos Youtube, criada em 2005, tornou acessivel a qualquer pessoa
a geracao, distribuicdo e promocao de videos pela internet, tarefa antes restrita a
profissionais especializados do audio visual (FERREIRA, 2015, p. 01 e 02). Outro bom
exemplo sdo os 6culos de Realidade Virtual (RV) que se democratizaram por meio do
Cardboard da Google, um produto composto basicamente por papeldao e que por seu
baixo custo e complexidade levou a experiéncia da RV onde os modelos mais
complexos e caros ainda ndao chegaram, abrindo um novo nicho de mercado em
crescente expansao (MALOSSI, 2015; MORAES, 2015; RIZZ0, 2015).

Os beneficios deste trabalho podem atingir ainda o campo da educacgao.
Igualmente ao realizado pelo Prof. Dr. José Luis Farinatti Aymone na disciplina de
Design Virtual da pds-graduacdao em Design da UFRGS com relag¢dao a tecnologias
como o VRML, futuramente o desenvolvimento de ambientes virtuais utilizando
WebGL poderd ser ensinado a académicos e interessados em Design Virtual, tendo
como base uma sistematica especialmente desenvolvida para os profissionais da

area. Por sua vez, estes aprendizes poderdo dar sequéncia a pesquisa nesta area.

1.5. ESTRUTURA DO TRABALHO

Esta dissertacdo esta dividida em oito capitulos, sendo o primeiro a
Introducdo, onde o problema de pesquisa é esclarecido, a hipdtese inicial é
construida e os objetivos, justificativa e delimitacGes sdao especificados.

O segundo capitulo (Design + WebGL) é composto por sete sec¢les. Elas
abordam os temas considerados relevantes para a compreensdao do universo da
pesquisa e buscam um entendimento, por meio de fundamentacdo tedrica e pratica,
sobre assuntos como a representagao tridimensional virtual no Design, a realidade
virtual e aumentada, os ambientes tridimensionais virtuais, a programacao orientada
a objetos, as tecnologias de representacao e disseminac¢dao de conteudo 3D virtual e
um aprofundamento sobre aspectos mais profundos do WebGL.

O capitulo numero trés (Materiais e Métodos) expde em detalhes a

metodologia utilizada para a realizacdo da presente pesquisa. Neste capitulo a



pesquisa é classificada segundo sua abordagem, objetivos e procedimentos e sdo
apresentados os métodos e materiais utilizados.

No quarto capitulo (Analise e Selecdo de Softwares) estdo descritas as etapas
de levantamento de ferramentas com potencial de uso no trabalho; elaboracdo dos
critérios para avaliacdao das ferramentas levantadas; descoberta dos requisitos da
sistemdtica em desenvolvimento; e, baseado nestes critérios e requisitos, selecao
dos softwares a serem utilizados diretamente na construcdo da sistematica.

O quinto capitulo (Sistemdtica) traz o resultado maior da pesquisa, a
sistematica de criacdo de conteudo virtual tridimensional interativo, utilizando a
tecnologia WebGL através do programa Blender e seu complemento Blend4Web. O
capitulo estd dividido conforme as etapas da sistematica, desde a obtencdo e
instalacdo dos softwares utilizados até o processo de exporta¢ao do contelddo pronto
para ser distribuido e visualizado.

O capitulo nimero seis (Resultados e Testes) apresenta os resultados obtidos
a partir da construcdo de ambientes-teste utilizando todos os recursos presentes na
sistematica. Ao fim do capitulo realiza-se um comparativo entre as tecnologias VRML
e WebGL.

O sétimo capitulo (Considerac¢des Finais) relata as consideragdes finais acerca
deste trabalho como um todo. Discutem-se as etapas realizadas, os resultados
alcancados e as dificuldades enfrentadas ao longo de seu desenvolvimento.
Também, neste capitulo apresentam-se os trabalhos mais relevantes produzidos em
paralelo com esta pesquisa, no mestrado em Design na Universidade Federal do Rio
Grande do Sul. E ao final, sugerem-se algumas possiblidades de pesquisa para futuros
trabalhos na mesma area.

No oitavo e ultimo capitulo (Referéncias Bibliograficas) estdo todas as
referéncias das citacGes utilizadas nesta dissertacdo. E por fim, logo apds as
referéncias, esta o Apéndice A (Tabela de Softwares Analisados), que contém a

listagem dos programas levantados e analisados durante o trabalho.



Capitulo 2

DESIGN + WEBGL

“O mundo dos gréficos tridimensionais ndo tem fronteiras nem limita¢des
[...] - podemos melhora-lo colocando ainda uma quarta dimensdo: a

dimensdo da nossa imaginag¢ao”. (MAZURYK; GERVAUTZ, 1996, p. 01)

Para compreender como o Design ao longo dos anos agregou a representagao
virtual, em especial aquela que trabalha com a tridimensionalidade, as suas
capacidades, buscou-se as bases conceituais e histéricas e as tecnologias que
influenciaram neste contexto e continuam aprimorando suas habilidades.

O presente capitulo apresenta as definicdes e exemplos, obtidos por revisao
bibliografica, referentes a temas de relevancia para a constru¢cdao do entendimento
da insercdo e utilizacdo de tecnologias digitais na criacdo de ambientes

tridimensionais virtuais por designers.

2.1. A REPRESENTACAO TRIDIMENSIONAL VIRTUAL NO DESIGN

A representagdao pressupde a duplicidade de qualquer coisa, material ou
imaterial, fisica ou virtual (PANISSON, 2007, p. 45). No Design a representacdo tem
por um de seus objetivos replicar conceitos em figuras e objetos que sirvam para
visualizar ou comunicar algo. Em outras palavras, as representacdes sao utilizadas
para materializar ideias a serem comunicadas ou ainda possibilitar simulacdes
durante um projeto.

Dentre os tipos de representagdes, destaca-se aqui as que apresentam
tridimensionalidade. Um objeto tridimensional (3D) é aquele que apresenta volume
e pode ser definido nas dimensdes altura, largura e profundidade e que por sua vez

estd inserido em um ambiente também tridimensional, seja ele fisico ou virtual.



A confeccdo de modelos tridimensionais fisicos sempre foi de grande
importancia no Design, ganhando visibilidade até mesmo pela popularizacdo da
prototipagem rapida e das impressoras 3D. Seja por meio de modelos ou protétipos,
os projetistas podem visualizar de uma melhor maneira sua criacdo e eventualmente
testd-la, se necessario.

Paralelamente a eles, com avanco da computacdo grafica e advento dos
computadores pessoais, se tornaram comuns os modelos virtuais construidos dentro
do ambito computacional, para os mais diversos fins, a partir de ferramentas
especificas como os softwares CAD (Computer Aided Design) (LIMA, 2010, p. 117).

O conceito moderno de CAD, em portugués Projeto Assistido por
Computador, foi concebido em 1963 por Ivan Sutherland (Figura 1) e seu orientador
no Massachussets Institute of Technology (MIT) quando desenvolveram um modo de
integrar o projeto a um programa de andlise criando também as primeiras
ferramentas para implementar esse sistema. Com relacdo a utilizacdo destas
ferramentas no Design, bem como na Arquitetura, desde o fim da década de 90,
houve um crescimento exponencial do uso da representagdo grafica virtual, tanto no

meio académico como profissional (JUNG, 2014, p. 53 e 56).

Figura 1 - lvan Sutherland, o precursor da tecnologia CAD.

Fonte: MIT MUSEUM (1963).



Tal modo de representagao trouxe grandes vantagens se comparado ao que
antes era feito a mdo. Sdo menores seus custos e o tempo de desenvolvimento,
oferecendo maior flexibilidade com relacdo a alteragdes. Por estas razdes, o uso da
modelagem virtual é altamente interessante para as areas de engenharia e Design
industrial (BJOERKLI, 2014, p. 02).

Devido ao crescente avanco tecnolégico computacional dos ultimos anos,
tudo aquilo que antes era feito com protdtipos fisicos, foi sendo possivel de ser
realizado virtualmente. Os objetos tridimensionais hoje podem ser simulados e
apresentados de maneira fiel a realidade utilizando ferramentas digitais.

Atualmente, no Design de produtos, é praticamente indispensavel o
conhecimento de modelagem virtual, seja para a realizacdo de testes, prototipacdo
ou para a apresentacao e divulgacao do projeto a clientes e usudrios. Sao muitos os
usos da representacao tridimensional virtual no Design e as ferramentas disponiveis
de criacdo de objetos e ambientes 3D continuam evoluindo e oferecendo cada vez

mais realismo e capacidades de animacdo e interacdo para o conteudo desenvolvido.

2.2. AREALIDADE VIRTUAL

Sabe-se que o mundo é compreendido pelos seres humanos através de seus
sentidos e sistemas de percepc¢do. Tudo o que se sabe sobre a nossa realidade vem
por meio dos sentidos. Em outras palavras, toda nossa experiéncia da realidade é
simplesmente uma combinacdo de informagdes sensoriais € nossos cérebros,
mecanismos que determina sentido a essas informacgdes. Parece légico entdo, que
se forem apresentados aos sentidos informacdes mentirosas ou inventadas, a
percepcdao da realidade também mudard em resposta a isso. A pessoa sera
apresentada a uma versao da realidade que ndo estd realmente 13, mas a partir de
sua perspectiva, seria percebido como real, gerando assim a chamada Realidade
Virtual (VIRTUAL REALITY SOCIETY, 2016a).

Sobre a historia por tras da Realidade Virtual (RV), Kirner e Siscoutto (2007,
p. 04) explicam, que as primeiras interfaces computacionais, usadas nas décadas de
40 e 50, somente permitiam uma comunicacdo com o computador baseada em

linguagem de maquina, algo muito distante dos conhecimentos dos leigos no



10

assunto. Anos depois, surgiram os consoles com video, dando inicio as interfaces
graficas rudimentares, mas ainda utilizadas apenas por especialistas. A partir do
avanco tecnolégico na area e a popularizagdao dos computadores pessoais isso foi

mudando.

Com a utilizagdo de microprocessadores, nas décadas de 70 e 80, os
microcomputadores se popularizaram, usando interface baseada em
comando, como o DOS. A evolugdo desta interface resultou no Windows,
que, explorando técnicas de multimidia, persiste até hoje. Apesar de
interessante e de ter bom potencial de uso, a interface Windows fica
restrita a limitagdo da tela do monitor e ao uso de representagdes como

menus e icones (KIRNER; SISCOUTTO, 2007, p. 04).

Como parte desta busca por melhores interacdes e interfaces
homem/maquina, surgiu entdo a Realidade Virtual (RV), que apesar de ter ganhado
forca apenas nos anos 90 e estar em um estagio de popularizacdo atualmente, ndo é
uma area de pesquisa nova. Investigacdes no campo da RV vem sendo realizadas ha
décadas, tendo sido reconhecida como uma poderosa ferramenta para a criacdo de
interfaces mais naturais e intuitivas entre computadores e humanos.

A Virtual Reality Society (2016) explica que realidade virtual é o termo
utilizado para descrever um ambiente tridimensional, gerado por computador, que
pode ser explorado e interagido por uma pessoa. Essa pessoa torna-se parte deste
mundo virtual ou esta imerso nesse ambiente e 1a é capaz de manipular objetos ou
executar uma série de ac¢des.

A RV, conforme Pan et al. (2006, p. 20), consiste na utilizacdo de sistemas de
computacdo grafica em combinag¢do com dispositivos de visualizacdo e de interface
para proporcionar um efeito de imersdao no ambiente interativo tridimensional
gerado por computador. Na definicdo de Tori e Kirner (2006, p.06), em outras
palavras, a Realidade Virtual é uma “interface avancada do usudrio” para acessar
aplicagGes executadas no computador, tendo como caracteristicas a visualizagdo de
ambientes tridimensionais em tempo real e a interagdo com elementos desse
ambiente. A experiéncia ainda pode ser aprimorada com estimulos a outros sentidos

humanos como o tato e a audigao.
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Assim como qualquer nova tecnologia, a interagdao com os dispositivos de RV
necessita de um tempo de aprendizado, ainda que este seja curto. Mas a grande
vantagem das interfaces de RV é o fato de as habilidades e conhecimentos intuitivos
do usudrio poderem ser utilizados para a manipulacao dos objetos virtuais, como o

movimento natural da cabec¢a e maos por exemplo.

O importante é que haja por parte do usudrio a impressdo de estar
atuando dentro do ambiente virtual, apontando, pegando, manipulando
e executando outras agdes sobre os objetos virtuais, em tempo real, ou
seja, dentro de limites de tempo bem definidos, ou com atrasos que nao

lhe causem desconforto (TORI; KIRNER, 2006, p. 06).

As primeiras ideias de realidade virtual surgiram dos cineastas na década de
50, mas foi nos anos 60 com os estudos de Ivan Sutherland, que se introduziu os
primeiros conceitos e ferramentas do Projeto Assistido por Computador. Em 1965
Sutherland disse que queria fazer com que esse mundo (virtual) representasse o
olhar real, o som real, parecesse real e respondesse de forma realista as a¢des do
espectador (MAZURYK; GERVAUTZ, 1996, p. 02).

Embora fossem grandes as ambicdes de Ivan Sutherland ja em 1965, no
principio eram necessarios diversos equipamentos especiais como luvas, capacetes,
Oculos estereoscépicos, mouses 3D e outros, para que o usuario conseguisse
interagir com o ambiente virtual (KIRNER; SISCOUTTO, 2007, p. 05). Desde entdo tais
limitagdes vem sendo reduzidas ou eliminadas a medida que evoluem as tecnologias
de RV.

Nos anos 90 se tornou popular o VRML (Virtual Reality Modeling Language),
uma linguagem de representacdo de objetos e ambientes tridimensionais que, na
época, rapidamente se tornou o formato de arquivo padrdo para a transmissdo de
“mundos virtuais 3D” através da internet (TAUBIN et al., 1998, p. 1228). Na literatura
identifica-se inclusive a forte importancia do VRML como uma linguagem que
permitem a preparacdo e a interacdo com objetos virtuais para a Realidade Virtual
como um todo. Quando em seu auge, o VRML foi identificado como um dos recursos
mais populares nesta area (KIRNER; TORI, 2006, p. 29).

Mantendo sua importancia para a area de Realidade Virtual nos anos 2000,

as diversas possibilidades trazidas na época pela tecnologia VRML foram colocadas a
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prova em uma pesquisa realizada pelo Prof. Dr. José Luis Farinatti Aymone da
Universidade Federal do Rio Grande do Sul (UFRGS), que desenvolveu um modelo
virtual do Campus Central da UFRGS em Porto Alegre (AYMONE, 2003).

Foram utilizados modelos tridimensionais de prédios da UFRGS criados em
trabalhos anteriores para, juntamente com novos elementos, compor um cenario
interativo que possibilitou a realizacdo de um tour virtual por entre as edifica¢gdes do
Campus (Figura 2) e areas internas da Faculdade de Arquitetura da UFRGS (Figura 3).
Diante das limitacdes de processamento computacional e de internet da época, a
pesquisa obteve 6timos resultados com a otimizagdao dos modelos tridimensionais
utilizados, propiciando uma experiéncia de realidade virtual fluida e agradavel que

pode ser utilizada para fins de ensino posteriormente.

Figura 2 - Visualizagcdo externa dos prédios do Campus Central da UFRGS em realidade virtual.
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Figura 3 - Sagudo do prédio da Faculdade de Arquitetura da UFRGS em realidade virtual.
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Fonte: AYMONE (2003, p. 02).

Com o passar dos anos a realidade virtual (RV) amadureceu e se tornou uma
tecnologia util para muitas areas que ndo sé o ensino, como a medicina, a construcao
civil, o entretenimento, etc. No Design de produto tecnologias de RV podem ser
ferramentas de projeto eficientes e eficazes desde a fase inicial do processo de
concepcdo até atividades especificas do projeto, como por exemplo, a gestdo do ciclo
de vida do produto (YE et al., 2007, p. 1193). Um ambiente de desenvolvimento de
produto baseado em RV pode fornecer uma melhor visualizacdo, interacdo e
manipulagdo do produto antes mesmo de ser posto na linha de produgao.

Seja para estes ou outros fins, estas tecnologias estdo remodelando as
interfaces e interacdes das pessoas com os ambientes virtuais oferecendo novas
abordagens para a comunicacdo de informacdes, a visualizacdo de processos,
expressao de ideias, o entretenimento e muito mais.

Em se tratando de entretenimento, é por ele que estamos vendo a realidade
virtual se popularizar, se tornando mais presente na vida de todos e com promessas
de revolucionar nossas vidas. Recentemente algumas iniciativas de empresas de
tecnologia trouxeram ao mercado produtos que, semelhantes aos primeiros
dispositivos especiais de RV, possibilitam tanto a visualizagdo como a interacdo do

usuario com os mais diversos ambientes 3D. Em sua maior parte, tais iniciativas estao
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voltadas ao mundo dos jogos digitais e dos filmes, oferecendo um apelo mais do que
suficiente para que todos queiram usufruir da tecnologia. Algumas das iniciativas
recentes mais relevantes neste universo da realidade virtual e entretenimento sao o
Oculus Rift e o Cardboard.

O Oculus Rift é um display de realidade virtual com audio integrado e com
formato que lembra em parte uns dculos. Criado pela empresa americana Oculus e
anunciado pela primeira vez no ano de 2012 ainda em fase de desenvolvimento, teve
sua primeira versao voltada ao consumidor final (Figura 4) somente em 2016. Visto
gue anteriormente algumas empresas ja tentaram criar um produto parecido, o Rift

é talvez o mais funcional e o primeiro a ter chances reais de fixagdo no mercado.

Figura 4 - Versao final do Oculus Rift, destinada ao consumidor final.

Fonte: PAGET (2016).

Este dispositivo deu o inicio a promissora era da RV, inicialmente tendo como
apelo os jogos digitais e posteriormente sendo abastecido de aplicacdes para as mais
diferentes finalidades. A empolgacdo e as promessas em torno do Oculus Rift foram
tao grandes, que em margo de 2014 o CEO do Facebook, Mark Zuckerberg, anunciou
a compra da empresa Oculus por cerca de dois bilhGes de ddlares e desde entdo é a
responsavel pelo ciclo de desenvolvimento continuo e promocgdo deste produto.

Frente ao cenario criado pelo Oculus Rift, em 2014 foi a vez da Google

apresentar a sua proposta de visualizador de realidade virtual. Buscando uma
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maneira de levar o maior nimero de pessoas possivel a experimentar a RV. E
considerando que grande parte da populacdo mundial tem hoje um smartphone, a
Google criou entdo o Cardboard (Figura 5). Um produto essencialmente composto
por papeldo, com custo de producdo extremamente baixo e especificacOes
disponiveis para qualquer um monta-lo facilmente e que em conjunto com um
smartphone pode trazer a experiéncia da RV utilizando os principios basicos do

préoprio Oculus Rift.

Figura 5 - Primeira versao do Google Cardboard langada em 2014.

Fonte: CAMPO (2016).

Sendo livre a sua reproducgao, rapidamente surgiram diversos outros modelos,
comerciais ou ndo, que utilizavam a légica de funcionamento do produto da Google.
Alguns destes modelos sdo confeccionados em diferentes materiais, oferecendo até
mesmo maior conforto e funcionalidades em comparacdo a ideia “popular” da
gigante de tecnologia. Em 2015 a Google ainda lancou uma nova versdo aprimorada
do Cardboard, mas que em esséncia pouco mudou.

Foi entdo que no embalo destas duas bem-sucedidas iniciativas e no
promissor mercado criado, outras grandes empresas de tecnologia resolveram
apostar na RV e trouxeram novos dispositivos que estdo rapidamente ganhando
forca, esse é o caso do Vive da HTC, do Playstation VR da Sony, do Gear VR da

Samsung e do Daydream View, outro produto de RV da Google. Para complementar
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ainda mais essas novas experiéncia de RV com um maior numero de respostas
sensoriais aos usuarios, alguns outros produtos estdo sendo desenvolvidos como
luvas, joysticks, esteiras omnidirecionais e uma série de sensores que mapeiam o0s
movimentos e o ambiente no qual ele esta inserido.

Por sua vez, toda a parte de software para trabalhar em conjunto com estes
dispositivos esta avancando também a largos passos. Para suprir a necessidade de
aplicativos e conteudos interativos para estas novas plataformas, desenvolvedores
aliam a tradicional forma de criacdo de ambientes tridimensionais, muita utilizada
nos jogos digitais, com os requisitos de intera¢ao e sensagdes proprias da realidade
virtual.

E para acompanhar o desenvolvimento de conteudos para estes dispositivos,
os softwares de criacdo de conteudo tridimensional virtual também estdo se
adaptando aos novos requisitos dos projetos destinados a realidade virtual. Dentre
os softwares de criacdao de ambientes interativos 3D, a Unreal Engine, a partir de sua
versdo 4.12, se destaca por oferecer um modo de edicdo (Figura 6) no qual é possivel
utilizar como manipulador os préprios dispositivos para os quais o conteldo esta
sendo criado, levando a interacdo intuitiva e natural, prépria da RV, para as etapas

de criacdo das aplicagdes.

Figura 6 - Modo VR Editor da Unreal Engine que utiliza um editor em realidade virtual para construir

ambiente para a prépria RV.

Fonte: PASCHALL (2016).
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Surge entdo uma nova forma de desenvolver ambientes tridimensionais
virtuais destinados a realidade virtual, que sejam reproduzidos tanto em
computadores pessoais como em dispositivos mdveis. Esse e outros requisitos
caracteristicas dos conteldos para RV se encontram com as possibilidades da
tecnologia WebGL.

Visualizando as vantagens da utilizacdo do WebGL e seu futuro promissor
para a criagao deste tipo de conteldo, grandes empresas, como a Mozilla e a Google,
estdo investindo na construcdo de ferramentas para esta finalidade. A Mozilla criou
uma biblioteca de desenvolvimento para WebGL (ver item 2.7.1), chamada A-Frame,
com suporte total a reproducdo em Realidade Virtual e de facil aprendizado. Ja a
Google, utilizando o WebGL, oferece na pagina do Chrome Experiments for Virtual
Reality arquivos base para a inser¢dao de cenarios e objetos 3D em ambientes

preparados para a RV.

2.3. A REALIDADE AUMENTADA

Considerada por diversos autores parte da Realidade Virtual e por tantos
outros uma tecnologia paralela a RV, a Realidade Aumentada (RA) ou Realidade
Mista como explica Pan et al. (2006, p. 20), refere-se a incorporacdo de objetos
graficos virtuais em uma cena real tridimensional, ou, alternativamente, a inclusdo
de elementos do mundo real em um ambiente virtual. Enquanto a Realidade Virtual
“mergulha” os sentidos em um mundo totalmente digital, a Realidade Aumentada
projeta objetos digitais, como modelos 3D, videos, imagens e sons em nossa visao
da realidade, como se realmente estivessem |4 (VIRTUAL REALITY SOCIETY, 2016b).

Em outras palavras, a RA mantém a presenca do mundo real, enquanto que,
na RV “pura” o ambiente é todo virtual e controlado por computador. A colocacdo
de conteldos virtuais, de duas ou trés dimensdes, no ambiente real e com uma
interagao processada em tempo real, facilita a visualizagdao e possiveis analises que
correlacionem o objeto virtual e o ambiente fisico. Um exemplo sdo os aplicativos de
RA onde é possivel visualizar como certo mobilidrio ou peca de decoragao ficard em

um comodo de uma casa, antes mesmo de compra-lo, reduzindo incertezas (Figura
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7). Como ferramenta é utilizada por diferentes profissionais e fins na drea médica,

engenharias, publicidade e muitos outros.

O fato dos objetos virtuais serem trazidos para o espaco fisico do usuario
(por sobreposicdo) permitiu interagdes tangiveis mais faceis e naturais,

sem o uso de equipamentos especiais (KIRNER; SISCOUTTO, 2007b, p.05).

Figura 7 - Exemplo de visualizagdo de mobilidrios sobrepostos a um ambiente fisico a partir da Realidade

Aumentada.

Fonte: GUENO (2014).

A vantagem de realidade aumentada sobre livros, por exemplo, ou outras
fontes de dados off-line é que a informacado pode ser apresentada no mesmo local
gue o objeto que se relaciona. Isto fornece o contexto para a informagdo, muitas
vezes tornando-o mais atraente e facil de entender. A capacidade de contextualizar
e localizar informacao virtual € uma das maiores forgas da tecnologia de realidade
aumentada (WITHER; DIVERDI; HOLLERER, 2009, p. 679).

Historicamente a tecnologia foi propiciada pela evolucdo tecnolégica na
década de 90, permitindo a sobreposicao de objetos virtuais com o ambiente fisico,
através de algum dispositivo tecnoldgico. Entretanto, essas aplicagdes somente se
tornaram mais acessiveis a partir do inicio dos anos 2000, com a convergéncia de
técnicas de visdo computacional, software e dispositivos com melhor custo-
beneficio, possibilitando uma melhor qualidade da experiéncia em RA e ampliando

suas possibilidades de aplicacdo (KIRNER; SISCOUTTO, 2007b, p. 05).
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O momento favordvel dos ultimos anos, em termos de avangos tecnoldgicos,
criou uma série de expectativas para uma nova geracao de interfaces baseadas em
RA. Mais uma vez, como o ocorrido na Realidade Virtual, a area do entretenimento
é uma das que mais contribui para a popularizacdo da tecnologia pois por meio dela
se atinge escalas de consumo de conteudo bastante altas. Praticamente ao mesmo
tempo em que ocorreu a recente explosao de entusiasmo e avangos com a realidade
virtual, a realidade aumentada também despertou interesses das gigantes da
tecnologia que trouxeram produtos promissores e com abrangéncia.

Novamente a Google deu os primeiros passos da “era moderna” da realidade
aumentada com o Google Glass e o Project Tango. Mesmo a RA sendo uma tecnologia
utilizada hd alguns anos e de relativa facilidade de acesso, a Google trouxe a ela
novos patamares e aplicacdes mais robustas.

O Google Glass (Figura 8), uma espécie de 6culos que utilizando a RA e uma
Inteligéncia Artificial, projeta em uma tela transparente em frente aos olhos do
utilizador, informacGes relacionadas a acdes do proprio usuario ou do ambiente ao
seu entorno (Figura 9). O produto foi um sucesso em termos de expectativas e
promessas e por alguns anos contou com a ajuda de muito desenvolvedores e
entusiastas em seu desenvolvimento. O produto da Google ndo chegou ao publico
em geral com um bom custo/beneficio e perdeu um pouco do seu encantamento.
Atualmente existem alguns rumores de que o projeto foi extinto pela prépria Google
qgue talvez novamente surpreenda o mundo com uma evolucdao do produto em

guestao.

Figura 8 - Google Glass, uma das apostas da Google com dispositivos inteligentes vestiveis e que utiliza a

RA.

Fonte: KEATS (2014).



20

Figura 9 - A ideia do Google Glass é sobrepor a visdo do mundo real do utilizador com informagGes Uteis

e respostas as suas acdes.

AN

Fonte: AXIOM (2013).

A nova aposta da Google foi entdo o Project Tango. Uma tecnologia a ser
incorporada em dispositivos mdveis (smartphones e tablets), que através de uma
série de sensores permite que os aparelhos detectem a sua posicdo e mapeiem em
3D o mundo em torno deles sem utilizar GPS ou quaisquer outros sinais externos.
Usando um projetor de infravermelhos e um par de cameras extras, ele pode
detectar coisas como paredes e pisos com certa precisao ou capturar uma varredura
3D detalhada de um espago e isso representa um grande potencial de expansao para
a realidade aumentada.

O Project Tango permite que aplicativos rastreiem posicdo e orientacdo de
objetos dentro de um ambiente 3D detalhado. Isso torna possivel aplicagdes como,
medicdo visual, utilitdrios de mapeamento, apresentacao e ferramentas de Design,
bem como uma grande variedade de jogos imersivos. Tais aplicagdes funcionam a
partir de principios da Realidade Aumentada, porém esta nova tecnologia da Google
aprimora, e muito, as possibilidades.

O primeiro aparelho comercial a embarcar o Project Tango é o Lenovo Phab?2
Pro (Figura 10), um smartphone que terd a chance de provar se a tecnologia tera
sucesso pelo seu potencial ou serd deixada de lado em pouco tempo como o ocorrido

com o Google Glass. De uma maneira ou outra, € um marco diante dos esforcos de
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aperfeicoar a realidade virtual como um todo e mais especificamente a realidade

aumenta para fornecer ferramentas realmente Uteis ao ser humano.

Figura 10 - Lenovo Phab2 Pro, primeiro smartphone com a tecnologia Project Tango, realizando a

medic¢do de objetos a distancia.

Fonte: URBANO (2016).

Outro aparelho de RA e de funcionalidades promissoras é o HoloLens da
Microsoft (Figura 11). Mesmo ainda ndo sendo possivel encontra-lo nas lojas o
HoloLens ja encheu de expectativas aqueles que sonham unir o “mundo real” ao
encantamento e possiblidades dos ambientes virtuais. Funciona assim, basicamente
coloca-se o dispositivo, que se parece com uns 6culos, em sua cabeca e o visor

“projeta” conteldo sobre o ambiente que vocé estiver vendo.

Figura 11 - O HololLens pode ser um instrumento profissional importante.

Fonte: MICROSOFT (2016).
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Ele possibilita uma interacdo em tempo real, com gestos naturais e com
processamento interno, sem a necessidade de estar conectado a um computador
como no caso dos 6culos de realidade virtual Oculus Rift e HTC Vive. Esta interagao
também pode ser compartilhada com outras pessoas que estejam utilizando o
produto, ampliando ainda mais o seu potencial. Assim, sendo para jogar ou trabalhar,
a Microsoft aposta que o HoloLens serd a grande ferramenta de mistura dos mundos

fisico e virtual dos ultimos anos.

2.3.1. Elaboragao de conteudo para a Realidade Aumentada

Pode-se dizer que a realidade aumentada ja é popular entre pesquisadores e
entusiastas ha alguns anos. Prova disso é um dos estudos do Prof. Claudio Kirner de
2004 onde ele utilizou uma ferramenta de criacdo de realidade aumentada para

aprimorar a visualizagdo de dados na forma de graficos tridimensionais (Figura 12).

Figura 12 - Gréficos tridimensionais sendo visualizados por meio da realidade aumentada.

Fonte: KIRNER et al. (2004, p. 08).

Desde os anos 90 surgiram diversos softwares que auxiliavam na criacdo de

experimentos simplificados com RA. Para usd-los era necessdrio geralmente dispor
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de um computador com webcam instalada, que lia informagdes de um cédigo visual
posicionado no ambiente fisico. Com o tempo apareceram os smartphones e tablets,
e entdao foram criados novos aplicativos que utilizam os componentes presentes
neles préprios, como o seu processamento, tela e camera.

Em se tratando da tecnologia WebGL como suporte para a criagdo de
Realidade Aumentada, assim como na Realidade Virtual, recentemente foram
criadas algumas bibliotecas de desenvolvimento que trabalham também com a RA.
A que se destaca é a awe.js, que tem como foco a RA e oferece uma documentacao
facilitada para que iniciantes possam trabalhar com ela. A grande vantagem de aliar
o WebGL a RA é poder distribuir os conteddos gratuitamente para diversas
plataformas sem a necessidade de se ter um aplicativo especifico para visualiza-lo a
ndo ser um navegador de internet qualquer, ja presente em qualquer computador,
smartphone ou tablet. Outro beneficio é a ampliacdo da gama de interacdes possiveis
de serem realizadas, podendo até mesmo correlacionar interferéncias realizadas em
objetos virtuais projetados através da RA com ag¢des no mundo fisico, como por

exemplo, enviar comandos para alterar a cor da iluminacdao de um ambiente.

2.4. OS AMBIENTES TRIDIMENSIONAIS VIRTUAIS

Apods a compreensdo de como se insere a representacdo tridimensional virtual
no Design e a importancia, influéncia e aplicacdo das realidades virtual e aumentada
desde o principio até os dias de hoje, é necessdrio entender como sido definidos e
construidos os ambientes em trés dimensdes, que sdao o centro do assunto e

fundamentais para o seu desenvolvimento.

Um ambiente envolve um determinado espago e uma situagao delimitada,
incluindo todos os componentes neles inseridos, como o conjunto de
objetos e de condicdes passiveis de serem percebidos e com os quais é
possivel interagir. Um ambiente virtual € um ambiente interativo, gerado
por um computador e disponibilizado através de um sistema de realidade

virtual (Stuart, 1996 apud KIRNER; SALVADOR, 2007, p. 91).
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Definido resumidamente por CUNHA e MAINENTE (2011, p. 05), um ambiente
virtual € um cendrio tridimensional, gréfico e interativo gerado por computador, com
0 objetivo de possibilitar uma representacdo cibernética similar ao mundo fisico,
onde o usudrio pode mover-se através dele e com recursos que propiciam uma
sensacado de profundidade e imersao.

Em vista disto, um ambiente virtual tridimensional (AV3D) possui ao menos
guatro caracteristicas essenciais que o identificam, como a evidente representacao
em trés dimensdes; a interatividade, no minimo a nivel de navegacao; a imersao, em
mundos que imitam a realidade ou cendrios inteiramente inventados e a inser¢ao
em um espaco também tridimensional. Tal espaco, que também é definido pelas
dimensdes altura, largura e profundidade, é aquele onde estdo inseridos os objetos,
animacgdes e interacbes que em conjunto caracterizam um ambiente 3D por
completo.

Como explicita NASCIMENTO (2010, p. 09), juntamente com a animacgdo e a
interacdo (estudos a parte nos itens 2.4.1 e 2.4.2), os objetos 3D sdo elementos
essenciais de um cenadrio tridimensional (Figura 13), uma vez que representam as
entidades materiais do mundo real emulado pelo ambiente virtual. De acordo com o
uso ao qual o objeto se destina, diferentes técnicas de criacdao, representacdo e

realismo podem ser adotadas.

Figura 13 - Exemplo de ambiente virtual (cidade) composto por objetos 3D (edificios) e inserido em um

espaco tridimensional delimitado.

Fonte: GHALL (2011).
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Os AV3D servem tanto para simular lugares fisicos no mundo real, bem como
mundos imaginarios. Estdo presentes em uma ampla gama de aplicacbes da
educacdo e formacao, a exploragdo cientifica e visualizacdo, Design e prototipagem,
diagndstico médico, entretenimento digital e muitos outros. Existe uma busca
constante para se criar experiéncias virtuais com cada vez mais fidelidade, o que na
maioria das vezes esta ligado diretamente ao estdgio atual de desenvolvimento do
poder de processamento da computagao grafica (ZHANG; WU, 2012, p. A13).

Hoje, em diversas dreas os ambientes 3D virtuais sdo de grande importancia
e talvez seja no Design onde eles encontram a maior pluralidade de aplicagdes.
Equilibrando técnica e criatividade, designers fazem uso dos AV3D para criar jogos
digitais, visualizacGes realistas de produtos, cenarios cinematograficos,
representacdes técnicas, simulagdes computacionais, ambientes educacionais,
material publicitario e o que mais a imaginacdo permitir.

Quanto a visualizagdo e distribuicao destes ambientes virtuais, em particular
por meio da internet, houve uma constante evolucdo desde o VRML até o WebGL.
Projetado para fornecer uma maneira padronizada para descrever informac¢ées 3D
interativas para aplicativos baseados na Web, o VRML se estabeleceu nos anos 90
como a forma mais eficiente de se construir e disseminar contelddos tridimensionais,
podendo ser gerado por softwares de modelagem 3D facilmente (KENT; WILLIAMS,
2002, p. 180).

Apesar das vantagens trazidas pelo VRML e da significativa quantidade de
trabalhados realizados com ele na época, aos poucos ele foi sendo substituido por
tecnologias com menos limitacdes e que aproveitavam melhor os novos recursos
advindos da evolucdo da computacdo. Basicamente como um aperfeicoamento do
VRML, mais maduro e refinado, o X3D, uma arquitetura de formato de arquivo
padronizada, também tinha por objetivo representar e comunicar cenas 3D e objetos
(WEB3D CONSORTIUM, 2016). Ainda que prometendo diversos avan¢os com relagdo
ao VRML, o X3D ndo se consolidou da mesma maneira que seu antecessor, que
continuou sendo utilizado mesmo que perdendo no decorrer dos anos.

Algumas iniciativas no ambito educacional ainda mantém vivo o padrao de
linguagem para modelagem de realidade virtual, popular nos ultimos anos do século
XX. Uma delas é a disciplina de Design Virtual da pdés-graduacdo em Design da

Universidade Federal do Rio Grande do Sul, ministrada pelo professor doutor José
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Luis Farinatti Aymone, que apresenta aos alunos os principais conceitos e estruturas
do VRML como forma de introduzi-los neste universo.

No entanto, hoje, o promissor WebGL busca uniformizar a programacao de
graficos 3D para distribuicdo online ou off-line. Devido as suas vantagens em relacdo
as tecnologias anteriores (ver item 2.7), estd sendo rapidamente adotado como o
novo e promissor padrdo, principalmente para a Web. O sucesso do WebGL gera
interesse em grandes e pequenos do mundo da tecnologia e diariamente suas
aplicagbes vém sendo aprimoradas.

Vale ressaltar que as interfaces e padrdes voltados a visualizagdo e
compartilhamento de conteddo 3D ndo se resumem somente a estas trés
tecnologias, todavia estas sdo as que tiveram maior representatividade e impacto ao

longo dos ultimos anos e serdo as estudadas neste trabalho.

2.4.1. A animag¢dao em ambientes virtuais 3D

Caracteristica fundamental em um ambiente tridimensional interativo, a
animacdo virtual, de um objeto, cdmera ou cendrio como um todo, existe quando
ocorre mudanca na forma dos componentes ou cena com o tempo, em diferentes
niveis, através de ativadores ou de comportamentos pré-determinados (PAL;
SARKAR, 2002, p. 169). Essa alteracdo de forma dos objetos compreende a
transformacdo de determinados parametros, como por exemplo posicdao, tamanho,
cor, textura e outros.

“A palavra animag¢do provém do latim Animus/Anima, que significa ar,
respirar, vida, alma e mente. Animar é entdo dar a ilusdo de vida no que esta
inanimado” (LUZ, 2009, p. 921). Fundamentalmente, na animacgao virtual existe um
comportamento de mudanca de estado atribuido a um objeto também virtual.

A animacao tridimensional apresenta algumas caracteristicas que a diferem
da animacdo em duas dimensdes (bidimensional). Ela procura simular filmagens ou
perspectivas do mundo real, possibilitando ver uma cena criada em computador, de
varios angulos ou pontos de vista, pois se trata da criagao de modelos num espago

tridimensional, possuindo comprimento, largura e profundidade (DUARTE, 2016).



27

Apesar dos outros tantos pardmetros possiveis de serem trabalhados, o
movimento foi sempre o objetivo central da animacdo. Simplificando seu conceito,
até pode-se dizer que animar é o processo de dar movimentos a cameras, luzes ou
objetos que fazem parte da cena. Para tal, existem diversas técnicas de criacdo de
movimentos totalmente gerados por computador e captura de movimento a partir
de objetos reais, para serem inseridos em ambientes virtuais.

Naturalmente as técnicas utilizadas para desenvolver uma animagdo variam
de acordo com o objetivo proposto e o grau de experiéncia do animador, podendo ir
de um simples deslocamento ou rotagdao de um objeto 3D rigido em uma cena até
mesmo um complexo sistema de animacdo que simula as colisdes tal qual
aconteceriam com os objetos fisicos, como ja é utilizada em grandes estudios de

animacado como a Pixar (Figura 14).

Figura 14 - Dedo do personagem se deforma de forma realista com o sistema de colisdes utilizado pelos

Estudios Pixar.

Fonte: MURATTAHAN (2012).

Independentemente do tipo de animacdo, 2D, 3D, stop-motion ou de técnica
mista, programada ou executada em tempo real, pode-se dizer que ela é formada

substancialmente por uma sequéncia de imagens estaticas, chamadas quadros, cada
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qual com um estado da forma diferente do anterior, que em conjunto representam
um movimento ou outra alteracdo visual no objeto animado. Quanto maior o numero
de quadros por segundo de animag¢ao, maior a fluidez da mesma e menor a sensagao
visual de cortes durante uma movimentacdo, por exemplo.

Cenas de animacdo tridimensional geralmente contém alguns objetos
estaticos agrupados com a funcdo de ambientacdo e objetos animados que mudam
seu estado ao longo do tempo. Além disso, as cenas sdo vistas usando cameras
virtuais e podem ser iluminadas por fontes de luz sintéticas. Estas cameras e luzes
também podem sofrer alteracdo ao longo do tempo, como se manipulado por
operadores de camera (THALMANN, 1993, p. 05). O problema a se resolver é saber
utilizar o método mais adequado para tornar algo animado.

Os métodos de animacgao 3D virtual ndao diferem muito daqueles utilizados
para criar os antigos desenhos animados desenhados originalmente a mao. De
acordo com o Prof. Eliseu Lopes (2005, p. 41, 42 e 43) existem basicamente dois

métodos para se animar:

e ANIMACAO DIRETA (STRAIGHT-AHEAD) — que consiste em ir
desenhando quadro a quadro (Figura 15), um apés o outro em
sequéncia, desde a condicdo inicial do objeto, personagem, camera,

etc., até ultimo ponto do curso da animagao.

Figura 15 - No caso desta animacdo os 14 desenhos (quadros) que comp&em o movimento foram

desenhados um seguido do outro em animagao direta.

Fonte: (LOPES, 2005, p. 42).
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e ANIMACAO DE EXTREMOS (POSE-PLANING) — neste se usa as pontas
de animacdo ou posi¢cées chave (Figura 16). Consiste em desenhar
primeiro as posi¢des extremas ou principais de uma agdao e
posteriormente utilizar alguma técnica ou ferramenta que auxilie na

interpolacdo deste, criando assim os quadros intermedidrios.

Figura 16 - Neste caso, os desenhos chaves ou pontas precisam ser interpolados.
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Fonte: (LOPES, 2005, p. 42).

Geralmente animacgdes criadas com o método de Animacdo Direta possuem
baixas taxas de quadros por segundo por ser um processo mais trabalhoso. Porém,
ainda que penoso, é bastante utilizado em animac¢des confeccionadas através da
sucessao de fotografias feitas uma a uma, o chamado stop-motion. J4 o método de
Animacado de Extremos é o mais eficiente quando se trata de animacgao 3D, devido a
facilidade com que o os programas de animacao intercalam estas pontas.

Wilson Paula (2000, p.24) destaca que a qualidade grafica ou quantidade de
quadros por segundo da animacado criada para ser executada em tempo real, como
em dispositivos de Realidade Virtual ou Aumentada, é limitada pela velocidade de
processamento do dispositivo utilizado. Este se configura como um dos principais
desafios da RV e RA para proporcionar uma imersdo cada vez mais préxima ao mundo
fisico. Qualidade grafica e desempenho de visualizagdo devem ser equilibrados
durante o desenvolvimento de uma aplicagdo para RV.

A animacado para realidade virtual tende a ser cada vez mais baseada na fisica
e em métodos de simulacdo dindmica. Como visto, ja se utiliza hoje dispositivos de

RV e métodos de simulacdo para a criacdo de complexas animag¢bes e ambientes
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virtuais por inteiro, construidos para serem executados em tempo real e com
interagdes progressivamente mais naturais.

Independentemente do método utilizado, a animagdao 3D é utilizada em
muitas industrias, como a do entretenimento, publicidade e técnica cientifica.
Conforme BEANE (2012), cada industria usa a animag¢do em 3D de maneiras
completamente diferentes e para saidas distintas, incluindo filmes, jogos,
prototipagem rapida, e muitos outros. Sem duvida o Design se faz presente em todas
estas dreas e seus produtos e por isso a animacdo é considerada uma ferramenta

importante para designers que desejem trabalhar nestes setores.

2.4.2. Ainteracao em ambientes virtuais 3D

Também essencial nos ambientes virtuais, a interacdo segundo ZORZAL et al.
(2007, p. 262) desperta o interesse dos usudrios e é capaz de potencializar o
entendimento de determinada visualizacdo. Interagindo com um sistema, o usudrio
pode alterar a visualizagdo do mesmo a fim de alcancar objetivos.

“No contexto de interface homem-maquina, interacdo é a maneira com que
0 usuario se comunica com a aplicacdo, podendo esta comunica¢do ocorrer através
de dispositivos ou de forma simbdlica” (SCHNEIDERMAN; PLAISANT, 2004 apud
KELNER; TEICHRIEB, 2007, p. 53).

Outra forma de conceitualizar a interacdo nos ambientes virtuais 3D é
identificando seus principais tipos, que segundo ROGERS, SHARP, PREECE (2013, p.

47) sdo quatro:

e Instrug¢do — quando os usudrios emitem instrugdes a um sistema. Isso
pode ser feito de inUmeras maneiras, incluindo: digitar comandos,
selecionar opgdes de menus em um ambiente de janelas ou em uma
tela multitoque, comandos sonoros, gesticular, pressionar botdes ou
usar uma combinacdo de teclas de funcgao;

e Conversagao — quando os usuarios tém um didlogo com um sistema.
Eles podem falar por meio de uma interface ou escrever perguntas que

o sistema responde via texto ou saida de voz;
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e Manipulagdo — quando os usudrios interagem com os objetos em um
espaco virtual ou fisico, manipulando-os (por exemplo, abrir, segurar,
fechar, colocar);

e Exploragdao — quando os usudrios se movem por um ambiente virtual
ou um espaco fisico. Ambientes virtuais incluem mundos 3D e sistemas

de realidade virtual e aumentada.

A interacdo do usudrio também pode ocorrer de diferentes formas de acordo
com a natureza do ambiente 3D. Ambientes podem ser classificados como
fisicamente imersivos, quando utilizam dispositivos especiais para esse tipo de
interacdo, como os 6culos de Realidade Virtual, volantes controladores para
simuladores de corrida com resposta haptica (ex.: vibracdo) (Figura 17) ou ainda
luvas com sensores que captam os movimentos do usudrio e provocam nele
sensacoOes fisicas como forca, pressdo, peso e outros. Ou ainda, mentalmente
imersivos, quando o usuario tem uma profunda sensacdo de participacdo e
envolvimento no sistema, mesmo sem estimulos corporais (NASCIMENTO, 2010, p.

06 e 07).

Figura 17 - Conjunto de volante, transmissdo e pedais para simuladores virtuais de corrida.

Fonte: RALLYE DESIGN (2011).
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Cenarios virtuais tridimensionais interativos, onde sua manipulacdo é feita
através de dispositivos de uso geral (como mouse e teclado) (Figura 18), podem ser
classificados como sistemas com imersdao mental, uma vez que ocorra uma forte

sensacado de envolvimento e interacdo por parte do usudrio.

Figura 18 - Interagdo em ambientes imersivos através de teclado e mouse convencionais.

Fonte: UPLOA (2013).

Resta entender para qual propriedade os designers devem dar maior atencao
com relacdo a qualidade da interacdo ao desenvolver um ambiente tridimensional
virtual, seja para realidade virtual, realidade aumentada ou qualquer outra
finalidade. Esta propriedade parece ser a usabilidade, utilizada para “descrever a
gualidade de interagdao de uma interface diante de seus usuarios” (HIX; HARTSON,
1993 apud FERREIRA, 2002, p. 09).

A eficiéncia e facilidade de interacao passa pela usabilidade das interfaces de
um sistema virtual, no caso, um ambiente 3D. De acordo com PRATES e BARBOSA
(2007, p. 266) a usabilidade compreende os seguintes fatores:

e Facilidade de aprendizado;

e Facilidade de uso;

e Eficiéncia de uso e produtividade;
e Satisfacdo do usuario;

e Flexibilidade;
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e Utilidade;

e Seguranga no uso.

Compreendendo os tipos de interacdo e os parametros associados a ela é
possivel identificar requisitos para a andlise das ferramentas a serem integradas a

sistematizacdo de criagao de conteudo interativo 3D proposta ao fim desta pesquisa.

2.4.3. A criacdo de conteudos tridimensionais por designers

De acordo com Martins (2000 apud KIRNER; SALVADOR, 2007, p. 93) o
desenvolvimento de ambientes virtuais engloba o estudo da modelagem grafica 3D
e da interface humano-computador (IHC), sendo que esta diretamente ligado ao
realismo visual, percebido através de nossos sentidos, e a interagao.

Os objetos geométricos virtuais, também chamados de modelos 3D, sdo
criados por meio de softwares de modelagem tridimensional. S3o0 compostos por um
conjunto de malhas que arranjadas de certas maneiras, permitem o reconhecimento
do objeto no espaco tridimensional virtual. Logo, segundo Lima (2015, p. 64), sdo
“entidades em trés dimensdes construidas com ferramentas de modificacdo de
malha, que ocupam espaco em um cenario digital”. Em conjunto com luzes, cameras,
animacgoes, ac¢les interativas e outros elementos, formam, propriamente, o
ambiente virtual.

Atualmente existem diversos programas de modelagem 3D. Alguns possuem
um foco mais restrito, com fungdes mais refinadas e especificas para fins
determinados, como animagdo, simulacdo de esforcos e escultura digital, por
exemplo. Outros, apresentam utilidades mais generalistas e fun¢gbdes extremamente
diversificadas, possibilitando tanto a criacdo de objetos 3D Unicos, como ambientes
inteiros com animacgoes e interagdes das mais basicas as mais complexas.

A sequéncia de criacdo de modelos tridimensionais para jogos digitais
elucidada por Lima e Meurer (2011 apud LIMA, 2015, p. 65) também é mesma
utilizada na concep¢do da maioria dos objetos 3D virtuais no Design, sendo

constituida de trés niveis:
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Nivel Técnico — é a fase de entendimento e definicdo de onde o
modelo sera usado, para assim produzir sua malha tridimensional de
maneira adequada. Ha fins que exigem modelos com uma malha de
altissima definicdo (grande quantidade de poligonos - highpoly), como
o cinema por exemplo, e outros que necessitam de objetos 3D de
média ou baixa resolucdo (pequena quantidade de poligonos -

lowpoly), como os jogos digitais para dispositivo médveis.

Nivel Funcional — é a fase onde define-se como sera a construcdo das
malhas dos modelos de acordo com seus requisitos técnicos.
Dependendo da destinagdo, o objeto por ser desenvolvido com partes
possiveis de serem movimentadas separadamente, como é o caso dos
personagens de uma animac¢dao, ou sem elas. Isso influencia

diretamente em como seja construido o objeto no software.

Nivel Estético — resolvidos os aspectos técnicos e funcionais, pode-se
entdo trabalhar a estética do modelo, por meio da modelagem 3D
propriamente dita. Este € o momento de se trabalhar também as
guestoes visuais mais refinadas do modelo, como cores, materiais,

texturas e propriedades fisicas.

Toda esta sequéncia de passos para a criacdao de modelos 3D constitui apenas

uma das etapas do processo de desenvolvimento de um ambiente tridimensional, a

modelagem. Tal processo é formado por pelo menos trés macro fases compostas de

etapas mais especificas (JOAQUIM, 2012):

1. Modelagem
Concepcdo da geometria

Aplicacao de materiais e texturas

2. Configuracao do layout da cena
Mapeamento

lluminacgdo
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Geragao de Cameras

3. Geragao de cena
Renderizacdo (Imagens estaticas)
Animagao

Interagao

Destas, talvez a fase de modelagem seja a mais conhecida e dominada por
designers, especialmente os de produto. A fase de configura¢ao do layout da cena
também ndo apresenta grandes dificuldades aqueles que ja trabalham com
renderizacdo digital, também bastante comum na d4rea. A maior dificuldade
encontra-se na terceira fase, no momento de gerar as animacdes e interacdes da
cena em questdo (um jogo, filme, museu virtual...), que exige conhecimentos um
pouco mais avancados e muitas vezes a utilizacdo de softwares especificos voltados
a estas funcdes. Por exemplo, dependendo da complexidade das interacées
pretendidas ou do software utilizado, é necessario um entendimento consideravel
de programacdo ou o auxilio de um programador, para criar e atribuir os
comportamentos interativos aos objetos tridimensionais.

Atualmente temos diversos programas destinados a criacdo e edicdo de
conteudo tridimensional virtual, que mantém ciclos de atualizagGes continuas onde
constantemente adicionam e aprimoram func¢des. Observa-se também que é comum
a utilizacdo de mais de um software em conjunto durante um projeto, funcionando
como programas auxiliares em funcdes especificas (modelagem, animacao,
renderizacdo...), proporcionando uma melhor qualidade ou fluxo de trabalho que
programas mais generalistas. Destaca-se a seguir uma amostra de quatro programas

com caracteristicas relevantes ao assunto do trabalho.

2.4.3.1. 3ds Max

O primeiro software é o 3ds Max (Tabela 1), desenvolvido pela empresa
Autodesk, lider mundial no ramo de computacdo grafica tridimensional. Possui uma

versdao educacional gratuita e é um dos programas mais completos, trabalhando com



36

modelagem, animag¢des, renderizagOes, escultura digital e efeitos especiais de
qualidade profissional. Apesar do grande nimero de ferramentas disponiveis para as
mais diversas aplicacdes e formato de arquivos suportados, ainda existe uma grande
guantidade de complementos, os chamados plug-ins, que adicionam novas funcdes
ao software.

Vale lembrar que o 3ds Max é um dos poucos que mantém o suporte ao VRML,
sendo possivel exportar ambientes neste formato de forma nativa ao menos até a

versao 2017 do software.

Tabela 1 - Caracteristicas do software 3ds Max, versdo 2017.

L Existéncia Tipos de Sistemas Operacionais
Aplicagoes . .
de Plug-ins Licenga Suportados
Modelagem, Versao Paga e
3ds Max Animacio, ) Versdo . .
L Sim . Windows 7 (ou superior)
2017 Renderizagao, Educacional
Escultura Gratuita

2.4.3.2. Blender

Outro software é o Blender (Tabela 2), um programa de cddigo-aberto da
Blender Foundation, que estd em crescente popularidade devido a ser totalmente
gratuito e trazer muitos dos recursos dos grandes programas pagos em conjunto com
recursos inéditos. Por ser um software de cddigo-aberto, recebe constantes
atualizacdes e melhorias provindas de sua enorme comunidade de usuarios.

O Blender impressiona pelos varios recursos presentes em sua interface, para
modelagem, renderizagao, animacgao, simulacdo de particulas, criacdo de jogos e até

edicdo de videos.
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Tabela 2 - Caracteristicas do software Blender, versao 2.78c.

. . Sistemas
L Existéncia | Tipos de L.
Aplicagoes . . Operacionais
de Plug-ins | Licenga
Suportados
Modelagem, Animacgao, Windows Vista 32bit
Blender R'enderiz~ag50, Escm'Jltura, ‘ . ou 64bit (ou superio‘r),
Simulagdo de Particulas, Sim Gratuito Mac OS X 10.6 64bit
2.78c . . .
Desenvolvimento de Jogos, (ou superior) e Linux
Edicdo de Videos 32bit ou 64bit
2.4.3.3. Unity

Mais um software popular e com versao gratuita é a Unity (Tabela 3). Criado
pela Unity Technologies, a Unity se difere dos softwares de modelagem 3D, sendo
propriamente um Motor Grafico para Jogos (em inglés, Game Engine), que tem por
objetivo principal proporcionar ferramentas de criacdo, edicdo e publicacdo de jogos
digitais para as mais diversas plataformas de mesa e mobile. Sendo um dos mais
utilizados e reconhecidos nesta area.

Apesar de ndo ter foco na modelagem em si, a Unity fornece inumeros
recursos de criacdo de ambientes virtuais tridimensionais compostos de animacdes
e interatividade. Sendo possivel entdo, utilizd-la para desenvolver conteudos deste
tipo para fins distintos dos jogos. Por ser um programa de uso profissional, seus
recursos de animacdo e interacdo exigem conhecimentos avancados de
programacao, assim afastando um pouco os leigos e iniciantes.

Além da diversidade de ferramentas do programa, uma de suas grandes
vantagens é a possibilidade de exportar as criagbes para computadores,
smartphones, tablets, videogames e smart tvs. Recentemente, também foi
adicionado o suporte nativo ao WebGL, proporcionando a exportagao direta de
conteudo para ser visualizado e manipulado em qualquer dispositivo com navegador
compativel.

Outro fator importante da Unity é que ela permite a produgdo de conteudo

para Realidade Virtual e Aumentada, dando cada vez mais valor para este segmento.
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Tabela 3 - Caracteristicas do software Unity, versao 5.4.1.

L Existéncia Tipos de Sistemas Operacionais
Aplicagoes . .
de Plug-ins Licenga Suportados
Desenvolvimento " . .
. Versdo Windows 7 (ou superior)
Unity de Jogos, ) .
. R Sim Gratuita e e Mac OS X 10.8 (ou
5.4.1 Animacgao, N .
L Versdes Pagas superior)
Renderizacdo

2.4.3.4. Unreal Engine

Por dltimo, a Unreal Engine (Tabela 4), também um famoso Motor Gréfico
para Jogos, desenvolvido pela Epic Games. Inteiramente gratuito, tem por funcao
principal a criacdo de jogos digitais, mas, assim como o Unity, possui ferramentas
para criar ambientes interativos para quaisquer fins.

Apesar de possuir uma interface organizada e grande parte em portugués, o
programa ainda exige conhecimentos especificos de programacao para a criagao de
interacdes complexas. A grande vantagem deste software para os menos
familiarizados com linguagens de programacdo escrita, ele também possibilita a
criacdo de agdes interativas por meio de uma linguagem visual chamada Blueprint,
qgue foi criada pela propria Epic Games. Mesmo necessitando de um periodo de
aprendizado e de certo conhecimento prévio de programacao, o Blueprint (Figura
19) facilita bastante o processo de construcdo e adicdo de interatividade a objetos e
ambientes virtuais, oferecendo vantagens até mesmo para programadores

experientes.
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Figura 19 — Exemplo da estrutura de uma interagdo construida com a Blueprint, linguagem visual de

programacdo presente na Unreal Engine.
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Fonte: ROMERO (2014).

Outro ponto muito interessante da Unreal Engine sao os projetos prontos
embarcados no programa. Alguns pequenos jogos e ambientes foram incluidos como
exemplos dos recursos do software e também s3do otimas ferramentas de
aprendizagem da linguagem Blueprint, ja que todos eles sdo editdveis e construidos
de maneira a facilitar o seu entendimento. E possivel ainda, utilizar pedacos prontos
destes codigos para inclusdao em outro projeto que esteja necessitando de fungdes
semelhantes, bem como comprar cédigos prontos na loja virtual do programa.

Em se tratando de Realidade Virtual, a Unreal estd sempre buscando
aprimorar suas ferramentas. Um exemplo é o modo VR Editor, onde a edi¢cdo do
conteudo é realizada utilizando os préprios dispositivos de RV que sera plataformas

de execucdo dos jogos criados.
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Tabela 4 - Caracteristicas do software Unreal Engine, versao 4.13.

. Existéncia Tipos de Sistemas Operacionais
Aplicagoes . .
de Plug-ins Licenga Suportados
Desenvolvimento Windows 7 64bit (ou
Unreal
) de Jogos, . . superior), Mac OS X 10.9.2
Engine i R Sim Gratuito )
. Animacao, (ou superior), Ubuntu
L Renderizacdo 15.04 (ou superior)

2.5. A PROGRAMAGAO ORIENTADA A OBJETOS (POO)

Em se tratando de como sdo criados os ambientes tridimensionais virtuais,
mesmo no Design, vale entender sobre a Programacdo Orientada a Objetos (POO) e
porque ela é importante quando falamos sobre objetos virtuais com propriedades e
funcdes, sejam eles modelos 3D ou entidades (instancias) abstratas.

Segundo David Hemmendinger (2008), a programacao orientada a objetos é
o uso de unidades modulares de programacao (objetos?, classes?, subclasses?, e assim
por diante), a fim de tornar a programacao mais rapida e de facil manutencao, se for
0 caso. Linguagens orientadas a objetos ajudam a gerenciar a complexidade em
grandes programas, permitindo a um programador pensar em cada parte do
programa de forma isolada.

Em outra definicdo, a POO é a pratica de criar uma arquitetura de software
gue permite flexibilidade através de um Design modular. Ela ndo é uma linguagem e
sim uma prdatica de arquitetura e de processo de pensamento por tras da
estruturacdo da programacao (SMITH, 2014, p. 01).

A orientacdo a objetos (00), como explica Marcio David (2007), foi criada
como uma tentativa de aproximar o mundo fisico do mundo virtual, dentro do
computador. Para isso, o0 mais natural foi utilizar objetos, pois afinal, o mundo real é

composto por objetos. Assim, comeca a ser respondido o porqué da importancia de

2 Na POO, objeto é um tipo de instancia que possui os atributos e comportamentos da classe a qual
pertence (SMITH, 2014, p. 21).

3 Classes s3o classificacdes de propriedades definidas, estados e comportamentos que podem ser
compartilhados ou modificados entre as instancias (SMITH, 2014, p. 21).

4 Subclasses s3o classes pertencentes a outra classe maior, chamada Superclasse (SMITH, 2014, p. 21).
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se compreender as bases da POO para o desenvolvimento de ambiente virtuais
interativos formatos por modelos (objetos) tridimensionais.

Abstraindo o conceito em um primeiro momento, pode-se comparar os
objetos da POO com os objetos do mundo fisico, onde ambos possuem
caracteristicas, comportamentos e estados. A fim de facilitar o entendimento do que
constitui um objeto, faz-se uma relacdo com o que jd conhecemos. As caracteristicas
de um objeto (como sua cor, peso, tamanho, identidade...) dizem o que ele é. O
comportamento de um objeto (correr, andar, ligar...) detalha o que ele faz. E o
estado mostra como o objeto se encontra em um determinado instante. Como
exemplo, uma porta ora esta aberta (estado: aberta), ora fechada (estado: fechada)
(LACERDA, L. C. De; RAMOS, 2015).

Seguindo o raciocinio, objetos com caracteristicas e comportamentos iguais
podem ser considerados de uma mesma classe. E assim, classes podem ser
entendidas como algo abstrato que engloba individuos (objetos) combinados por
seus estados, atributos e comportamentos iguais. Isso facilita a organizacdo
estrutural do software desenvolvido conforme a 0O.

Esta separacdo por classes, a fim de facilitar o entendimento do problema, foi
a base da POO, que teve inicio nos anos 60. Explica Exforsys (2006) que, na Noruega,
Kristen Nygaard e Ole-Johan Dahl estavam trabalhando em simulag¢des de navios
explodindo e perceberam que poderiam agrupar os navios em diferentes categorias.
Cada tipo de navio teria a sua prépria classe com comportamentos e dados Unicos.
Assim, Kristen e Ole-Johan foram responsaveis pela introducdo do conceito de
“classe”, juntamente com o conceito de instancia de uma classe.

Com o tempo esta pratica foi aprimorada, se tornando uma alternativa a
tradicional forma de programacdo estruturada ou procedural. Apesar de n3o ser
adequada para todo e qualquer propdsito, existem vantagens claras da POO em
comparac¢dao com a Programacao Procedural, como a sua capacidade de prover uma
melhor organizacdo do cddigo e de contribuir para o seu reaproveitamento sem ter
que replicd-lo diversas vezes (MULLER, 2016).

Estas e outras vantagens da Programacdo Orientada a Objetos provém de
suas principais qualidades, como a capacidade de abstracdo, encapsulamento,

modularidade, heranga e polimorfismo. Destas, duas sao de grande importancia e
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relacionam bem a POO ao desenvolvimento de ambientes virtuais tridimensionais,
sdo elas, a modularidade e a heranca.

Aqui a modularidade consiste na divisdo de um programa em partes (Figura
20), que se tornam mais faceis de serem construidas, examinadas ou reparadas
(ALVES, 2013, p. 18). Em softwares complexos a modularidade facilita o

entendimento do cédigo, simplificando sua manutencdo e aperfeicoamento.

Figura 20 - A esquerda, a representacdo do pensamento procedural, basicamente uma lista de
procedimentos sequenciais. A direita, a representagdo da modularidade da orientacdo a objetos, onde

se divide o todo em partes para facilitar o seu entendimento e construcao.

método 3

método ' Dados -Objeto

procedimento
s

procedimento _método
—_—
Dados Globais método Ml Dados -Objeto
procedimento
—
_método
método ; Dados -Objeto

Fonte: ALVES (2013, p. 05).

procedimento
ST

Ja a heranga, basicamente estd relacionada a hierarquia de classes, onde as
subclasses herdam todas as propriedades e componentes da classe pai. Essa
caracteristica torna mais enxuta a programacao, ja que referenciando subclasses ou
objetos a uma classe pai (Figura 21), naturalmente elas recebem seus atributos sem

a necessidade de duplicacdo do cddigo (MANSSOUR, 2002, p. 03).
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Figura 21 - Ledo, tigre, lobo, cachorro e gato pertencem a classe Animal e naturalmente possuem as

mesmas propriedades e comportamentos bdsicos de sua classe pai.

Animal

-nome: String
-sexo: String
-raca: String

+emitirSom()
+dormir()

+caminhar()

Leao

A

Gato

Lobo

Cachorro

Fonte: ALVES42013pp. 2].;2

llustrando esta relacdo da POO com a criacdo de ambientes virtuais, a

linguagem visual de programacdo Blueprint, presente na Unreal Engine (ver item

2.4.3.4), utiliza os principios da orientacdo a objetos para a definicdo de classes e

objetos através de um diagrama de blocos interligados. A Blueprint é um bom

exemplo de como a OO torna mais facil a elaboracdo e visualizagao da estrutura de

programacdao em modulos e o seu reaproveitamento. Também exemplifica como

podem ser representadas caracteristicas e comportamentos de objetos do mundo

fisico na programagao virtual de um ambiente tridimensional, bem como suas inter-

relagdes, com blocos que podem receber e enviar informagdes a outros objetos

(Figura 22).
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Figura 22 - Exemplo de estrutura de blocos (Blueprint) que compartilham dados entre si para formar a

légica.

Tick drives the object to follow the cursor)

(Engage sphere movement with mouse cursor

Fonte: SAMDOG (2014).

2.5.1. Programacao Escrita e Programacao Visual

Como visto, a Blueprint se configura como uma Linguagem Visual de
Programacdo, apresentando objetos e fun¢des na forma de blocos, relacionando-os
por meio de “fios” que representam o envio ou recebimento de um dado, de um
ponto a outro. Nela, as propriedades fisicas e mecanicas, bem como as animacgdes e
comportamentos atribuidos aos objetos tridimensionais virtuais estdao estruturados
e descritos de maneira mais clara em compara¢dao com linguagens textuais. Isso
facilita tanto o entendimento como a edi¢do, tendo potencial de se tornar uma
poderosa ferramenta para designers que estdo se interessando cada vez mais
projetos que envolvem programagdo computacional.

Basicamente, uma linguagem de programacao é um método padronizado que
permite a um programador especificar precisamente os dados e instrucdes a serem
transmitidas a um computador (DIGITALDEV, 2014). Existem hoje diversas linguagens
com capacidades diferentes e que sdo utilizadas para diferentes fins. O
detalhamento delas ndo faz parte do escopo desta pesquisa.

Portanto, na programacao escrita, todas as instrucdes sdo descritas de forma

textual (Figura 23). As linguagens que trabalham desta maneira, utilizam “regras
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especificadas que regem como um cddigo (escrito) deve se comportar para produzir

programas de computador” (BIGOWN, 2015).

Figura 23 - Parte de um cédigo escrito, representando a criagdo de uma cena virtual para futura adigdo

de elementos tridimensionais.

WIDTH = 480,
HEIGHT = 300;

VIEW ANGLE = 45,
ASPECT = WIDTH / HEIGHT,
NEAR = 0.1,

FAR = 10000;

$container = $('#container');

renderer = new THREE.WebGLRenderer();
camera =

new THREE.PerspectiveCamera(
VIEW_ANGLE,
ASPECT,
NEAR,
FAR);

scene = new THREE.Scene();

scene.add(camera);

camera.position.z = 300;
renderer.setSize(WIDTH, HEIGHT);

$container.append(renderer.domElement) ;

Fonte: LEWIS (2016).

J4 na programacao visual, existe um ambiente de desenvolvimento e sintaxe
compostos por elementos majoritariamente visuais. De acordo com Renato Santos
(2013, p. 25), as linguagens deste tipo procuram em geral facilitar a resolucdo de
problemas de uma forma mais intuitiva, atrativa e natural, voltada especialmente
para a autoaprendizagem (Figura 24). Tal consideracdo vai ao encontro do que a

empresa Unreal espera com a Blueprint, oferecendo gratuitamente uma grande
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gama de conteudos desenvolvidos com ela, para que o usudrio aprenda a partir de

exemplos.

Figura 24 - Parte de um software construido em blocos coloridos com a ferramenta online Scratch, um

bom exemplo de ambiente visual de programacgdo voltado ao aprendizado.

quando receber mensagem 1

mude para a fantasia dot
3

adicione size ao tamanho
(]

mude para a fantasia costume

L S

Fonte: FUPICAT (2016).

Segundo Este tipo de programacdo permite a construcdo de algoritmos por
meio da interacdo com elementos visuais. Normalmente, estes elementos
representam blocos de controle similares a estruturas légicas como FOR, WHILE, IF-
THEN-ELSE, (respectivamente PARA, ENQUANTO, SE-ENTAO-SENAO em portugués) e
variaveis (RIBEIRO et al.,, 2012, p. 02 e 03). Assim, pretendem melhorar a
compreensdo da resolucdo de problemas computacionais ao eliminar a preocupacao
com a sintaxe de uma linguagem procedimental tradicional. Ainda, RIBEIRO et al.
(2012, p. 04) revela um impacto positivo na motiva¢do e no aprendizado dos alunos
gue aprendem através de linguagens visuais ao invés de uma linguagem de
programacao escrita tradicional.

Apesar de as linguagens visuais de programacdao demonstrarem ser, mais
intuitivas, ainda é a programacdo textual, com cédigos escritos, que domina a
producdo de softwares. Por isso, nesta pesquisa, busca-se identificar as linguagens e
ferramentas de programacao predominantemente visual, com capacidade de
representar cendrios tridimensionais virtuais onde seja possivel a adi¢dao e criagdo de
animacoes e interagdes. Além disso, a facilidade de aprendizado e uso é um fator de
grande importancia para a escolha das ferramentas que fardo parte da
sistematizacdo proposta, visto que ela é direcionada a designers com pouco ou até

mesmo nenhum conhecimento prévio do campo da programacao.
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2.6. TECNOLOGIAS DE REPRESENTACAO E DISSEMINACAO DE
CONTEUDO 3D VIRTUAL

Desde a popularizacdo da internet no fim dos anos 80 e inicio dos 90,
percebeu-se a necessidade de se aproveitar o seu potencial para o desenvolvimento
e distribuicdo de conteudo interativo, inclusive com graficos tridimensionais. Na
época o problema era criar uma linguagem padrao para se descrever cenas 3D
especialmente para distribuicdo via internet.

A primeira tecnologia desenvolvida com este propdsito foi o chamado VRML
(Virtual Reality Modeling Language) em 1995, que conquistou o apreco de muitos,
tendo grande importancia até o inicio dos anos 2000 e ainda utilizado em algumas
iniciativas académicas, como na disciplina de Design Virtual na pds-graduacdo em
Design da UFRGS. A partir dela ja era possivel executar os cenarios 3D através da
internet ou off-line, o que seguiu nas préximas tecnologias estudadas. Na sequéncia,
em 2003, foi a vez do X3D, uma nova geracdo de padrdo de descricdo de ambientes
tridimensionais para Web, que surgiu como uma revisdo do VRML com o intuito de
substitui-lo, no entanto, ndo teve a mesma abrangéncia do seu antecessor.

Apds ndo mais suprirem as necessidades da internet moderna, o VRML e o
X3D foram perdendo o suporte e o espago que conquistaram. Novas tecnologias
tentaram se estabelecer como o novo padrdo de distribuicdo de conteudo 3D e
algumas tiveram relativo sucesso. Foi entdo que, através do aprimoramento das
capacidades da Web, bem como dos computadores e dispositivos mdveis, langou-se
em 2011 o WebGL. Tecnologia que rapidamente estd substituindo as demais e
trazendo um novo nivel de qualidade para a interatividade online e off-line.

E importante ressaltar que o VRML, o X3D e o WebGL sdo tecnologias de
diferentes tipos e diferentes épocas (Figura 25). Enquanto as duas primeiras sao
linguagens textuais descritivas, a terceira se configura como uma Interface de
Programacao de Aplicativos (API®, sigla em inglés) que se utiliza de outras linguagens

de programacdo para o desenvolvimento de aplicagcdes. As trés estdo ligadas

5 API é a sigla do termo em inglés Application Programming Interface, que traduzido para o portugués
significa Interface de Programacdo de Aplicativos. Consiste em um conjunto de instrucGes e padrdes de
programacao que permite a construcdo de aplicativos, inclusive os baseados na internet, e a comunicacao
de recursos entre aplicagcdes (CANALTECH, 2015; VENTURA, 2015).
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principalmente pela semelhanca de seus propdsitos, ou seja, a representacdo de

conteudos 3D interativos por meio de navegadores web.

Figura 25 — Linha do tempo das tecnologias mais importantes de representagdo de contetdo 3D voltado

para web.
1997
Fim dos anos 80 e inicio 1995
dos anos 90 Certificagdo do VRML pela
Surgimento da primeira Internacional Standards
Popularizacfo da internet e versdo do VRML. O Organization (ISO) e
= : > primeiro padrdo aberto > atualizagdo de suas
percepgdo do seu potencial riad ra descricdao d especificacbes, passando a
para e distribuicdo de criado para descrigdo de P acoes, pass:
s ; cenas tridimensionais permitir animagdes,
conteudo interativo 2D e . e . ~
3D destinadas a distribuicdo interagdes, sons e outros.
) pela internet. Esta versao foi chamada de
VRML97 ou VRML 2.0.

v

1999

2003

Inicio dos anos 2000
Primeira especificagdo da
> | evolugdo natural do VRML97,
0 X3D V3.0. Uma atualizacdo
do VRML, que implementou
novas fungdes e maior
flexibilidade.

Inicio dos esforcos para  |—> Auge da utilizagdo do
lidar com novas

N VRML por pesquisadores,
atualizagbes e designers e entusiastas
deficiéncias do VRML. & ’

v

2008

2011

Primeira especificagdo do WebGL, apds a unido de
Primeira especificagdo da quinta versao esforgos de grandes empresas de tecnologia.
do HTML, linguagem utilizada para —>
organizar e formatar péginas web.
Esta versdo trouxe o elemento Canvas,
que propiciou o surgimento do WebGL.

Este pretende ser o novo padrdo duradouro para
desenvolvimento e visualiza¢do de conteudo 3D por
meio de navegadores Web, aproveitando melhor o
processamento computadores, tablets, smartphones
e outros.

A seguir, as trés importantes tecnologias terdo o porqué de sua relevancia
explicado, desde o surgimento até a substituicdo por novos padrdes mais

promissores.
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2.6.1. VRML (Virtual Reality Modeling Language)

O VRML ou Virtual Reality Modeling Language é esclarecido por Marins et al.
(2007, p. 03), como uma linguagem textual que descreve objetos e suas inter-
relagdes em um espago virtual tridimensional, “sem que exista procedimentos de
I6gica caracteristicos das linguagens de programacgao convencionais” (PRADO et al.,
1999).

Projetada para a internet, permite construir mundos virtuais incorporando
formas 3D, iluminagdo, nevoeiro, animacao, efeitos sonoros, interacdes simples e
hyperlinks. Cada mundo ou ambiente pode ser composto por um ou mais arquivos

4

nomeados com a extensdo “.wrl” (abreviacdo de mundo em inglés) e tem como
destinacdo principal a distribuicdo e visualizacdo na Web por meio de um navegador,
embora possa ser executado também off-line (NADEAU, 1999, p. 18).

Com sua primeira versdao (1.0) lancada em 1995, o VRML foi a primeira
linguagem padronizada e especificada de descri¢cdo escrita de cenas tridimensionais
para compartilhamento pela internet. Em sua versdao 1.0, a linguagem permitia
somente a criacdo de cenas estaticas. Porém, a partir do esforco de algumas
empresas interessadas no avanco desta tecnologia, em 1997 a Internacional
Standards Organization (1SO) certificou a proposta destas e assim a especificacdo foi
reescrita e chamada de VRML97 ou VRML 2.0, quando se introduziu diversas
modificacdes que permitiram animacdo, interacdo, som e outros (PRADO et al.,
1999).

Como explica Isabel Manssour (2000), para visualizar documentos VRML, é
necessario uma aplicacdo especifica ou um plug-in (complemento) para o navegador
de internet. No auge de sua utilizacdo (fim dos anos 90 e inicio dos anos 2000) a lista
destes plug-ins era grande, contudo, o surgimento de novas e mais vantajosas
tecnologias fez com que eles quase sumissem, restando hoje o suporte de
pouquissimas empresas que mantém a possibilidade de se visualizar conteddos em
VRML em navegadores e sistemas operacionais modernos. Alguns exemplos de

softwares que continuam sustentando vivo o VRML s3o:

e 3ds Max: Software de modelagem tridimensional e animagdo da

empresa Autodesk. Com uma nova versdao recém lancada (v. 2017),
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continua trazendo os mais completos recursos de criacdo de
ambientes interativos em VRML (Figura 26), que podem ser
exportados para o formato (.wrl) diretamente pela interface principal

do programa.

Figura 26 - Conjunto de ferramentas presentes no software 3ds Max 2017, destinadas especificamente a

criacdo de cenas em VRML.

Cortona3D Viewer: Mantido pela empresa Parallel Graphics, o
Cortona é talvez o mais famoso plug-in remanescente para
visualizacdo de arquivos VRML nos navegadores atuais (Internet
Explorer, Mozilla Firefox, Google Chrome, Opera) e outras aplicacdes
(Microsoft PowerPoint, Microsoft Word). Possui completo suporte ao
VRML97 e utiliza recursos modernos de aceleracdao grafica para
proporcionar uma melhor experiéncia.

VrmlPad: Também da empresa Parallel Graphics, o VrmIPad é um
6timo editor de cddigo voltado para VRML. Apesar da possibilidade de
edicdo de um cdédigo VRML (Figura 27) em qualquer editor de texto, o
VrmlPad traz vantagens como, o realce de termos reservados da

sintaxe da linguagem e a deteccdo de erros ao compilar o cédigo.
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Figura 27 - Parte de um cdédigo VRML com especificagdes de um modelo 3D inserido em um ambiente

virtual.

-l DEF marty—-4473 Tran=sform {
translation —0.000701904 0.301058 -0.0749664

rotation O —1 A -3 141E3 Orientagdo e escala do
=cale 0.00136749 0. 00136749 0. 00136749 mode.’onoespago
scalelrientation —0.235245 0.15295 0.959826 —0.20714%
children [

=l Shape {

appeEarance Appearance |

material Material {

diffuseColor 0.9838235 0.988235 0.988235
amnbientIntensity 1.0

zpecularColor 0 0 0

shinines=s 0.145

transparency 0

Caracteristicas da superficie do modelo 3D

b

= geometry DEF marty—4473-FACES IndexedFaceSet {
ccw TRUE Caracterfsticas, descrigdo e posicionamento
creasehngls 0.785 da geometria do modelo tridimensional
=olid TRUE

= coord DEF marty—4473-CO0ORD Coordinate { point [
—79 4214 -1036 .17 -2 09863, -72 9663 —-1029. 26 —30.8319, -79 7761 1022 54 -1 92267,
—79.9889 -1034 .02 Z9.9048, -—80.0474 -1019.52 32,8574, -103.198 -1031.94 92 . 4825,
-102.705 -1012.59 91,0229, —-133.6 -1006.8 109.13%8, -131.643 1007 .34 104 027,
—-170.931 -1008.8 89.6334, 173 024 —-1008.18 93,9798, —-191 232 -1016.68 55 4833,
—-191 423 -1033 .98 57 279, —-185 144 -1035.56 4. 07975, —-184 654 —-1021.14 3 8647,
—169.913 -1023 .34 —29 6016, -179.5909 -1012 22 4.84174, -166.6483 -1015 —-28.7467.
—158 . 454 -—-994 944 —Z5 2548, -153.327 -1018 34 —52. 0728, -147 114 -995 51 —&a7 0262,
—-140.374 -962.779 —46. 7864, —-143.487 977 592 -21 9425, -105.239 976 847 -8 . 49491,
—-148 52 -980.447 12,1455, -119 71 -979 254 20,1573, —-155. 861 —973 673 42 437,
—-128.01 -972.062 50.5084, -1&2 417 —-975.471 60.7228, —-130.945 -973.913 71.2413,
—-171.505 -995 791 83 6901, —-130.993 -995 612 98 6175, -104 586 -1001.91 78.73.
—84 0p63 -1010.27 29.0231, -85 2473 -1015.23 -3 08585, —-71 5539 -101f 76 —30.0542,
—75.4807 -1010.76 —31.1928, —-48 155 -1016.88 -93.0134, -52. 9646 -998.834 —87 317,
—80.6685 -991.726 —-31.5571, -91 1639 -989 147 -5 11795, -98.673 -989.097% 24,9223,
—-107 036 -982.527 61 5539, —-91.1939% -9g1.862 —34 2837, -183.748 -1002.01 50.558,
—-172.09 -983.282 41.0623, -1s6.67 —-991 142 7 15059, —-45.6639 —10385.04 -97 . 355,
—-118 329 -1039 23 136 672, —-156.721 1037 32 —-62 4977, -171 243 1036 .36 —29 8367,
—175.18%7 -1028 .26 102.321, —-135.565 -1025.76 117 .1, -157.031 -1025.1 —E2.9154,
—45 4978 -1023 .1 —93 3247, —148 075 173 .129 147 443, —125 762 16Z.746 —86 . 8276,
—-170.645 105.481 -93.079, 37 9275 —218.198 26,8717, —33.529 162 087 22 8005,
—74.9498 -1015.13 -1&0.17, —-115.75 —-1004.88 137 . 949, -78.0389 -1003.92 -153 . 885,
—-43.9853 -1001 .59 -130.62, -58. 8419 -986.428 78 3973, -188.897 -16.8167 —40.3394,
=176 216 36.9026 —-40. 7609, —159 909 29 1047 -83 3763, -149. 719 63 0571 -85 6317,
—-185 878 76.7989 -37 6223, —131.895 11s.643 —81 5095, —157 985 127 175 —-31.5212.
—118 . 681 144 579 -%9.7561, —151 207 1e0.1%77 —-28.0613, —-119.01 1g5.845 -82.4917,
—153 %25 170.597 23,9991, -194 226 252 281 -29.1966, —-167.801 57.921 -129.05,
—-176.895 29,3115 -128 502, -172.509 -24.1444 82 4045, -188.781 -Z5.9791 -129.187,
—-176.396 —40.6053 —-80.2268, -192.919 —44 1534 -131. 267, -179.645 -56.6072 —78.85359,
—-136.946 -982 366 78 9018, -140.895 -957 446 -54 2813, -80.8747 -953 942 —36 8071,
—-186.18 193.197 —-155 525, —150.842 112 33 -126.21, -135.719 158 882 -131 .47,
—142 738 173.944 142 312, -—180.832 214 927 -16d4, -116.569 -1020.26 —138.962,
—-118 859 -1025 21 -140.01, -78. 9741 -1018. 35 —155.043, -79.1374 -1023 74 —154 475,
—-78.098 -1040.09 -157 525, —41 6436 -1037.27 -134 056, —42.4941 -1022 35 -133.09,

dd_ 2477 in4d" CO 124 41Ca LE0 o9CO ACd nad a0 norcd e W B Br B 1C2 Cac 441 CaCa

Estes e outros poucos programas de criagao, edi¢ao e visualizagdo de arquivos
VRML ainda disponiveis, possibilitam que pessoas de distintas areas continuem
fazendo uso deste antigo padrdo, muito por seu potencial de criacdo de conteudos
interativos tridimensionais de forma simples e com cédigo de facil compreensao.
Uma das areas que ja utilizou muito e segue hoje em ag¢Oes isoladas explorando este

padrdo é a academia, na aprendizagem das prodprias ferramentas de criagao ou no
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desenvolvimento de aplicagdes interativas para a visualizagao de dados, ensino e
outros.

A simplicidade de manipulacdo da linguagem VRML segue atraindo
pesquisadores e profissionais de diferentes dreas, como os designers, mesmo que o
impedimento da utilizacdo de modelos 3D muito detalhados, que ndo sao
processados adequadamente, e a necessidade de programas complementares para

a visualizagao, sejam vistos como desvantagens significativas na atualidade.

2.6.2. X3D (Extensible 3D Graphics)

Basicamente com o mesmo propésito do VRML, o X3D também é um padrado
aberto para representacdo, comunicacdo e distribuicdo de conteudos
tridimensionais e interativos, principalmente através da internet. Os esforgos iniciais
para a sua criagdao comegaram em 1999 pela Web3D Consortium, organizagao criada
para definir e desenvolver o X3D (DALY; BRUTZMAN, 2007, p. 130). Surgiu como uma
revisdo, mais madura, refinada e completa, de seu predecessor, constituindo uma
nova arquitetura de formato de arquivo livre de royalties, composta por um conjunto
de especificacoes e interface de programacdo (SOARES, 1999; WEB3D CONSORTIUM,
2016).

Eduardo Falcdo (2011, p. 43) explica que o X3D aproveita as ideias basicas do
VRML e as amplia somando novas funcionalidades. Uma importante mudanca é
adocdo de um novo formato de codificacdo para o padrdo, o XMLE, que permite a
integracao das cenas 3D com a Web mais facilmente.

Assim como acontece com os arquivos VRML, as cenas criadas com o padrao
X3D ainda nao dispensam a utilizacdo de complementos para navegadores (plug-ins)
ou programas especificos para a sua visualizacdo. Ainda assim, suas capacidades sdo

significativas e indicadas por Hopf et al. (2007, p. 06).

6 Essencialmente o XML (Extensible Markup Language) é uma linguagem de marcacdo, que por sua vez
sao codigos “que podem ser aplicados a dados ou textos para serem lidos por computadores ou pessoas”.
Outro exemplo de linguagem de marcacdo é o HTML que serve para organizar e formatar uma pagina
web. Com o XML é parecido, porém ele é utilizado para “padronizar uma sequéncia de dados com o
objetivo de organizar, separar o conteldo e integra-lo com outras linguagens” (PEREIRA, 2009).
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A tecnologia X3D da suporte para graficos 3D, transformagdes de
geometria, iluminagdo, materiais, texturas, mapeamento, pixels, vértices
e aceleragdo de hardware. Permite animagdo com temporizadores e
interpoladores de condugdo continua. Permite também interagdo com o
mouse e entradas de teclado. A navegagdo no ambiente acontece por
meio do uso de cameras, com caracteristicas de colisdo, proximidade e
visibilidade, deteccdo e varios tipos de iluminagdo. Por meio de script é
possivel mudar dinamicamente a cena através de linguagens de

programacgdo como o JavaScript (HOPF et al., 2007, p.06).

Com relagcdo a criacdo e edicdo de ambientes X3D, a situacdo é também
semelhante ao VRML, onde restaram poucos programas que ainda disponibilizam
recursos nativos para tal. Um destes softwares é o Blender que ainda hoje, em sua
versdo mais recente (2.78), possibilita nativamente a exportacdo de arquivos no
formato “.x3d”, no entanto, nem todos os recursos de modelagem disponiveis no
Blender podem ser exportados e, portanto, a geracdo de cenas realistas ndo é
possivel. Existem também complementos que adicionam a funcdo de exportacao
para X3D a softwares como o 3ds Max por exemplo, mas muitas vezes estes
encontram problemas e ndo se comportam tdo bem quanto uma func¢ao nativa.

Mesmo sendo um aprimoramento do VRML em termos de funcionalidades e
capacidades, as ferramentas ainda disponiveis para desenvolvimento em X3D ndo
proporcionam uma maneira facilitada de criagdo, mesmo os editores visuais como o
Blender. Vale lembrar que, como os arquivos X3D sdo em esséncia codigos escritos,
sua edicdo pode ser realizada por meio de simples editores de texto, método
utilizado somente para pequenas alteracdes por ser bastante mais trabalho. E em se
tratando do cdédigo (Figura 28) verifica-se que ele segue os principios do VRML,
todavia se apresenta de maneira mais organizada e melhor estruturada a partir do

uso de tags.
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Figura 28 - Parte de cddigo que descreve uma cena simples em X3D, criado com o software Blender.

<?xml version="1.0" encoding="UTF-8"7%>

2 <!DOCTYPE X3D PUBLIC "ISC//Web3D//DTD X3D 3.0//EN" "http://www.web3d.org/specifications/x3d-3.0.dtd">
3 <X3D version="3.0" profile="Immersive" xmlns:xsd="http://www.w3.org/2001/¥MLSchema-instance" xsd:nollamespaceSchemalocat
4 E <head>

5 <meta name="filename" content="mntitled.x3d" />

& <meta name="generator" content="BElender 2.76 (sub 0)" />

7 - </head>

g B <Scene>

g <NavigationInfo

11 v EXAMINE" , "ANY"'

iz avatar3ize="0.25, 1.75, D0.75"

13 i

14 <Background DEF="W0 World"

15 dColor="0.051 0.051 0.051"

16 or="0.051 0.051 0.051"

WK O o

<Transform DEF="Cube_ TRANSFORM"
translation="0.000000 O.000000 O.DOOOOO"
=cale="1.000000 1.000000 1.000000"
rotation="0.000000 0.707107 0.707107 3.141593"
>
<Transform DEF="Cube_ifs_ TRANSFORM"

{T}
{1}

2

2

2

2

24 translation="0.000000 O.000000 O.0OOOOOO"

25 scale="2.000000 2.000000 2.000000"

26 rotation="1.000000 O.000000 O.0D0OCOC O.O0OODOOO"

27 ] >

2 <Group DEF="group ME Cube">

2 «<Shape>

3 ] <Appearance>

3 <Material DEF="MA Material"

3 olor="0.269% 0.340 0.&800"

H 0.401 0.401 0O.401"

B 0.000 O0.000 O.O0ODO"

y="0.333"

</Bppearance

<IndexedFaceSet solid="true"
coordindex="0 12 3 -1 476 5-10451-11562-12673-140237-1
= >
<Coordinate DEF="coords_ME Cube"
point="1.000000 1.000000 -1.000000 1.000000 -1.000000 -1.000000 -1.000000 -1.0C

[ T A R M Y N T N iy v - e (. T QT X RS T
T

/>
L </IndexedFaceSet>
L </Shape>
o </Group>
- </Transform>
- </Transform>

<Transform DEF="Lamp TRANSFORM"
translation="-4.076245 5.903862 1.005454"
=cale="1.000000 1.000000 1.000000"
rotation="-0.498084 -0.762016 -0.413815 1.513875"

LT T T T S N T T T S S S A O R KA F R

tn
P

tn

o

&

= >
? <PointLight DEF="LA Lamp"

Sendo o X3D praticamente uma evolugdao estrutural do VRML, as
possibilidades de aplicacdo de ambos sdo muito parecidas. Desde jogos,
visualizadores de dados, museus virtuais, ambientes educativos e tantos outros.
Ainda que formado por funcionalidades interessantes, hoje o X3D ndao mais atende
os requisitos de ambientes tridimensionais para uso no Design e por designers, muito

devido a baixa qualidade grafica das cenas por ele descritas.
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2.6.3. WebGL

Dos anos 90 para ca, VRML, X3D e diversas outras tecnologias proprietdrias,
tentaram se estabelecer como padrao definitivo de descricdo de objetos e ambientes
tridimensionais virtuais para Web. Foi entdo que em 2006, como um experimento de
um engenheiro de software da empresa Mozilla chamado Vladmir Vukicevi¢, nasceu
o WebGL. Tecnologia que teve certificada sua primeira especificagdo somente em
2011, apds a unido de esforcos de empresas como o consércio Khronos?, Mozilla,
Google, Apple, Opera, entre outras (BORJA, 2016, p. 10; PARISI, 2014, p. 18).

O WebGL se caracteriza como uma Interface de Programacao de Aplicativos
(API) multiplataforma, para renderizacdo de graficos 3D concebidos para Web
(KHRONOS GROUP, 2014a). Nas visdes de Danchilla (2012, p. xviii) e de Levkowitz;
Kelleher (2012, p. 23), é um novo padrao que permite executar poderosos graficos
tridimensionais dentro de um navegador web, sem a necessidade de quaisquer
apoios externos, como os plug-ins.

Esta tecnologia se mostra promissora porque resolve algumas das principais
limitacOes das anteriores. Além de ndo serem mais necessarios complementos para
a visualizacdo dos conteudos, ela fornece funcionalidades de acesso direto ao
hardware gréafico (GPU) dos dispositivos e as aplicagGes sdo executadas nativamente
nele, permitindo uma aceleracdo grafica mais eficiente, utilizando melhor a
capacidade de processamento de computadores, smartphones, tablets e tantos
outros (CONGOTE et al., 2011, p. 139; LOESCH et al., 2012, p. 196). Com isso, houve
um salto significativo de qualidade gréfica (Figura 29) e efeitos de fisica das cenas
tridimensionais. Cenas estas, que podem agora ser visualizadas com melhor
qualidade e em uma gama muito maior de aparelhos através de navegadores web,

caracteristica enfatizada por Kenneth Russell (2015, p. 03):

WebGL expbe o poder do processador grafico que ja estd em todos os
dispositivos, diretamente para a web, de maneira segura. Isso permite que
aplicativos 3D sofisticados, poderosos e portateis possam ser entregues

ao usuario final, diretamente no navegador (RUSSELL, 2015, p. 03).

7 0 Khronos Group é uma entidade sem fins lucrativos, focada na criacdo de padrdes abertos e livres de
royalties para computacdo paralela, graficos e midia dinamica em uma ampla variedade de plataformas e
dispositivos (KHRONOS GROUP, 2016c).
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Figura 29 - Aplicagdo interativa em WebGL com texturas e objetos detalhados, desenvolvida pela Disney

para promover o filme "O Mdgico de 0z".

Fonte: GOOGLE (2016).

Loesch, Christen e Nebiker (2012, p. 196) esclarecem que o WebGL é, em
esséncia, uma interface de programacdo de baixo nivel, com comunicacdo mais
proxima da linguagem da mdquina e familiar apenas a especialistas, onde para
simplificar a criagdo de conteudos, sao continuamente desenvolvidos os chamados
motores de alto nivel ou ainda, bibliotecas. Estes abstraem a interface original e
fornecem os recursos do WebGL de maneira menos complexa, utilizando uma sintaxe

de programacao facilitada (Figura 30).
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Figura 30 - Corpo de cédigo HTML com a descri¢cdo de uma cena simples em WebGL utilizando a

biblioteca Three.js.

<body:>
<script src="../build/three.js"»></script>
<script>

var camera, scene, renderer;
var mesh;

init();
animate();

function init() {

camera = new THREE.PerspectiveCamera( 7@, window.innerWidth / window.innerHeight, 1, 1eee );
camera.position.z = 400;

sceng = new THREE.Scene();
var texture = new THREE.TexturelLoader().load( 'textures/crate.gif' };

var geometry
var material

new THREE.BoxBufferGeometry( 280, 280, 200 );
new THREE.MeshBasicMaterial( { map: texture } });

mesh = new THREE.Mesh( geometry, material );
scene.add( mesh );

renderer = new THREE.WebGLRenderer();

renderer.setPixelRatio( window.devicePixelRatio );

renderer.setSize( window.innerWidth, window.innerHeight );

document.body.appendChild( renderer.domElement );

Jfl /

window.addEventListener( 'resize’, onWindowResize, false );
}

function onWindowResize() {

camera.aspect = window.innerWidth / window.innerHeight;
camera.updateProjectionMatrix();

renderer.setSize( window.innerWidth, window.innerHeight );

}

function animate() {
requestAnimationFrame( animate );

mesh.rotation.x += ©.8@5;
mesh.rotation.y += 2.81;

renderer.render( scens, camera );

b
</scripte

</body>

Fonte: THREE.JS (2016).

Os possiveis usos do WebGL sdo iniUmeros e crescentes a medida em que se
aumenta o poder de processamento dos dispositivos, em especial os moveis
(smartphones, tablets e tantos outros), possibilitando a execugdo de aplicagcdes com
maiores exigéncias computacionais, diretamente de um navegador web e adaptavel
ao hardware. J4 se encontram, para execu¢do multiplataforma e sem a necessidade
de plug-ins através do WebGL, jogos com graficos 3D detalhados e fisicas realisticas

(Figura 31), demonstracdes virtuais de produtos com animacdes e interagles
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imersivas (Figura 32) e também completos softwares online de modelagem
tridimensional (Figura 33). Todas estas aplicacbes eram inimagindveis até poucos
anos atrds. Assim como o aumento do poder grafico dos dispositivos, o niumero
também crescente de novas bibliotecas, como novas funcionalidades para a

descricdo de cenas, s6é faz aumentar as possibilidades e utilidades da tecnologia.

Figura 31 - Jogo transportado de plataformas méveis para execugdo direta em navegador web através

do WebGL.

Fonte: MADFINGER GAMES (2014).

Figura 32 - Demonstra¢do promocional de veiculo em ambiente virtual.

Littie
Full creaits.

Fonte: LITTLE WORKSHOP (2015).
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Figura 33 - Software online de escultura digital inteiramente em WebGL.

RENDERING

TOPOLOGY

SCULPTING & PAINTING

Fonte: GINIER (2015).

Imagina-se que seja possivel oferecer a designers uma maneira mais simples
de aproximacdo e utilizacdo das funcionalidades do WebGL. Ampliando suas
capacidades em projetos, dando-lhes a oportunidade de contribuir com suas
criacBes, neste universo que promete evoluir muito nos préximos anos e se tornar
um dos pilares da computacdo grafica (LEVKOWITZ; KELLEHER, 2012, p. 34).

Apesar do entusiasmo generalizado e as pretensdes de um futuro brilhante,
alguns autores temem que o WebGL possa falhar na tentativa de se tornar o padrao
definitivo de representacdo 3D para web, como seus antecessores. Para que isso ndo
aconteca, Brian Danchilla (2012, p. 301) diz serem necessdrias trés coisas: suporte
de navegadores web e aparelhos, adocdo da comunidade de desenvolvimento,
especialmente dos desenvolvedores de jogos e melhorias continuas no
desenvolvimento do préprio padrdo. Espera-se que este trabalho possa contribuir
para inclusdo de mais designers neste meio e assim garantir a satisfacdo destas trés

necessidades, trazendo vantagens para ambos, tecnologia e profissionais.

2.7. O WEBGL EM DETALHES

Objeto principal desta pesquisa, é de fundamental necessidade o

entendimento aprofundado acerca do WebGL. Algumas das potencialidades dele ja
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foram apresentadas, porém é necessario esclarecer quais outras tecnologias
propiciaram o seu desenvolvimento e como ele se torna cada vez mais acessivel por
meio das bibliotecas de desenvolvimento.

A partir do entendimento basico de que o WebGL é uma tecnologia de
representacdo de graficos 3D em navegadores web de forma “nativa”, ou seja, sem
a necessidade de quaisquer complementos para sua execucao, é possivel defini-lo de
forma mais técnica. Entdao, o WebGL sé foi possivel gracas a outras trés importantes
tecnologias que o suportam, o OpenGL ES 2.0, o HTMLS5 e o JavaScript.

O OpenGL ES (Open Graphics Library), que chegou em sua versao 2.0 em 2007,
é uma poderosa interface de programacdo de aplicativos (APl) multilinguagem,
gratuita e de baixo nivel, composta por um conjunto de fun¢des que fornecem acesso
direto a muitos recursos da Unidade de Processamento Grafico (GPU — sigla em
inglés), responsdvel pelo processamento de video de computadores, videogames,
aparelhos méveis e tantos outros. Utilizando tais fun¢Ges é possivel descrever cenas
2D e 3D com graficos complexos que sdo “lidas” e renderizadas pela GPU (KHRONOS
GROUP, 2016a; OPENGL.ORG, 2010). Praticamente todo o funcionamento do WebGL
faz referéncia ao OpenGL ES 2.0, utilizando ainda a mesma semantica para se valer
justamente de uma de suas maiores e mais vantajosas funcionalidades, a
multiplataforma, agora destinada a distribuicdo e execugdao de conteudo gréfico
digital para a web (BORIJA, 2016, p. 09). Sendo também aberto e de baixo nivel, em
comunicagdo direta com a GPU, é chamado de OpenGL para a Web (KHRONOS
GROUP, 2014b, 2016b).

Por sua vez, o HTML5, versdao numero cinco do HTML?, linguagem utilizada
para organizar e formatar paginas web, foi quem propiciou levar o OpenGL ES para
os navegadores. Com sua primeira especificacdo anunciada em 2008, o HTML5
trouxe dentre muitas novidades o elemento Canvas, que basicamente fornece uma
superficie para a renderizacdo em tempo real de graficos (imagens) diretamente no

navegador. Esse trabalho de reprodug¢do de conteddo multimidia na internet era

8 0 HyperText Markup Language, HTML, é uma linguagem de marcacdo utilizada para desenvolvimento
de paginas e aplicagdes web. Arquivos HTML sdo interpretados por navegadores web (browsers) de
diferentes dispositivos (ORIENTE, 2015; PACIEVITCH, 2016).
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antes realizado por softwares externos, proprietdrios, mais limitados e menos
seguros como € o caso do Adobe Flash Player, que teve reinou por longos anos como
a melhor opcado do segmento.

Conforme Wallace Jackson (2016, p. 171 e 178) ao mesmo tempo em que o
WebGL se utiliza da nova funcionalidade, ele também funciona como um
complemento a versdao numero 5 da linguagem HTML. O elemento Canvas,
introduzido pelo HTMLS5, foi estipulado primeiramente para graficos bidimensionais
(2D) e posteriormente, com a combinacdao com o WebGL, passou a permitir contetddo
3D animado e interativo.

Ja o JavaScript é sobretudo uma linguagem de alto nivel que tem como
caracteristicas ser leve, multiplataforma e suportar programacao orientada a objetos
na forma de scripts® (MARK, 2016; MOREIRA, 2016). E utilizada pela maior parte das
bibliotecas (ver item 2.7.1) de WebGL em conjunto com o elemento Canvas do
HTML5 para descrever, graficos 2D e 3D, composi¢les, interacdes e animacdes
simples e complexas (PALUCH, 2015).

As versOes atuais de todos os principais navegadores web suportam
aplicacGes desenvolvidas em WebGL, entre eles Microsoft Edge, Google Chrome,
Mozilla Firefox, Opera e Safari, em suas versdes para computadores pessoais e
dispositivos moveis. A Unica restricao envolve aparelhos mais antigos que talvez ndo
consigam executar todos os efeitos presentes em conteudos desde tipo. Com apoio
total das gigantes da tecnologia, o WebGL ja se tornou o padrao mais promissor para
internet, deixando para tras fortes concorrentes como o Flash da Adobe.

Com relacdo as limitacGes ainda existentes, elas tendem a ser reduzidas
rapidamente e seu campo de aplicacdo ampliado, pois conforme o esclarecido por
Dan (2014), o WebGL faz uso dos mesmos drivers de video que sdo utilizados pela
grande maioria das aplicagdes que rodam de maneira off-line nos dispositivos atuais,

indicando que hd muito a ser aproveitado ainda. Para se manter forte a tecnologia

9 Linguagens de programacao geralmente s3o projetadas para a criacdo de aplicacdes completas, porém
as linguagens de script estdao direcionadas para tarefas em menor escala como, criagdo de rotina de
execucdo corriqueira (macros) ou integracdo entre aplicacdes existentes, sendo chamadas até de glue
languages (linguagens cola, em traducdo literal) por serem mais flexiveis e permitirem a juncdo de
programas menores para se construir um grande sistema (BAZILIO, 2016, p. 02 e 04).
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deve ter suas capacidades exploradas e aprimoradas, sendo os designers grandes

beneficiadores do que ela tem a oferecer.

2.7.1. Bibliotecas

Com o propdsito de facilitar a programacdo de aplicagcbes com WebGL, sdo
utilizadas as chamadas Bibliotecas de Programacao ou Library, em inglés. O WebGL
é uma APl que se comunica diretamente com o hardware responsavel pelo
processamento de video dos dispositivos através de uma linguagem de baixo nivel e
é por este motivo que a criacdo de conteudo utilizando esta tecnologia acontece
majoritariamente por meio de bibliotecas de programacao.

As bibliotecas, nada mais sdao que conjuntos de fung¢des e definicbes pré-
escritas para um propésito definido e prontas para serem utilizadas em um nivel mais
elevado da programagao por aqueles que ndao tem motivos para entender a
linguagem “bruta” da maquina simplesmente para criar um aplicativo (ANDRADE,
2015; JACOME, 2010). As bibliotecas sdo fundamentais porque reduzem a
complexidade da programacdo com vistas de aumentar a produtividade,
proporcionando uma maneira mais facil e compreensivel de se desenvolver
aplicacBes, no caso deste trabalho ambientes virtuais tridimensionais (MINISTERIO
DA CULTURA, 2006). Elas abstraem funcdes de baixo nivel, subtraindo e resumindo
detalhes para, segundo Leite (2007), expressar algo de maneira mais concisa, sem
gue os detalhes mais complexos figuem a mostra, tornando a escrita do cddigo mais
“humana” a medida que se distancia da linguagem de maquina. No momento da
execucdo das aplicacdes essas funcdes abstraidas sdo traduzidas novamente para a
linguagem reconhecida pelo hardware.

Muitas bibliotecas ja trabalham com o OpenGL e o elemento Canvas do
HTMLS5 para facilitar o desenvolvimento de cenas virtuais com o padrao WebGL.
Neste caso, uma biblioteca ou um conjunto delas pode constituir um Motor Grafico
ou uma Engine, que é “um pacote de funcionalidades que sdo disponibilizadas para

facilitar o desenvolvimento de um jogo e impedir que sua criagao tenha que ser feita
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do zero” (KLEINA, 2011). Este pacote é utilizado na modelagem de graficos 2D e 3D,
adicdo de animacdes e interacdes como a movimentacdao de personagens ou o
sistema de colisdo entre personagem e objetos.

Como mencionado, uma biblioteca existe para propdsitos definidos e dentro
do WebGL muitas servem para fins bem especificos como é o caso da Awe.js, que
oferece recursos para a criacdo de conteldo para execuc¢dao em plataformas de
realidade virtual e aumentada. Outras bibliotecas possuem uma quantidade
extremamente variada de recursos como criacdao de geometrias, cameras e luzes,
carregamento de modelos tridimensionais em diversos formatos, capacidade de
edicdo de propriedades de materiais e texturas, criacao de animagdes, entre outros.

Ressalta-se que algumas bibliotecas trazem consigo uma interface grafica de
desenvolvimento, semelhante a muitos dos softwares de modelagem
tridimensionais tradicionais, para servir de editor visual dos ambientes virtuais em
WebGL, deixando o cddigo escrito mais afastado dos olhos do desenvolvedor. Muitas
dessas interfaces graficas sdao criados também a partir do WebGL, herdando sua
capacidade de multiplataforma. Tais editores facilitam ainda mais o aprendizado e
manipulacdo dos recursos desta tecnologia, se mostrando adequados para uso por
designers sem conhecimento avangado em programacao.

A mais importante e utilizada biblioteca para WebGL hoje é sem dulvidas a
Three.js. Muitos dos bons projetos em WebGL sdo criados com a Three.js (threejs.org
— pagina oficial), pois ela possui um numero bastante grande de funcionalidades
prontas para serem utilizadas em cenas virtuais de baixa ou alta complexidade visual
e interativa. Ela também acompanha uma interface grafica para edicdo de conteudo
on-line e off-line (Figura 34), que possibilita a importacao de modelo 3D, que podem
ser escalados e posicionados dentro do espaco virtual e a criacdo e edicdo de
materiais, luzes e cameras. Apesar disso, animacgdes e interacdes sé podem ser
adicionadas diretamente no cddigo escrito exportado pelo editor visual em formato

".html’, ponto de maior dificuldade para nao programadores.
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Figura 34 - Interface gréfica de edigdo online de contelido WebGL da Three.js.
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Fonte: THREE.JS (2016b).

Como ja visto anteriormente, ainda existem programas de modelagem 3D e
desenvolvimento de jogos, como a Unreal Engine e a Unity, que permitem a
exportacao de projetos criados a partir deles para WebGL. Estes utilizam em sua

maioria um conjunto de bibliotecas proprietdrias para isso, limitando o trabalho de

criagdo a interface do préprio software.



Capitulo 3

MATERIAIS E METODOS

Aqui, apresentam-se o método de pesquisa (Figura 36) utilizado para a
caracterizacdo do problema, obtencdo de dados relevantes e os ensaios realizados
com as tecnologias, a fim de encontrar uma solucdo inovadora. Neste capitulo
também sdo descritos os materiais utilizados em cada fase do trabalho investigativo.

O presente trabalho cientifico é conduzido por um método de pesquisa
baseado na metodologia denominada Design Science Research (DSR), que foi
aclarada por um estudo de Dresch et al. (2013), voltado principalmente a Engenharia
de Producdo, mas possivel de ser utilizado também no Design. Através de suas cinco
etapas, o DSR compreende a identificacdo do problema, a definicdo dos resultados
esperados, o projeto e desenvolvimento, a demonstracdo, a avaliacdo e por fim, a
comunicacdo. Nestes se encaixam os sete passos realizados neste trabalho (Figura
36), conforme a Figura 35.

A primeira etapa (Conscientizacdo) visa a compreensdao da problematica
envolvida. Assim, é nesta fase que se define e formaliza o problema de pesquisa e
suas fronteiras. J& em Sugestdo criam-se possiveis solucdes satisfatérias para o
problema elucidado anteriormente.

“0O Desenvolvimento corresponde ao processo de constituicdo do artefato em
si” (DRESCH et al., 2013, p. 750 apud MANSON, 2006). Ou seja, é na fase de
Desenvolvimento em que se desenvolvem as solugbes satisfatérias, também
chamadas de artefatos'?, definidas na fase anterior com base na caracterizacdo do
problema realizada na primeira etapa.

A fase de Avaliacdo é quando se realiza a verificacdo do comportamento da

solucdo desenvolvida no ambiente para o qual foi projetada. Para isso é necessario

10 segundo Dresch et al. (2013, p. 751), “a pesquisa fundamentada em Design Science deve produzir um
artefato viavel, na forma de um constructo, modelo, método e/ou uma instanciagao”.
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um processo composto por critérios, que validara ou nao a solugdo criada. Por fim,
na Conclusdo, apresenta-se a sintese do processo de pesquisa acompanhada de uma
discussdao e, consequente, comunicacdo do mesmo a comunidade académica e

profissional.

Figura 35 — Etapas do Design Science Research adaptadas para o método de pesquisa utilizado.
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Fonte: Adaptado de Dresch et al. (2013, p. 750).
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Figura 36 - Método de pesquisa utilizado.

Revisao Bibliografica
de Entendimento

Reconhecimento de lacunas na drea de pesquisa,
caracterizacdo do problema, elaboragéo da hipétese
de solugdo e obtengao de tdpicos especificos para estudo.

Revisdo Bibliografica
de Aprofundamento

Discussdo e compreensdo de questdes histdricas,
evolutivas e técnicas relacionadas ao problema.

Pesquisa
Exploratdria Pratica

Coleta e exploragdo de ferramentas relacionadas
a criagdo de contelido em WebGL.

Analise e Sele¢do PROBLEMA
de Ferramentas DE PESQUISA
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proprios de designers, a fimde
melhorar a apresentacao, a distribui¢do
e o alcance de seus trabalhos?

Elaboracdo da
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Construcdo da sistematica de criagdo
de conteudo em WebGL por designers.

Teste de Execucdo da
Sistematica Proposta

Utilizacdo da sistematica proposta no
desenvolvimento de ambientes tridimensionais
virtuais com animagao e interagao.

Resultados e
Consideracdes Finais

Apresentacao dos resultados obtidos e das
consideragdes finais relativas ao andamento
da pesquisa e seus possiveis caminhos.

3.1. METODOS

3.1.1. Revisao bibliografica de entendimento

Primeiramente, diante do anseio de aproximar designers as capacidades de

criagdo de projetos de ambientes virtuais interativos e atualizar aqueles que ja
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trabalham na area, realizou-se uma revisdo bibliografica de entendimento,
objetivando tracar uma linha evolutiva das tecnologias destinadas ao
desenvolvimento destes, sejam por designers ou programadores. Como retorno
desta, obteve-se os principais tdépicos a serem explorados a respeito das tecnologias
de descri¢cdo de cenas virtuais tridimensionais, partindo do VRML, passando pelo X3D
e chegando no WebGL, que configura hoje o estado da arte no que diz respeito ao
tema.

Identificou-se, porém, que apesar de oferecer vantagens significativas em
comparagao a seus antecessores, o promissor WebGL ainda esta distante de
designers, que, ao menos no Brasil atual, em grande parte ndo possuem um
conhecimento minimo de programacdo, ainda que estejam familiarizados com
softwares de modelagem 3D. Esta constatacdo se da por meio da analise das grades
curriculares dos oito melhores cursos de graduacdo em Design em universidades
publicas e privadas do Brasil, segundo classificacdo da revista Guia do Estudante
(2017).

Sete!! dos oitos cursos analisados ndo possuem em suas grades curriculares
qualquer disciplina ligada direta ou indiretamente ao ensino de programacdo aos
estudantes de Design. E, ainda que um curso'? tenha em sua matriz curricular uma
disciplina (Conceitos de Informdtica) relacionada com a Informatica, ndo se
encontrou nada sobre seu contelddo programatico e a presenca de assuntos ligados
a programacao.

Entdo, foram efetuados alguns ensaios livres de rigor metodoldgico,
explorando-se ambientes virtuais dinamicos, desenvolvidos a partir de VRML, X3D e
WebGL, focando no reconhecimento de uma lacuna na drea de pesquisa em questao.
Em seguida realizou-se a caracterizacdo do problema, com a clarificacdo de suas
variaveis e elaboracdo da hipétese de solucdo através do método hipotético-

dedutivo.

11 pesign (Projeto de Produto) — Pontificia Universidade Catdlica - Rio (PUC Rio);
Design (Comunicagado Visual) — Pontificia Universidade Catdlica - Rio (PUC Rio);
Design Grafico — Universidade Federal de Goias (UFG);

Design — Universidade Estadual Paulista (UNESP);

Design — Universidade Federal do Amazonas (UFAM);

Design — Universidade de Brasilia (UNB);

Design — Escola Superior de Propaganda e Marketing SP (ESPM SP).

12 pesign (Midia Digital) — Pontificia Universidade Catdlica - Rio (PUC Rio).
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3.1.2. Revisao bibliografica de aprofundamento

Tendo clara as condicionantes do problema, iniciou-se uma revisdo
bibliografica de aprofundamento sobre as questdes histéricas, evolutivas e técnicas
das tecnologias abordadas (VRML, X3D e WebGL). Em conjunto elaboraram-se
discussGes sobre assuntos elementares e de compreensdao necessaria para a
sequéncia da pesquisa tais como, a tipificacdo e singularizacdo da representacao
tridimensional virtual no Design, os campos da realidade virtual e aumentada, a
qualificacdo dos ambientes tridimensionais virtuais em geral e a estrutura¢ao da

programacao orientada a objetos.

3.1.3. Levantamento de ferramentas

Apds a revisdao bibliografica para obtencdo de informacdes relevantes a
analises futuras, realizou-se um levantamento das ferramentas disponiveis hoje que
objetivam dar suporte a criagdo de conteudos por meio do WebGL. O levantamento
delas foi realizado com o auxilio de buscadores online com o Google.com, através de
termos em portugués, inglés e espanhol. A lista de ferramentas obtidas (34 no total
- Tabela 5) compreende modeladores, editores e exportadores de cenas 3D que
possuem funcionamento online ou off-line. Preenchendo a necessidade de se ter
instrumentos para todas as etapas da sistematizacdo a ser proposta, da modelagem
do ambiente até a sua publicagdo. Algumas delas consistem em um conjunto de
software e complemento (plug-in), sendo este ultimo o responsavel pela exportacdo

do conteudo utilizando o WebGL nestes casos.



Tabela 5 — Modeladores, editores e exportadores de cenas 3D analisados.

Ferramenta Funcionamento
Unity + Assets Off-line
Blender + Blend4Web Off-line
Blender + Babylon Exporter Off-line
Blender + Sketchfab Exporter Online
Rhino + Iris Off-line
3ds Max 2017 + WebGL Exporter for Max Off-line
3ds Max 2017 + SEA3D Exporter Off-line
3ds Max 2017 + Three.js Exporter Off-line
3ds Max 2017 + Babylon Exporter Off-line
3ds Max + Sketchfab Exporter Online
Autodesk Maya 2016 + Inka3D Off-line
Autodesk Maya 2016 + WebGL Exporter For Maya Off-line
AutoCAD 2017 + WebGL Exporter For Autocad Off-line
A3DS Viewer Off-line
CopperCube Off-line
WebGL Publisher Off-line
Atomic Game Engine Off-line
FinalMesh Off-line
Marmoset Toolbag Off-line
Godot Engine Off-line
Unreal Engine Off-line
Autodesk Stingray 2017 Off-line
Goo Create Online e Off-line
WebGLStudio.js Online e Off-line
Three.js Online e Off-line
Clara.io Online
ShaderFrog Online
PlayCanvas Online
ThreeFab Alpha Online e Off-line
Vizor.io Online
SculptGL Online
3DTin Online
Cl3ver Online
P3d.in Online
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Para comparacao e selecdo das ferramentas mais adequadas a proposta, foram

criados dez critérios baseados nas discussbes realizadas anteriormente,

na

experiéncia, citada anteriormente, com a disciplina de Design Virtual do PGDesign

da UFRGS e a partir das experimentacdes dos prdprios softwares levantados para a

analise, visando a utilizacdo dos programas a nivel estudantil e profissional. Tais

critérios (Tabela 6) servem para caracterizar as ferramentas e possibilitam verificar

quais se destacam tecnicamente em cada fung¢do do processo. Também, cada critério

é explicado em detalhes e sua criacdo justificada na sequéncia.

Tabela 6 - Critérios a serem considerados para a escolha das ferramentas que fardo parte da sistematica

proposta.
Ne Critérios Referéncias
. Tipo de licenca (gratuita, paga, Disciplina dfe Design Virtual
avalia¢do, educacional...) (PGDesign/UFGRS)
Experimentagdo Pratica dos
Experimentagdo Pratica dos
3 Sistemas operacionais suportados Softwares Levantados
Possibilidade de publicagdao direta em (ZHANG, Xiaoyu; GRACANIN, 2013
4 WebGL (HTML) para execugdo em p. 195)
multiplataforma
= Exportagdo em codigo aberto ou Disciplina d_e Design Virtual
fechado (PGDesign/UFGRS)
Disciplina de Design Virtual
6 Formatos de importagao (PGDesign/UFGRS)
Experimentacdo Pratica dos
7 Formatos de exportagdo Softwares Levantados
8 Funcionalidade (modelagem, animacéo, Disciplina d.e Design Virtual
interacdo) (PGDesign/UFGRS)
9 Conhecimento prévio necessdrio (GUIA DO ESTUDANTE, 2017)
Experimentagao Pratica dos
10 Periodicidade das AtualizacGes

Softwares Levantados
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No critério de numero 1 verifica-se quais os tipos de licengas os softwares
possuem entre Gratuito, Pago, Versdo Educacional Gratuita e Versdo de Avaliagdo,
podendo o desenvolvedor disponibilizar mais de um tipo para o mesmo programa.
Para inclusdo na sistemdtica a ser proposta prioriza-se os programas gratuitos ou os
gue oferecem versdes educacionais devido ao acesso facilitado para uso no ensino.
Programas somente com versdes pagas nao interessam em um primeiro momento e
por isso tal critério é importante.

A categorizacdo do software conforme seu modo de funcionamento (critério
n? 2) entre Online ou Off-line, possibilita a identificacdo daqueles que podem
funcionar integralmente mesmo sem conexdao continua com a internet, ainda que
sejam executados em navegadores web. Em conjunto com o reconhecimento dos
sistemas operacionais suportados (critério n? 3), formulam-se os principais
requisitos para o funcionamento dos mesmos no que diz respeito a edicdo de
conteudo. Quanto mais abrangentes as possibilidades de execucdo nestes dois
critérios, mais usudrios poderdo utiliza-las.

A capacidade de publicacdo direta do contetudo criado em uma pagina HTML
executavel (critério n? 4) também tem grande valor, visto que diminui os passos
necessarios para o usuario do programa transformar a sua criagdo em um arquivo
pronto para ser disponibilizado pela internet ou outros meios. Isso simplifica e reduz
os conhecimentos prévios necessarios para se chegar ao fim do processo. No caso de
alguns programas que funcionam unicamente online, mesmo que esta publicagao
direta para um executdvel seja possivel, ndo é disponibilizado o arquivo final de
maneira off-line, somente sendo possivel seu compartilhamento através dos servicos
também on-line da empresa desenvolvedora.

O critério n2 5 visa distinguir se o arquivo final gerado pelo programa é
composto por codigo aberto ou fechado. Possuir cédigo aberto significa que nele
podem ser facilmente identificadas suas funcdes e diretrizes, possibilitando além da
simples exportagao do ambiente virtual para WebGL, um estudo da prdpria estrutura
do cddigo escrito e até mesmo alteracoes diretas nele, como visto no VRML. Ja os
com cédigo fechado, também chamados de proprietdrios, sdo criptografados pela

empresa que o desenvolve para impossibilitar a sua leitura e modificacdao pela
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escrita. Apesar de ndo ser definidor para a o uso ou nao do software na sistematica,
é sempre desejavel para fins educacionais que os cddigos se apresentem de maneira
aberta e clara.

A identificacdo dos diversos formatos de arquivos possiveis de serem
importados para o programa (critério n2 6) é relevante. Quanto maior o nimero de
arquivos suportados e a possibilidade de trabalho com os principais formatos do
mercado, maior a integragao com outros softwares que porventura possam fornecer
recursos como modelos 3D, imagens, sons, etc.

A partir do critério n? 7 s3o verificados os formatos trabalhados pelo
programa para exportacao do contetddo desenvolvido no contexto da publicagdo em
WebGL, desconsiderando formatos destinados a outros fins. De antemdo sdo
observados alguns possiveis formatos de arquivo como o HTML que pode existir
sozinho, contendo todos os elementos do ambiente criado em um sé arquivo ou
pode vir acompanhado de outros arquivos que sdo referenciados no HTML principal
e chamados quando a aplicagdo é posta em execugdo. Também comum para
utilizacdo no WebGL, os arquivos JSON carregam diversas informacdes da cena e
podem ser inseridos em cddigo externo para que possa ser gerado entdo um HTML
executavel por um navegador. A exportacdo direta em HTML simplifica o processo,
contudo arquivos JSON possibilitam uma utilizacdo aprimorada por usuarios mais
experientes.

Elementar, o critério n? 8 dd espaco para a relacdo das principais
funcionalidades dos softwares levantados. Um maior numero de fungdes
relacionadas aos pilares da criacdo de ambientes tridimensionais virtuais
(modelagem, animacdo e interagdao) em um mesmo software pode reduzir o nimero
de ferramentas necessarias no método proposto.

O critério n2 9 avalia quais conhecimentos prévios sao exigidos pelo software
para desenvolver ambientes 3D animados e interativos. Em muitos casos podem ser
necessarios conhecimentos basicos ou avangados de programagdo, os quais nao
fazem parte das habilidades de grande parte dos designers e por isso serdo evitadas.

Por outro lado, pode ser preciso saber lidar com modelagem tridimensional virtual,
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competéncia mais préoxima dos profissionais desta drea, ndo oferecendo grandes
empecilhos para a sistematizacdo.

Por ultimo, o critério n? 10 serve para conferir em qual periodo de tempo sao
disponibilizadas atualizagdes para as ferramentas. Este aspecto demonstra se o
responsavel pelo desenvolvimento do programa continua dando suporte ao seu
produto. Uma frequéncia alta de atualizacdes pode significar uma correcao de
problemas e adicdo de funcionalidades mais rapida. Também é possivel prever as
chances de continuidade do suporte para evitar a utilizagdo de programas que

possam ser descontinuados em breve.

3.1.5. Requisitos da sistematica

Através dos dez critérios definiram-se os requisitos desejdveis e obrigatérios
para o método proposto mais tarde (Tabela 7). Cada requisito estd diretamente
ligado a um dos critérios e aos resultados esperados ao final deste trabalho de
pesquisa. A partir deles se torna possivel a validacdo das ferramentas a serem

utilizadas na sistematica.
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Tabela 7 - Requisitos da sistematica de criagdo de ambientes 3D interativos por meio do WebGL.

Ne Requisito Condigao

Ser composto por softwares com versdes gratuitas
1 Obrigatério
ou educacionais

Possibilitar a criacdo e edicdo de conteddo sem a )
2 Desejavel
necessidade de conexdao com a internet

Funcionar nos trés principais sistemas
3 Obrigatério
operacionais do mercado (Windows, OS X e Linux)

Permitir publicacdo direta em WebGL sem ajustes
4 Obrigatdrio
avancados

5 Ser o arquivo final constituido por cddigo aberto Desejavel

Possibilitar a importacdo dos mais diversos
6 Obrigatério
formatos de arquivo

Permitir a exportagdo do conteudo diretamente
7 Obrigatério
em um HTML executavel

Abranger todas as trés principais funcionalidades
8 Desejavel
requeridas (modelagem, animacéao e interacdo)

9 Nao exigir conhecimento prévio de programacao Obrigatério
Ser constituido por softwares com suporte ativo e

10 Desejavel
atualizacdes frequentes

3.1.6. Selecao dos softwares

Apods a construcdo dos critérios e requisitos, iniciou-se a andlise prévia para
identificar os softwares com maior potencial para atender as necessidades dos
designers no momento da criacdo de seus ambientes e exportacdo em WebGL. Esta
analise empirica e balizada pelos critérios estipulados se deu pela tentativa de
criacdo e exportacdo de um cendrio tridimensional simples composto por objetos 3D,
animacdes e interacdes de baixa complexidade. Assim foram entdo obtidas as
informacgdes necessdrias, segundo os critérios, para verificar o cumprimento ou nao

de cada um dos 10 requisitos para cada umas das 34 ferramentas (Apéndice A).
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Infelizmente um grande numero de ferramentas foram consideradas
inadequadas para utilizacdo na sistematica, visto que se mostram em desacordo com
um ou mais requisitos obrigatérios estipulados para o cumprimento dos objetivos.
Muitas exigem um conhecimento avangado de programacao, principalmente para a
criacdo de animacdes e interacdes, outras oferecem apenas versdes pagas ou
versOes de avaliacdo com grandes limitacdes. Existem também aquelas que
apresentaram problemas técnicos, ndo sendo possivel chegar ao final do processo
com a geragado de um arquivo executdvel da cena.

Das 34 ferramentas analisadas apenas uma se mostrou inteiramente
adequada a compor a sistematica em desenvolvimento cumprindo com todos os
requisitos obrigatdrios e 3 dos 4 desejaveis. Ela é constituida por dois softwares que
trabalham em conjunto, o Blender, que une as capacidades de modelagem 3D,
importacao de objetos, animagao e interagao e o Blend4Web um complemento
(plug-in) do Blender que proporciona a exportagdo facilitada do conteudo para
WebGL.

Ambos sdo totalmente gratuitos (critério 1), funcionam sem a necessidade de
conexdo direta com a internet (critério 2) e possuem versdes para os trés principais
sistemas operacionais, Windows, Mac OS e Linux (critério 3), com suporte ativo e
atualizacdes frequentes (critério 10). Ainda, o conjunto abrange por si sé as trés
funcionalidades requeridas, modelagem, animacao e interagao (critério 8), sem que
seja necessdrio algum conhecimento prévio de programacdo computacional para o
trabalho com quaisquer delas (critério 9). Para isso, os softwares trazem embarcada
uma linguagem de blocos (Figura 37), com a qual é possivel desenvolver facilmente

animacgoes e intera¢des de maneira predominantemente visual.
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Figura 37 - Visualizagdo geral de uma estruturagao de blocos utilizando a linguagem embarcada no

conjunto de softwares Blender + Blend4Web.

B vosve (2 [ 2R A RIDIER

Os softwares permitem também a importacdo de objetos 3D em diversos
formatos de arquivo (critério 6), o que facilita o fluxo de trabalho com outros
softwares de modelagem tridimensional. E possibilitam a exportacdao do contetudo
3D de forma simples diretamente em um arquivo HTML executdvel (critérios 4 e 7).

Apesar de nao satisfazerem o requisito desejavel n? 5, que diz respeito ao
arquivo final ser constituido de cddigo aberto para poder ser estudado
posteriormente em forma de texto, verificou-se que as interagdes estruturadas em
blocos suprem em parte este anseio, possibilitando uma leitura e entendimento
facilitado da construgdo das mesmas.

Ao passo que os softwares Blender e Blend4Web em conjunto demonstraram
potencial em uma primeira anadlise exploratéria, um novo experimento mais
aprofundado foi realizado para verificar em detalhes as funcionalidades oferecidas e
que possibilitariam a difusdo do WebGL como tecnologia util e aplicavel aos projetos
de Design Virtual e ao ensino.

O experimento compreendeu a criacdo de um cenario (Figura 38 e Figura 39)
composto por variados objetos 3D com animac¢des e interacdes desenvolvidas a

partir da linguagem de blocos embutida nos programas. Objetivou-se explorar e
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demonstrar a potencialidade dos principais recursos oferecidos, bem como analisar
o desempenho na execugdo do arquivo final (HTML) em computadores e
smartphones através dos navegadores web mais utilizados no mundo (Google
Chrome (60,5%), Mozilla Firefox (15,6%), Microsoft Edge/Internet Explorer (15,5%)),
conforme pesquisa realizada em Abril de 2016 pela empresa StatCounter

(CANALTECH, 2016).

Figura 38 - Parte de ambiente demonstrativo evidenciando o modelo de um carro com a paleta de

possiveis cores para ele e a direita um espaco de estar.

Figura 39 - Espago de estar com interagdo nos objetos sobre a mesa e palavras na parede que acionam a

troca do tipo de cdmera.
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Verificou-se que o complemento Blend4Web consegue trabalhar com a maior
parte dos recursos do Blender relacionados a modelagem 3D, aplicagdo e edicdo de
materiais e texturas, animacdes lineares, efeitos de fisica e particulas, iluminacao,
cameras e outras configuragdes do espago tridimensional, exportando com sucesso
o conteldo criado, diretamente em arquivo HTML Unico e executavel. Essa
exportacdo bem-sucedida, na maioria dos casos, se deve ao fato de que quando
ativado, o Blend4Web retira da interface do Blender todos os recursos com os quais
ele ainda ndo consegue trabalhar, restando para o usuario apenas aqueles
suportados.

Além disso o Blend4Web adiciona ao sistema de programacdo visual, ja
incluso no Blender, novos blocos com fun¢des de entendimento facilitado, nao
necessitando conhecimento prévio de programacdo para sua operacdo. A partir da
relagdao dos blocos é possivel criar inUmeras interagdes, entre elas, movimentacao e
visualizacdo da cena; transformacdo de objetos, luzes e cdmeras quanto a suas
dimensdes, posicdao, material, visibilidade e outros; acionamento de animagdes e
sons; redirecionamento para paginas da web ou outros ambientes, etc. Ainda existe
a possibilidade de inser¢do de interagdes mais complexas ou relacionadas a arquivos
externos por meio de arquivos criados com a linguagem javascript, porém devido a
este estudo ser voltado ao processo de trabalho de designers esse ponto nado foi
explorado.

Ressaltam-se também os recursos mais relevantes do conjunto Blender +
Blend4Web relacionados a modelagem, animacgao e interacdao, observados durante
as experimentacdes. Primeiro, o software Blender por si sé possui uma interface
(Figura 40) bastante semelhante aos demais programas de modelagem de
modelagem 3D do mercado, sendo familiar aos profissionais que ja utilizam estes.
Por sua vez, o complemento Blend4Web se utiliza desta mesma interface,
aproveitando-se de grande parte das ferramentas do Blender para fornecer os
recursos necessarios para a exportacdo dos ambientes utilizando a tecnologia
WebGL. Dessa forma, praticamente toda a parte referente a modelagem
tridimensional, configuracdo de luzes e camera, o tratamento de materiais e

mapeamento de texturas é suportada sem limitacdes significativas.
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Figura 40 — Tela inicial do software de modelagem tridimensional Blender.
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O conjunto de softwares também trabalha satisfatoriamente com varios tipos
de animacgdo, como as que compreendem as transformacdes de objetos como um
todo (dimensdo, posicao, material, visibilidade...), as animacfes de esqueletos que
permitem por exemplo a movimentacdo de personagens, as que trabalham com o
audio da cena que pode ser tanto reproduzido no ambiente como um todo ou com
emissdo concentrada em um sé ponto, as que simulam os efeitos ao ar livre (dgua,
vento, atmosfera...) e aquelas que retratam alguns efeitos de particulas como
fumaca, fogo e respingos d’agua.

Finalmente, as interagcdes podem ser construidas na tela Node Editor, onde
se encontra a linguagem de blocos do Blend4Web. Entre os blocos basicos
disponiveis estdo os que controlam sons; a visibilidade, transformagdes e materiais
de objetos; os tipos e movimentagdes de cameras; as animag¢des presentes na cena;
o realce de objetos por meio de um contorno e as acdes executadas ao clique do
mouse ou outro dispositivo suportado. Existem alguns outros blocos que possibilitam
também guardar valores em variaveis, realizar operacdes matematicas e verificar
condicdes de igualdade. Estes ultimos viabilizam a criacdo de interagcdes com maior
grau de complexidade sem que isso represente um aumento na dificuldade de

utilizagdo da presente linguagem.
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Paralelo a isso, o conjunto Blender + Blend4Web proporciona diversos

recursos nativos interessantes e coerentes com a caminho que segue a tecnologia

digital atualmente. Um deles é a navegacdao e movimentacdo por meio de mouse,

teclado, controles de videogames e telas de toque. Em aparelhos com giroscépio

(smartphones e tablets) também ¢é possivel acessar uma visualizacdo em tela

dividida, prépria para equipamentos como éculos de realidade virtual, preparando

os projetos para a nova era da RV. OQutros recursos nativos sdo:

Fast Preview: Uma forma de visualizacdo rapida do projeto no
navegador web, antes de se exportar o arquivo HTML final. Junto a ela
sdo disponibilizados alguns recursos para a identificacdo de erros e
ajustes finos em tempo real nas propriedades da cena 3D. Ele
proporciona maior controle no processo de desenvolvimento de
ambientes e aplicagdes virtual tridimensionais.

Otimizagdes: Verificou-se o suporte a otimizagdes comuns em
tecnologias de representagdao anteriores como a suavizagdo de
geometrias e a cépia de elementos que compartilham informacdes de
atributos entre si, tornando menor a exigéncia de processamento
computacional para a execu¢ao do conteddo e aumentando a taxa de
quadros por segundo!® (FPS, sigla em inglés) no momento de sua
reproducdo.

Perfis de Qualidade Gréfica: Para todos os projetos exportados
diretamente em HTML sdo criados automaticamente trés perfis de
qualidade grafica (Baixo, Alto e Ultra) com diferentes niveis de
aprimoramento de texturas, iluminagcdo e outros. Isso amplia as
chances de o ambiente ser executado com fluidez satisfatéria em
dispositivos de menor capacidade de processamento. Esses perfis
também podem ser criados manualmente caso se deseje.

13 «

Quadros por segundo (FPS) é uma medida de como o0 movimento de video é exibido. O termo se aplica

igualmente ao video de filme e video digital. Cada quadro é uma imagem estatica” (MICROSOFT, 2016b).
Quando maior o niumero de quadros por segundo, maior a percepc¢do visual de fluidez do conteludo

reproduzido.
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Por fim verificou-se a fluidez de reproducdo do ambiente criado nos trés
navegadores mais utilizados e ja citados, em suas versGes mais atuais. Para isso,
registrou-se as taxas minimas e maximas de quadros por segundo (FPS) no momento
da execugdo, obtida por meio do recurso Fast Preview do préprio Blend4Web. Todas
as analises foram realizadas em um mesmo computador e com o mesmo perfil de
qualidade grafica (Alta) para ndo haver possiveis influéncias externas. Ressalta-se
ainda que o valor maximo possivel de ser atingido em qualquer navegador é 60 FPS,

devido a uma trava do sistema.

Tabela 8 - Taxas minimas e maximas de quadros por segundo (FPS) durante a execu¢do do ambiente

WebGL nos trés principais navegadores. Quanto maior, melhor.

Google Chrome v.55 | Mozilla Firefox v.50 | Microsoft Edge v.38

Minimo 58 FPS 55 FPS 57 FPS
Maximo 60 FPS 60 FPS 60 FPS

A partir da analise destes registros percebe-se que ndo ha diferencas
significativas quanto a fluidez de visualizacdo do ambiente nos trés navegadores,
guando executada esta cena experimental. Também ndo é possivel diferenciar
visualmente as pequenas quedas na taxa. Pode-se dizer que neste teste ndo houve
superioridade expressiva no uso de um destes navegadores para a execug¢ao de
conteudos gerados pelo conjunto Blender + Blend4Web, confirmando a possibilidade
de uma distribui¢ao mais abrangente dos mesmos.

Finalizam-se as discussGes acerca da analise e selecdo dos softwares e dd-se
inicio a construcao da sistematica de criacdo de ambientes tridimensionais virtuais
por designers, que mais tarde é experienciada na criacao de novos ambientes virtuais
que esclarecem seus pontos fortes e fracos, que surgem como sugestdes de novas
pesquisas relacionadas. O presente trabalho é finalizado com a apresentacao dos
ambientes-teste em WebGL e a comparacdo deles com ambientes que utilizam o
antecessor VRML. Também sdo discutidos os resultados e relatadas as consideracdes
finais relativas ao andamento da pesquisa e seus possiveis caminhos.

Para possibilitar a comparagao entre as cenas utilizando o WebGL e seu

antecessor, utilizou-se dois softwares para exportar as cenas em VRML. Cada programa
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gerou uma cena em VRML com diferentes caracteristicas. A primeira exportagdo foi
realizada a partir do préprio software Blender v.2.78c sem nenhuma altera¢do no
ambiente e a outra com o software 3ds Max 2017, onde elas foram reconstruidas
utilizando as ferramentas do programa exclusivas para VRML.

Para visualizar os arquivos “.wrl”, formato padrdao do VRML, foi preciso utilizar
um plug-in que é instalado no computador e que funciona em conjunto com o
navegador web do mesmo. Escolheu-se o plug-in Cortona3D por ser um dos Unicos
ativos atualmente e por executar adequadamente todos os recursos da linguagem

VRML.

3.2. MATERIAIS

Descreve-se aqui os materiais, softwares e dispositivos empregados nas

diferentes etapas desta pesquisa cientifica.

3.2.1. Revisao bibliografica

Para uma revisdo bibliografica de relevancia, buscou-se referéncias
diversificadas. Foram escolhidos livros e e-books publicados que tenham sido
revisados por uma equipe editorial. Artigos, monografias, dissertacdes e teses foram
obtidas por meio de reconhecidas plataformas de indexac¢ao de conteddo académico
(Periédicos CAPES, Elsevier, SciELO, Google Académico e outros). Websites foram
utilizados como fonte para a obtencdo de informac¢des explicativas basicas, de
carater publico, quando nao foi possivel conseguir os dados procurados em meios de
melhor reputacdo, sempre verificando a procedéncia dos mesmos.

Para organizar todo o conteudo coletado utilizou-se o software Mendeley.
Um gerenciador de referéncias académicas que as ordena e classifica segundo dados
inseridos pelo usuario ou obtidos automaticamente dos documentos nele
cadastrados. Ele também facilita a inser¢cdao correta de citagdes em trabalhos

académicos, diminuindo drasticamente o tempo gasto neste processo.
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3.2.2. Analise de ferramentas e avaliacao da sistematica

Tanto as experimentacdes das ferramentas selecionadas para analise como
os testes desenvolvidos com a sistematica foram realizados em um smartphone para
visualizacdo do conteddo multiplataforma em WebGL e dois computadores desktop,
um com sistema Windows e outro com Mac OS, para visualiza¢ao e edigao.

O smartphone é um LG G3 D855P, que conta com um processador Qualcomm
Snapdragon 801 de quatro nucleos com velocidade de 2.5GHz cada, GPU Adreno 330,
2GB de meméria RAM, tela IPS LCD de 5,5 polegadas, resolucao de 1440 x 2560 pixels
e rodando o sistema operacional Android em sua versao 6.0.

A configuracdo do primeiro desktop é a seguinte: processador Intel Core i5-
4670 com quatro nucleos de 3,4GHz cada, placa de video Nvidia Geforce GTX 760
com 2GB de memodria GDDR5, 8GB de memadria RAM DDR3 1600MHz. Este desktop
roda o sistema Windows 10 Pro de 64 bits atualizado frequentemente.

O segundo computador é um Mac Mini (modelo final de 2012) com
processador Intel Core i5 (modelo ndo especificado) de 2,5GHz de velocidade em
cada um de seus dois nucleos, processador grafico Intel HD Graphics 4000, 4GB de
memoria RAM DDR2 1600MHz, rodando o sistema operacional Mac OS Sierra com

manuteng¢do constante de suas atualizagdes.
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SISTEMATICA

O processo de criacdo de ambientes tridimensionais virtuais (Figura 41) em
desenvolvimento é suportado por trés pilares (Figura 42). Estes foram definidos a partir
das discussdes anteriores sobre realidade virtual e analise histérica e técnica das
tecnologias predecessoras de descricao de cenas virtuais. Portanto, a sistematizagao
considera a adicdo destes trés parametros ao espaco virtual, que por fim é exportado
em formato executdvel em multiplas plataformas seguindo os principios do WebGL

(Figura 43).

Figura 41 — Processo basico de criagdao de ambientes 3D virtuais com animagao e interagdo.
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Figura 42 - A sistematica deve satisfazer trés principais questdes: modelagem, animacgao e interagao.

W

Geometrias Movimentos .
Materiais Visibilidade Acionamento
Texturas Sons Navegacao

Modelagem Animacao Interacdo

A sistemdtica (Figura 43) é subdivida em onze macro fases que abrangem a
obtencdo e instalacdo dos softwares requeridos, a preparacdo para o uso, a
apresentacdo da interface geral, a obtengdo dos modelos tridimensionais, a insercao
de luzes, cdmeras, sons e textos, a configuracdo do ambiente e sombras, a adicdo de
efeitos ao ar livre, a criagcdo de animacgdes e interagdes e por fim, a exportagdo do
ambiente virtual pronto para visualizacdo em computadores e dispositivos moéveis
como smartphones, tablets ou qualquer outro que possua um navegador web
compativel com a tecnologia WebGL. Cada macro fase é dividida em tépicos menores
gue auxiliam na organizacao da sistematica e por consequéncia ajudam o usudrio a
localizar o assunto desejado com maior facilidade.

Salienta-se que o conjunto de softwares utilizados aqui oferece ainda mais
funcionalidades do que as abrangidas por esta sistematica. Porém s3ao exploradas
somente aquelas que se encontram de acordo com os requisitos do trabalho de
pesquisa e que também sdo relevantes a execucdo de projetos da drea de Design
Virtual.

Este € um processo que visa a construgdo basica de ambiente virtual 3D
animados e interativos por designers utilizando o WebGL. Portanto, recursos e
propriedades mais avancadas podem ser estudadas e aprofundadas pelo préprio

usuario posteriormente nos manuais oficiais dos programas* e nos diversos tutoriais

14 Link para os manuais dos programas:
Blender - https://www.blender.org/manual/
Blend4Web - https://www.blend4web.com/doc/en/
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em texto e video disponiveis na internet, a fim de obter melhores resultados de
acordo com as especificidades de cada projeto.

Também, ressalta-se que, em decorréncia da legibilidade deste documento,
somente alguns tdépicos iniciais e finais da sistemdatica sdo apresentados na integra
aqui. O conteudo completo foi publicado na forma de um livro digital intitulado
‘Ambientes Virtuais 3D Interativos — utilizando Blender + Blend4Web’ pela editora
Marca Visual (ISBN 978-85-61965-48-8), tendo como autores, Bruno Spanevello
Pergher e José Luis Farinatti Aymone. Cada sec¢do suprimida da sistematica traz a

indicacao de sua localizagao no referido livro e ao menos uma imagem que a ilustra.

Figura 43 — Panorama geral da sistematica proposta.
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4.1. OBTENCAO E INSTALAGCAO DOS SOFTWARES

Inteiramente gratuitos em suas versdes completas’® e constantemente
atualizadas, Blender e Blend4Web s3ao disponibilizados para download em seus
enderecos virtuais oficiais: Blender (https://www.blender.org/) e Blend4Web “CE”
(https://www.blend4web.com/en/). Tanto um como o outro também possuem versdes
para Windows Vista ou superior (32bit ou 64bit), Mac OS (64bit) e Linux (32bit ou 64bit).
Seguem os atuais requerimentos de hardware descritos na pagina oficial do Blender
(Tabela 9).

Demais instrucdes a respeito da instalacdo dos programas podem ser

encontradas no Capitulo 1 do livro ja mencionado, entre as paginas 21 e 26.

Tabela 9 — Configura¢des de hardware exigidas para o funcionamento adequado dos softwares Blender

e Blend4Web.

Hardware

Minimo

Hardware

Recomendado

Hardware

Ideal

Processador (CPU)

Memodria RAM

Monitor

Periféricos

Placa de Video
(GPU)

32-bit Dual Core 2Ghz
com suporte SSE2

2GB

24 bit com resolugdo

de 1280x768 pixels

Mouse ou Trackpad

512 MB RAM e
compativel com

OpenGL 2.1

64-bit Quad Core

8 GB

24 bit com resolugdo

de 1920x1080 pixels

Mouse de 3 botdes

2 GBRAM e
compativel com

OpenGL 3.2

64-bit Eight Core

16 GB
2 monitores 24 bit
com resolugdo de
1920x1080 pixels
Mouse de 3 botdes ou
Mesa de desenho
(Graphics Tablet)
2 placas com 4GB RAM
e compativeis com

OpenGL 3.2

Fonte: BLENDER (2017).

15 No site do Blend4Web é possivel encontrar duas versdes gratuitas do software, a “CE” (Recomendada)
que traz todos os recursos de desenvolvimento (ex.: Scene Viewer, Project Manager, Fast Preview) e o
“Add-on” que possibilita apenas os recursos basicos de exportagao. Existem também duas versdes pagas
gue basicamente possuem alteragGes na licenca de uso dos contelidos, um suporte técnico diferenciado
e uma maior biblioteca de materiais, sem acrescentar ferramentas ou recursos relevantes a criacdo dos
cendrios tridimensionais.
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4.2. PREPARACAO PARA O USO DO BLEND4WEB

Depois da instalacdo dos dois programas, deve-se atentar para dois
procedimentos iniciais necessarios para que o complemento Blend4Web funcione
adequadamente. Esses procedimentos devem ser realizados sempre que se inicie um

arquivo novo.

1. O primeiro procedimento necessario é a escolha do Blend4Web como
motor de renderizacdo do Blender no topo da janela principal (Figura 44).
Assim, sdo habilitadas todas as op¢des de configuracdo do Blend4Web e
também sdo assinaladas ou ocultadas da interface as ferramentas do
Blender com as quais o complemento ainda ndo trabalha
adequadamente, certificando que nao haja erros, durante a exportacao,
pela utilizacdo de recursos ndo suportados. Apds habilitado, sao
apresentadas diversas configuracdes do complemento Blend4Web na
area Properties (Propriedades em inglés), identificada por uma barra no
topo contendo varios icones (Figura 45).

Figura 44 — Alteragdo do motor de renderizagao.

Engine
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2. Antes do desenvolvimento do ambiente 3D propriamente dito, deve-se
atentar para algumas opc¢dOes acessadas pelo menu Scene (terceiro icone
da barra de propriedades - Figura 45). Para a correta exportacdo dos
elementos 3D, animacdes e interacdes desenvolvidas deve-se habilitar as
seguintes op¢des (Figura 46), sempre ao iniciar um novo projeto:

e Logic Editor: responsavel por exportar a ldgica de interacdes criadas
por meio da linguagem de blocos;

e NLA (com Cyclic NLA): responsavel pela exportacdo e execucdo de
alguns tipos de animacdes;

e Enable Physics: permite a exportacio de efeitos de fisica
eventualmente presentes na cena. Deve estar configurado como

AUTO ou ON.

Figura 46 — Opgdes a serem habilitadas no menu Scene antes do inicio da criagao.
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4.2.1. Fast Preview

O Fast Preview é um recurso que se apresenta na forma de um ambiente para a
realizacdo de testes do contelido que esta sendo desenvolvido. E acionado por meio do
botdo também denominado Fast Preview na barra inferior da janela 3D view (Figura 47).
Ele ajuda a reduzir o tempo gasto com o projeto, permitindo a realizagao de inimeros
testes de forma rdpida e com ferramentas extremamente Uteis para a identificacdo de

erros na cena.

Figura 47 — Localizagdo do recurso Fast Preview.

(1) Cube

® Objectmode ¢+ @ 8| %t LRl clobal * GEES HEENE 2 [ o

Ao clicar no botdo Fast Preview, o programa realiza a exportacdo do projeto em
desenvolvimento com as configurages do momento e em formato de um arquivo
temporario, que é substituido por outro na préxima utilizacdo do recurso. Logo apds, o
arquivo gerado é entdo aberto no navegador web padrdao do computador dentro do
Scene Viewer, um ambiente de testes onde é possivel visualizar uma série de
informacgdes sobre o projeto tais como dados das geometrias, resolucdo da visualizacao,
tamanho do arquivo e outros (Figura 48). H4 também uma barra na lateral direita com
a qual é possivel realizar uma série de alteracdes nos valores das propriedades de varios
recursos que foram inseridos na cena. Essas alteracdes modificam a cena ao lado em
tempo real, porém ndo sdo salvas nem no arquivo gerado para testes nem no arquivo

do projeto no Blender.
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Figura 48 — Scene Viewer aberto pelo comando Fast Preview para a realizagdo de testes.
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Em se tratando de verificacdo de possiveis erros, existe um sistema de semaforo

(Figura 49), no canto superior direito da tela, que avisa ao usudrio se a cena contém

problemas relacionados as restricdes do programa por meio das cores verde (sem

erros), amarelo (erros de menor gravidade) e vermelho (erros de maior gravidade). Nem

sempre os erros acusados ocasionam falhas na exportacdo final se ndo corrigidos, mas

podem indicar problemas na relagao entre elementos e outros recursos utilizados. Para

visualizar quais sdo os erros encontrados, é necessario abrir no navegador a janela que

contém algumas ferramentas destinadas aos desenvolvedores web. Nos principais

navegadores (Google Chrome, Mozilla Firefox, Safari e Microsoft Edge) essas

ferramentas sdo acessadas pela tecla F12. Ali, geralmente na aba Console (Figura 50),

sdo apresentadas as descricdes dos problemas precedidas um dos seguintes termos:

B4W WARN, B4W EXPORT WARNING e B4W EXPORT ERROR.

Figura 49 — Exemplo da sinalizagdo da presenca de erros por cores na tela do Scene Viewer.

Build: 20.01.2017 13:49:53

Scene: preview

Loaded: 100% (5.7s)

# Home s HIGHQ

¥ Pause =p Resume

C Reset

3 Rofate

Build: 20.01.2017 14:02:30

Scene: preview

Loaded: 100% (3.3s)
A Home +« HIGHQ C Reset

® Pause =p Resume O Rotate

Build: 20.01.2017 14:13:11
Scene: preview

Loaded: 100% (3.1s)
4 Home +« HIGHQ C Reset

¥ Pause = Resume O Rofate




93

Figura 50 — Aba Console da janela de ferramentas de desenvolvedor do navegador Google Chrome.

Brunol — [m] )
T BlenddWeb Viewer x
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Animation
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NLA

Shape Keys
Materials M
[ ﬂ Elements Conscle Sources MNetwork Timeline Profiles  Application  Security  Audits  AdBlock @142 & X
Q ¥ twop v Preserve log ¥ Show all messages
BAW LOG: GET EXTENSION WEBGL_depth_texture print.js:49 -
B4W LOG: GET EXTENSION WEBGL_compressed_texture_s3tc print.js:49
BAW LOG: SET PRECISION: highp print.is:49
B4W LOG: LOAD METADATA ../../tmp/preview/preview.jsen?t=20012017144958 print.js:49

© P B4W EXPORT ERROR: Fail to force set of active logic node tree. See more details in print.js:124
https://www.blenddweb. com/doc/en/addon . html#non-critical-export-error

» B4ld EXPORT WARNING: Wrong name of active logic node tree:''. See more details in print.js:132
https://e -blend4web.com/doc fen/addon.html#other-messages
41 LOG: LOAD BINARY ../../tmp/preview/preview.bin?t=20012017145082 print.js:49
24 LOG: LOAD PHYSICS Using Separate Worker Thread, Max FPS: 6@ print.js:49
4W LOG: PHYSICS PATH http://localhost:6687/src/../deploy/apps/common/uranium.js2t=20012017145802 print.js:49
(3 ARN: There is no sun on the scene. Procedural sky will use a default sun position. print.§s:111
BAW LOG: GET EXTENSIOM QES_standard_derivatives print.is:49
BAW LOG: GET EXTENSIOM OES_element_index_uint print.is:49
B4W LOG: LOAD IMAGE 1824x1@24 ../../tmp/preview/53861487a4cfB849@38e5dadaale23f91.pngt=20012017145005 print.is:49
B4 0G: LOAD AG 75 ../../tmp/previen/122a3c72d96878abeBded831d3abf331. png ?t=20012017145885 print.js:49
: LOADED ALL I print.js:49
: PHYSICS READY print.js:49
: THREAD @: LOADED CALLBACK print.js:48
B4W LOG: START NLA print.js:49
>
Console X

4.3. INTERFACE GERAL

O ensinamento da utilizacdo das ferramentas e propriedades basicas de
modelagem e montagem de cenas tridimensionais ndo faz parte deste livro. E
importante, porém, facilitar a localizacdo dos recursos apresentados. Por isso, para um
entendimento geral da interface partilhada pelos softwares aqui adotados, segue uma
breve descrigdo e mapeamento das areas e janelas mais relevantes. Ressalta-se que
todas as janelas do Blender podem ser movidas e dispostas, conforme a preferéncia do

usuario e o que se apresenta aqui é baseado na disposicao padrao do software.
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e Info (Figura 51): contém os acessos as configuracdes mais gerais do
programa e sua interface. Traz também os atalhos para o manual de uso
e algumas informacodes sobre o projeto em edicao;

Figura 51 — Localizagdo da barra Info.

Info

e 3D View (Figura 52): é a principal janela de visualizagdo do espago
tridimensional do programa e dos objetos 3D. Na esquerda, encontra-se
um agrupamento de ferramentas de movimentagao e escala de objetos,
criacdo de geometrias, luzes e cameras, relacbes entre elementos e
fungdes basicas relacionadas a animacgdes e efeitos de fisica;

Figura 52 — Localizagdo da janela 3D view.

3D view
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Outliner (Figura 53): possui a lista estruturada de todos os elementos
(objetos 3D, cameras, luzes...) do projeto. Através dela é possivel
selecionar com precisdo o elemento desejado e alterar propriedades
relacionadas a visibilidade;

Figura 53 — Localizacdo da janela Outliner.

Outliner

Properties (Figura 54): contém as propriedades basicas e avancadas,
divididas por abas, referentes a cada elemento criado. Também abrange
as configuragdes do cendrio e ambiente, bem como aquelas especificas
do Blend4Web;

Figura 54 — Localizagdo da janela Properties.
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e Timeline (Figura 55): uma das areas destinadas a edi¢cdo de animacgdes no
Blender. Muito utilizada para a criagdo de animagdes mais simples,
originadas pela interpolacdo de condicGes (Keyframes) definidas ao longo
da sequéncia de quadros;

Figura 55 — Localizacdo da janela Timeline.

Timeline

—

e Node Editor (Figura 56): oculto logo quando é criado um novo documento
no Blender. O Node Editor é onde se constrdi as légicas das interacdes
através da linguagem visual de blocos do Blender acrescida de recursos
proprios do Blend4Web.

Figura 56 — Janela do Node Editor.
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4.3.1. Criacdo e Manipulacao das Janelas de Exibicdo (Viewports)

As Janelas de Exibicdo, chamadas de Viewports em inglés, sdo as janelas pelas
quais se visualiza a cena tridimensional que se estd criando. No Blender, a janela 3D View
cumpre esse papel e, em muitos casos, é util a presenca de mais de uma viewport em
conjunto no ambiente de trabalho do programa. Essas multiplas janelas podem, por
exemplo, auxiliar no posicionamento correto dos elementos no espaco virtual. Quando
se tem mais de uma viewport (janela 3D View) aberta, é possivel que cada uma delas
tenha uma forma diferente de visualizacdo da cena em desenvolvimento.

Por padrao, quando se inicia um novo projeto no Blender, ja é aberta uma janela

3D View. Para criar outras, existem quatro maneiras:

OBS: Estes métodos servem tanto para as janelas 3D View, como para a

abertura e duplicacdo dos demais tipos de janelas do software
Blender.

1. A primeira maneira de criar janelas outras janelas 3D View é clicando em
um dos icones triangulares localizados nos cantos inferior esquerdo e
superior direito da janela 3D View aberta (também presente nos cantos
de qualquer outra janela) e arrasta-lo na horizontal ou na vertical (Figura
57). Isso fard com que uma duplicacdo da janela 3D View seja aberta na
direcdo em que o triangulo foi arrastado (Figura 58).

Figura 57 — Ampliacdo e localizag¢do dos triangulos localizados nos cantos inferior esquerdo e superior

direito da janela 3D View.
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Figura 58 — Duas janelas 3D View abertas lado a lado.

2. A segunda forma é uma variagdo da primeira. Mantém-se pressionada
tecla SHIFT do teclado ao clicar em um dos icones triangulares localizados
nos cantos inferior esquerdo e superior direito da janela 3D View aberta
(também presente nos cantos de qualquer outra janela) e arrasta-lo na
horizontal ou na vertical (Figura 57). Assim, uma cépia da janela 3D View
serd aberta “destacada” das demais (Figura 59). Pode ser movida
livremente e também disposta em um monitor secundario, se existir.

Figura 59 — Cdpia da janela 3D View destacada das demais.
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3. A terceira forma consiste em clicar com o botdo direito do mouse em
qualquer linha limite (as mais externas) de qualquer janela, 3D View ou
outra. Com isso, um menu se abre (Figura 60) e, clicando na opcao Split
Area, é possivel escolher alguma das janelas abertas para ser dividida em
duas do mesmo tipo. A escolha do ponto exato para a divisdao da janela
desejada se da por meio de uma linha, horizontal ou vertical, que
acompanha o ponteiro do mouse quando este estd sobre alguma das
janelas (Figura 61). Para confirmar a divisdo, basta um clique com o botao
esquerdo do mouse na posicdo desejada.

Figura 60 — Menu (ampliado) com a opgédo Split Area, que se abre com o clique do botédo direito do

mouse entre duas janelas.

Figura 61 — Linha de divisao de janelas que acompanha o ponteiro do mouse e determina o ponto de

divisdo da janela.
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4. A quarta e ultima maneira de criar cépias da viewport principal é
substituir outra janela aberta por uma janela 3D View. Para isso, basta
clicar no botdo de troca de janela (Figura 62), localizado em um dos
cantos da janela que se pretende substituir (o canto varia dependendo da
janela), e escolher a opgdo 3D View no menu que se abre (Figura 63). A
janela escolhida no menu assumird o local e as dimensdes da anterior
(Figura 64). Para redimensiona-la, é so clicar com o botdo esquerdo do
mouse nas linhas limites da janela e, mantendo pressionado, arrastar
para definir o tamanho desejado.

Figura 62 — Diferentes localizagdes dos botdes de troca de janela (ampliados), de acordo com o tipo de

janela.
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Figura 64 — Duas janelas 3D View. A de baixo esta no lugar original da Timeline que foi substituida e

redimensionada.

Todas as janelas 3D View abertas, bem como as demais janelas do programa,
podem ser redimensionadas ao clicar com o botdo esquerdo do mouse, manter
pressionado e arrastar as linhas que as delimitam, tanto na horizontal como na vertical.
O procedimento é o mesmo para o redimensionamento de qualquer menu lateral das
janelas. Estes por sua vez, quando reduzidos até o limite externo das janelas das quais
pertencem, sdo ocultados por completo, aparecendo em seu lugar um icone com o sinal
de positivo (+) (Figura 65), que ao ser clicado faz com que o menu reaparega. Em
qualquer caso, redimensionamento de janelas ou menus, ao posicionar o ponteiro do
mouse sobre as linhas limites de ambos, surge um icone no formato de duas setas na
vertical (nos limites inferior e superior) ou horizontal (nos limites esquerdo e direito)

(Figura 66).
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Figura 65 — Duas janelas 3D View. A da esquerda com seu menu lateral esquerdo ocultado e em seu

u um i i .
lugar um icone ‘+’ (ampliado
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D

Ja para fechar qualquer janela, incluindo a 3D View, deve-se clicar com o botao
direito do mouse em uma das linhas limites entre duas janelas e, no menu que se abre,
escolher a opgdo Join Area (Figura 67). Depois, ao passar o mouse sobre uma das janelas
divididas pela linha clicada, ela escurece e surge uma seta indicando que ela serd

fechada ao clique do botdo esquerdo do mouse (Figura 68).
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Figura 67 — Menu (ampliado) com a opgdo Join Area, que se abre com o clique do botdo direito do

mouse entre duas janelas.

Figura 68 — Indicagdo da janela, selecionada com o ponteiro do mouse, que sera fechada ao clique do

botdo esquerdo do mouse.
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OBS: A configuracdo das janelas abertas (quantidade, tipo,

posicionamentos, dimensdes) é salva junto com o arquivo do projeto
do Blender. Quando ele for aberto em qualquer computador, sera
iniciado com a ultima configuragcao de janelas salva.
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Multiplas viewports, cdpias da janela 3D View, podem apresentar para o usuario
diferentes visualizacdes da mesma cena, assim auxiliando-o na disposicdo e
configuracdo de elementos, materiais e outros. Para modificar a visualizacdo de cada

viewport, existem alguns menus acessados pela barra inferior da janela 3D View.

e View (Figura 69): possui opgdes para alternar a posi¢do de visualizagdo da
cena entre diferentes vistas, de acordo com a orientacdo do espaco
virtual: Left (esquerda), Right (direita), Back (traseira), Front (frontal),
Bottom (inferior), Top (superior), Camera (visdo da camera principal).
Ainda, é possivel alternar a visualizacdo entre Perspectiva e Ortogonal
(View Persp/Ortho);

Figura 69 — Menu View com marcagao das opgdes de alteragdo da posi¢do de visualizagdo da cena.
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e Viewport Shading (Figura 70): Possui opgdes para alternar a forma de
exibicdo dos objetos 3D entre:

- Material: que mostra uma aproximacdo do material aplicado aos
objetos e da iluminacdo da cena;
- Texture: que mostra os objetos com suas texturas aplicadas;
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- Solid: que apresenta os objetos apenas com cores soélidas e
iluminagao simples;

- Wireframe: que exibe somente as linhas da malha dos objetos;

- Bounding Box: que exibe os objetos somente como caixas
retangulares que demonstram suas dimensées maximas;

- Solid: que apresenta os objetos apenas com cores soélidas e
iluminagao simples.

Quando se trabalha com o complemento Blend4Web sdo apenas essas as
opcOes deste menu, porém sem ele ha ainda mais uma opg¢do chamada
Rendered, que apresenta a visualizacao exata da cena renderizada, com
iluminagao e materiais em qualidade final.

Figura 70 — Menu Viewport Shading com as diferentes opgdes de exibicdo dos elementos da cena.
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4.3.2. Manipulacdo de Elementos (Objetos 3D, Luzes, Cameras...)

Usuarios que nunca tiveram contato com o software Blender podem ter certa
dificuldade na hora de manipular os elementos inseridos no espaco virtual. Por isso, é
valida uma explicacdo das formas e configuracdes de Translacdo, Rotacdo e Escala
presentes no programa. Estas servem tanto para objetos 3D, como para luzes, cameras,
textos, autofalantes e outros elementos.

A primeira forma de manipula¢do de elementos é através do Gizmo (Figura 71),
uma representagao que surge na tela quando algum elemento se encontra selecionado
e serve para manipuld-lo segundo cada um de seus eixos, individualmente. Comum em
grande parte dos programas que trabalham com modelagem tridimensional, ele tem
sua representacdo alterada conforme a funcdo determinada para ele no momento

(Translagdo, Rotagdao ou Escala). Sendo constituido por setas quando em modo
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Translac¢ao, circulos em modo Rotacdo e eixos com cubos nas pontas em modo de Escala.

Cada cor do Gizmo representa um dos 3 eixos (X, Y e Z) do espaco tridimensional.

Figura 71 — Os trés tipos de Gizmo segundo sua fungdo. Da esquerda para a direita: Translagdo, Rotagdo

e Escala.

Para alternar entre os 3 tipos de Gizmo utiliza-se os botdes denominados
Translate, Rotate e Scale, presentes na barra inferior da janela 3D View (Figura 72). No
lado esquerdo destes botdes, o botdo com um icone representando os eixos coloridos

faz com que seja ocultado e exibido o Gizmo na tela.

Figura 72 — Localizagdo do botdo que mostra ou oculta a visualizagdo do Gizmo e os que alternam entre

os trés tipos de Gizmo.

Para alterar a Translacdao, Rotacao ou Escala do elemento selecionado, basta
clicar com o botdo esquerdo do mouse em alguns dos eixos coloridos do Gizmo e,
mantendo-o pressionado, arrastar o mouse.

Também é possivel modificar o posicionamento e a orientagdo do préprio Gizmo.
Para isso, existem os menus chamados Pivot Point (Figura 73) e Transform Orientation
(Figura 78), que configuram, respectivamente, as duas propriedades. Ambos os menus

se encontram na barra inferior da janela 3D View e suas opg¢des sao as seguintes:
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Figura 73 — Menu de configuracao do posicionamento do Gizmo no espago virtual.
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e Active Element (Figura 74): posiciona o Gizmo no centro do elemento
ativo (selecionado). No caso da selecdo individual de mais de um
elemento em conjunto, o Gizmo se posiciona no centro do ultimo
elemento adicionado a selecdo. Ja no caso de uma selecdo de multiplos
elementos de uma vez sd, o Gizmo fica ao centro do ultimo elemento
manipulado antes da selegao;

Figura 74 — Representagdes de Gizmos posicionados com a opgao Active Element ativa. Na esquerda,

com somente um objeto selecionado e, na direita, trés objetos selecionados em conjunto.

e Median Point (Figura 75): quando apenas um elemento é selecionado,
posiciona o Gizmo no centro deste. Quando mais de um elemento é
selecionado, faz com que o Gizmo fique no ponto médio de equilibrio
entre eles;

e Individual Origins (Figura 75): posiciona o Gizmo da mesma forma que o
Median Point, porém todas as manipula¢des realizadas através do Gizmo
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afetam os elementos como se existisse um Gizmo individual no centro de
cada um deles;

Figura 75 — Representagdes de Gizmos posicionados com a opgao Median Point ou Individual Origins

ativa. Na esquerda, com somente um objeto selecionado e, na direita, trés objetos selecionados em

conjunto.

e 3D Cursor (Figura 76): permite que o Gizmo seja posicionado em qualquer

local que o usuario desejar. Com um ou mais elementos selecionados,

basta clicar com o botdo esquerdo do mouse na posi¢ao desejada para o
Gizmo, dentro do espaco virtual;

Figura 76 — Representacdes de Gizmos posicionados com a opg¢do 3D Cursor ativa. Na esquerda, com

somente um objeto selecionado e, na direita, trés objetos selecionados em conjunto.
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e Bounding Box Center (Figura 77): funciona de forma semelhante ao
Median Point, porém quando multiplos elementos sdo selecionados, o

Gizmo se posiciona no centro de um paralelepipedo imaginario que os
engloba.

Figura 77 — Representacdes de Gizmos posicionados com a opgdo Bounding Box Center ativa. Na

esquerda, com somente um objeto selecionado e, na direita, trés objetos selecionados em conjunto.

Figura 78 — Menu de configuragao da orientagdo do Gizmo.
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o View: determina que os eixos do Gizmo mantenham uma orientagao
predeterminada independentemente da posi¢ao de visualizagdo do
elemento selecionado. Essa orientagdo segue as seguintes regras:

- Eixo Y: Para cima / Para baixo;
- Eixo X: Esquerda / Direita;
- Eixo Z: Para dentro da tela / Para fora da tela.
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e Gimbal: faz com que o Gizmo se oriente e atue conforme os principios de
um Gimbal, um suporte articulado que permite a rotacao de um objeto
em torno de um Unico eixo (Figura 79);

Figura 79 — Representagdo de um suporte Gimbal.

e Normal: orienta o Gizmo de forma que o seu eixo Z corresponda com o
Vetor Normal do elemento selecionado;

e Local: faz com que os eixos de transformacdo do Gizmo tenham a mesma
orientacdo dos eixos do elemento selecionado, seja ele um objeto 3D,
camera, luz ou outro;

e Global: faz com que os eixos de transformagao do Gizmo estejam com a
mesma orientacao das coordenadas globais, ou seja, a orientacdao dos
eixos do espaco virtual.

Além da manipulacdo da Translacdo, Rotacdo e Escala dos elementos por meio
do Gizmo, existem outras duas diferentes formas de manipula-los. Uma delas é através
dos botdes Translate, Rotate e Scale, dispostos no menu Tools da janela 3D View (Figura
80), quando um ou mais elementos estdo selecionados. Estes alteram, respectivamente,
a Translacdo, Rotacdao e Escala dos elementos de forma livre com o movimento do
mouse, sem a fixacdo a algum eixo. Também podem ser acionados pelos atalhos: tecla

G (Translate), tecla R (Rotate) e tecla S (Scale).
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Figura 80 — Localizagdo dos botdes Translate, Rotate e Scale no menu lateral da janela 3D View.
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Para obter maior controle dessa movimentagao mais livre, também é possivel
realiza-la de outra maneira. Com o elemento que se pretende mover selecionado, clica-
se com o botdo esquerdo ou botdo direito do mouse e o mantém pressionado, no circulo
localizado ao centro do seu Gizmo (Figura 81) e movimenta-se o mouse fazendo com
que a posicao, Rotacdo ou Escala do objeto (dependendo do tipo de Gizmo ativo) seja
alterada sem a fixacdo em um sé eixo, porém com maior precisdo. Durante a
movimentac¢do o Gizmo é ocultado e, no caso dos modos de Rotac¢do e de Escala, surgem
icones na ponta do ponteiro do mouse, indicando que o elemento em questdo esta

sofrendo altera¢Oes nestas propriedades (Figura 82).
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Figura 81 — Indicagdo da localizagdo do circulo central do Gizmo de rotagdo.

Figura 82 — Representagdes dos icones que surgem quando se transforma a Rotagdo (esquerda) e a

Escala (direita) de elementos pelo clique no circulo central do Gizmo e movimentagdo do mouse.

A Ultima forma de manipulacdo de elementos é através do menu Object >
Transform, dentro da janela Properties (Figura 83). Neste local, encontram-se as
informacdes exatas das coordenadas de posicionamento, angulos de rotacdo e fator de
escala do elemento selecionado, para cada um dos 3 eixos (X, Y e Z). Estes valores podem

ser alterados conforme deseja o usuario.
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Figura 83 — Localizagdo dos campos com os valores (editdveis) referentes a posigdo, Rotagdo e Escala do

objeto selecionado.
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4.3.3. Comandos Importantes

Usudrios ndo familiarizados com o Blender podem ter dificuldades em ac¢des
simples e rotineiras no inicio da experiéncia com o programa. Por isso, alguns comandos
importantes sdo esclarecidos a seguir. Lembrando que o termo Elemento, utilizado
diversas vezes, compreende objetos 3D, luzes, cameras, autofalantes, textos e qualquer

outra coisa inserida no espaco virtual do programa.

Selecionar Elementos
Sabe-se que um objeto estd selecionado no Blender quando ele possui um
contorno laranja (Figura 84) ou verde quando fizer parte de um grupo. Existem

diferentes formas de selecionar um objeto isoladamente ou um conjunto de objetos:
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Figura 84 — Dentre os trés objetos da cena (cilindro, esfera e cubo) apenas o cubo esta selecionado.

e Pode-se simplesmente clicar com o botao direito do mouse no elemento
gue se deseja selecionar. Para selecionar mais de um elemento, é
necessario segurar pressionada a tecla SHIFT e clicar com o mesmo botdo

do mouse neles;

e E possivel selecionar elementos clicando-se com o botdo esquerdo do
mouse em seu nome na lista presente na janela Outliner (Figura 85), que
reuni todos os elementos presentes no espaco virtual do programa. Para
selecionar multiplos elementos, também deve-se manter pressionada a
tecla SHIFT enquanto clica-se no nome deles com o mouse;

Figura 85 — Janela Outliner (ampliada) com o elemento Esfera selecionado.
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e A Ultima maneira de selecionar elementos é segurar a tecla CTRL
pressionada e, segurando pressionado também o botdo esquerdo do
mouse, arrasta-lo para desenhar livremente uma forma que envolva a
maior parte ou por inteiro, os elementos que se pretende selecionar. Para
auxiliar na criacdo dessa forma livre o programa apresenta na tela uma
linha tempordria com o desenho que estd sendo feito com o mouse
(Figura 86).

Figura 86 — Exemplo de desenho de forma livre para selecionar, no caso, o cilindro e a esfera.
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Também é possivel retirar a selecdo de todos os elementos da cena se desejado,
bastando pressionar a tecla A do teclado. Ainda, quando nao houver nenhum objeto
selecionado, pressionar a tecla A faz com que todos os elementos presentes no espaco
virtual sejam selecionados ao mesmo tempo. Essa mesma ferramenta de desmarque ou
selecdo total, chamada (De)select All, é encontrada no menu Select, presente na barra

inferior da janela 3D View (Figura 87).
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Figura 87 — Localizagdo da ferramenta (De)select All na janela 3D View > menu Select.
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Excluir Elementos

Existe mais de uma maneira de excluir elementos do espaco virtual do programa,
porém, independentemente da forma de exclusdao, deve-se primeiro selecionar o(s)
objeto(s) que se deseja excluir.

Depois pode-se utilizar umas das trés formas de exclusao:

e Com o ponteiro do mouse dentro da janela 3D View, pressionar no
teclado a tecla DEL ou DELETE ou X mais a tecla ENTER, para confirmar a
exclusdo. Pode-se ao invés de pressionar a tecla ENTER, clicar com o
botdo esquerdo do mouse na opgao Delete do menu que se abre ao
pressionar a primeira tecla do comando (Figura 88);

Figura 88 — Menu (ampliado) para confirmagdo de exclusdo do elemento selecionado.
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e Pode-se também excluir elementos clicando no botdo Delete na janela 3D
View > menu Tools > Edit (Figura 89) e, depois, pressionando a tecla
ENTER ou clicando com o botdo esquerdo do mouse na opg¢ao Delete, no
menu que se abre na tela, para confirmar a exclusao;

Figura 89 — Localizagdo da opgdo Delete no menu lateral Tools > Edit, dentro da janela 3D View.
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e Aterceira forma de excluir elementos da cena é escolher a opcao Delete
(Figura 90) no menu Object, localizado na barra inferior da janela 3D View.
Depois, confirmar a exclusao pressionando a tecla ENTER ou clicando com
o botdo esquerdo do mouse na opgdo Delete, presente no menu
suspenso que se abre.

Figura 90 — Opgdo Delete (ampliado) no menu Object da Janela 3D View.
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Duplicar Elementos
Existem basicamente dois tipos de duplicacdo de elementos no Blender, o
Duplicate e o Duplicate Linked. Ambos criam uma cépia do(s) elemento(s) selecionados,

porém com algumas diferencas.

e Duplicate: cria uma cépia visualmente idéntica e independente do(s)
elemento(s) selecionado(s), mas todos os seus atributos (dimensdo,
material e outros) podem ser modificados sem que o elemento original
sofra qualquer alteracdo. E acessado de diversas maneiras:

- Pressionando as teclas SHIFT + D do teclado;

- Clicando na opc¢ao Duplicate, no menu Tools > Edit da janela 3D
View;

- Clicando na opc¢ao Duplicate Objects, no menu Object da barra
inferior da janela 3D View.

e Duplicate Linked: cria uma cdépia com quase todos os seus atributos
vinculados ao elemento original. Se um dos elementos (original ou cdpia)
for modificado, todos os que estiverem vinculados sofreram as mesmas
alteragdes. Destaca-se, no entanto, que as propriedades de
transformacdo permanecem independentes em cada um. Assim, é
possivel mover, rotacionar e escalar qualquer elemento sem afetar as
outras cépias. E acessado de diversas maneiras:

- Pressionando as teclas ALT + D do teclado;

- Clicando na op¢ao Duplicate Linked, no menu Tools > Edit da janela
3D View;

- Clicando na opg¢ao Duplicate Linked, no menu Object da barra
inferior da janela 3D View.

Esse segundo método de duplicacdo é utilizado também como forma de
otimizacdo de uma cena e seu uso é melhor explicado no item 4.4.1
(Otimizacdes).

Criar e Selecionar Grupos
E possivel agrupar elementos que tenham algo de semelhante para facilitar, por

exemplo, a selegdo deles em conjunto. Para isso, primeiro seleciona-se os elementos
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que fardo parte do grupo e, entao, utiliza-se os botdes localizados no menu Relations >
Group na janela 3D View (Figura 91), no menu Object > Group na barra inferior da janela

3D View (Figura 92) ou seus respectivos atalhos, de acordo com o desejado.

Figura 91 — Localizagdo das opgGes de grupos no menu Relations > Group, na janela 3D View.

4= Blender

Figura 92 — Localizagdo das opg¢des de grupos no menu Object > Group (ampliado), na barra inferior da

janela 3D View.
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e New Group (Figura 91) / Create New Group (Figura 92) (Atalho: CTRL +
G): cria um grupo com os elementos selecionados. Por padrdo ele terd o
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nome Group, que pode ser alterado no momento de sua criagdo no menu
Create New Group > Name (Figura 93), o qual se abre apds o clique no
botdao New Group ou utilizacdo do atalho;

Figura 93 — Menu para escolha do nome do grupo recém-criado.
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e Add to Active (Figura 91) (Atalho: SHIFT + CTRL + G): adiciona um
elemento selecionado a um grupo existente, quando pelo menos um
outro elemento, ja pertencente ao grupo, estiver selecionado em
conjunto com ele;

e Remove From Group (Figura 91 e Figura 92) (Atalho: CTRL + ALT + G):
remove um ou mais elementos selecionados de um grupo ao qual ele
pertence. Apds o cligue nessa opcdo, é necessario confirmar, em um
menu suspenso na tela, o grupo do qual se deseja remover o(s)
elemento(s);

e Remove From All Group (Figura 92) (Atalho: CTRL + ALT + G): remove um
ou mais elementos selecionados de todos os grupos aos quais ele(s)
pertence(m).

Para selecionar em conjunto todos os elementos de um grupo existente, basta
selecionar um deles e utilizar o atalho SHIFT + G para abrir um menu com a opg¢do Group
(Figura 94), que quando pressionada com o botdo esquerdo do mouse, seleciona todos

os demais elementos pertencentes ao grupo.
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Figura 94 — Menu suspenso que se abre ao utilizar o atalho SHIFT + G.
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No caso de o primeiro objeto selecionado pertencer a mais de um grupo, quando
escolhida a op¢ao Group no menu, outro menu suspenso surgird pedindo para o usudrio

escolher qual o grupo que ele deseja selecionar (Figura 95).

Figura 95 — Menu suspenso secundario para escolha do grupo que se pretende selecionar, no caso do

elemento selecionado estar inserido em mais de um grupo.
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Combinar Objetos

Dependendo da necessidade do usudrio, é util combinar multiplos objetos e

transforma-los em um sé ao invés de criar um grupo com eles. No Blender, é possivel
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unir diferentes objetos que, mesmo sem a necessidade de uma ligacao fisica entre eles,

passam a se comportar como se fossem um objeto Unico.

OBS: Se os objetos, quando separados, possuiam diferentes materiais

atribuidos a eles, apds a unido, mantém seus materiais separados
para edicdo futura pelo menu Material, na janela Properties.

O objeto unido fica com o nome do ultimo objeto a ser selecionado
antes do uso da ferramenta Join, podendo ser renomeado clicando
com o botdo direito do mouse em seu nome na lista presente na
janela Outliner e, depois, em Rename.

O procedimento de combinagdo é simples e inicia-se com a sele¢ao de todos os
objetos que serdo unidos. Depois, utiliza-se o botdo Join (janela 3D View > menu Tools

> Edit - Figura 96) ou o atalho CTRL +J.

Figura 96 — Localiza¢do do botdo Join na janela 3D View > menu Tools > Edit.
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Ja, para separar os objetos que foram combinados, é possivel utilizar o atalho
CTRL + Z quantas vezes forem necessarias para que a cena retorne ao estado em que os
objetos estavam ainda separados. Ha vezes, porém, em que ndo é possivel mais utilizar
o atalho CTRL + Z, pois afeta todas as altera¢des realizadas no programa. Nesses casos,
existe uma técnica com a qual é possivel separar novamente tais objetos.

Inicialmente, seleciona-se o objeto que foi unido/combinado. Depois, entra-se
no modo de edicao (Edit Mode) pelo atalho TAB ou pelo menu de sele¢ao de modos da
janela 3D View (Figura 103). Entdo, seleciona-se ao menos um vértice do objeto que se
deseja separar dos demais (Figura 97). Finaliza-se, selecionando a opgao by loose parts,
localizada na janela 3D View > menu Mesh > Vertices > Separate, quando dentro do
modo de edicdo (Figura 98). Pode-se, entdo, retornar ao modo de objeto (Object Mode)

pelo atalho TAB ou menu de sele¢cdo de modos.

Figura 97 — Vértice do cubo selecionado.
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Figura 98 — Localizagdo da opgdo by loose parts no menu Mesh > Vertices > Separate, dentro da janela

3D View em modo de edigdo.
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Movimentar a Cena (janela 3D View) com o Mouse

A principal forma de movimentar a visualizagdo da cena exibida na janela 3D
View é através dos botdes do mouse e movimentos realizados com ele dentro dessa
janela. Para isso, recomenda-se a utilizagdo de um mouse com pelo menos trés botdes
(esquerdo, central com rolagem e direito). Seguem as movimentacdes possiveis de

serem realizadas com o mouse e algumas teclas auxiliares do teclado.

e Rolagem/Zoom: utilizando a rolagem do botdo central do mouse pode-
se aproximar (para frente) ou afastar (para tras) a visualizacdo da cena.
Também ¢é possivel realizar esse movimento de zoom, segurando
pressionada a tecla CTRL mais o botdo central do mouse e, em seguida,
arrastando o mouse para frente (aproximar) ou para tras (afastar);
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Orbita: segurando pressionado o botdo central do mouse e o arrastando,
é possivel realizar um movimento de érbita, em que o visualizador
movimenta a cena como se estivesse rotacionando uma esfera ou
orbitando em sua volta;

Movendo o panorama: para simplesmente mover a visualizacdo para
cima, para baixo, para a esquerda e para direita sem orbitar em sua volta,
segura-se pressionada a tecla SHIFT mais o botdo central do mouse e,
depois, arrasta-se o mouse para qualquer lado;

Movendo o panorama em um sé eixo: E possivel mover a visualizagio
em um so eixo. Para mové-la somente para cima e para baixo segura-se
pressionada a tecla SHIFT mais a rolagem do mouse para frente (cima) ou
para tras (baixo). Ja, para mover para a esquerda e para a direita, a tecla
a ser mantida pressionada é a CTRL mais a rolagem do mouse para frente
(direita) e para tras (esquerda);

Rotacdao em um so plano: mantendo pressionadas as teclas CTRL e SHIFT
mais a rolagem do mouse, rotaciona-se a visualizacdo para a esquerda
(rolagem para frente) ou direita (rolagem para tras) em um plano paralelo
ao plano da tela;

Definir quadro de ampliagao da imagem: pode-se também aplicar um
zoom instantaneo em uma determina area da cena. Com o ponteiro do
mouse dentro da janela 3D View, pressiona-se o conjunto de teclas SHIFT
+ B e, depois, mantendo pressionado o botdo esquerdo do mouse,
desenha-se na tela um retangulo sobre da area desejada, que sera
ampliada e centralizada na janela (Figura 99).
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Figura 99 — Em cima, retangulo demarcando area para ampliagdo e embaixo area ampliada.
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Ocultar a Renderizacao de Elementos

Objetos 3D presentes no espago virtual do Blender podem estar visiveis ou
ocultos na cena final exportada com o complemento Blend4Web. Um objeto definido
como oculto, ndo serd renderizado somente durante a execucdo da cena no navegador.
Isso significa que ele ndo estara visivel, mas todas as influéncias dele no ambiente, como
reflexos, sombras, efeitos de fisica e outros, se manterdo e serdo visualizados
normalmente.

Por padrdo, todos os objetos inseridos serdo visiveis apds a exportacao. Para

desativar a visibilidade de um objeto na cena exportada, com o motor de renderizagao
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Blend4Web ativado (Figura 44), deve-se seleciona-lo e ativar a op¢cdo Do Not Render no

menu Object > Rendering Properties, dentro da janela Properties (Figura 100).

Figura 100 — Localizagdo da opgdo Do Not Render na janela Properties > menu Object > Rendering

Properties.

" Do Not Render

OBS: Para desativar a renderizacdo de mais de um objeto presente no

espaco virtual, é necessario realizar o procedimento de selecdo e
ativacao da opgdo Do Not Render separadamente para cada um
deles. A selecdo de um conjunto de objetos e ativacdo dessa opgao
uma Unica vez desativa somente a visibilidade do ultimo objeto
selecionado do conjunto.

Bloquear a Exportacao de Elementos
Além de ocultar um elemento na visualizagao do arquivo final exportado, pode-
se fazer com que elementos ndo sejam exportados junto com o resto do ambiente

virtual. Um objeto 3D, camera, luz ou outro pode ter sua exportacdao desativada,
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primeiro o selecionando e, depois, ativando a opc¢ao Do Not Export, encontrada na

janela Properties > menu Object > Export Options (Figura 101).

Figura 101 — Localizagdo da opgdo Do Not Export na janela Properties > menu Object > Export Options.

+ Do Not Export

OBS: Para desativar a exportacdo de mdltiplos elementos inseridos no
espaco virtual, é preciso realizar o procedimento de selecdo e
ativacdo da opcao Do Not Export em separado para cada um deles. A
selegdao de um conjunto de elementos e ativagdo da opgao uma Unica
vez desativa somente a exportagdo do ultimo objeto selecionado do
conjunto.

4.4. OBTENGCAO E OTIMIZACAO DE MODELOS 3D

Os objetos tridimensionais preenchem o espaco virtual e sdo os principais

elementos dos Ambientes 3D Virtuais e os primeiros a serem inseridos na cena.
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Dependendo da necessidade e propdsito, eles podem ser obtidos ja prontos, por meio
da internet, por exemplo, ou modelados do zero através de softwares especificos.

Em se tratando da aquisicao de objetos pela internet, existem diversos bancos
de modelos 3D onde é possivel encontrar variados tipos de objetos, gratuitos e pagos,
em diversos formatos de arquivo. Destacam-se os de maior popularidade, diversidade e
nimero de modelos:  TurboSquid  (http://www.turbosquid.com), Free3D
(https://free3d.com/), 3D Warehouse (https://3dwarehouse.sketchup.com), GrabCAD
(https://grabcad.com/library), Thingiverse (http://www.thingiverse.com/), Archive 3D
(http://archive3d.net/) e Clara.io (https://clara.io/library).

Todos os referidos acima possuem uma grande quantidade de modelos gratuitos
e é necessario atentar apenas para os formatos de arquivos disponiveis para cada
modelo, que devem ser um dos suportados pelo Blender para importacao: Collada
(.dae), Alembic (.abc), 3D Studio (.3ds), FBX (.fox — em suas versGes mais recentes),
Motion Capture (.bvh), Stanford (.ply), Wavefront (obj.), X3D Extensible 3D (.x3d/.wrl),
STL (.stl), Scalable Vector Graphics (.svg). O processo especifico de importacdo de
modelos no Blender se dé pelo menu Import, localizado na barra Info > File. Nele, deve-
se escolher o formato do arquivo que se pretende importar para entdo abrir uma nova
janela onde é possivel buscar no computador o arquivo desejado.

Quanto a criacdo integral de objetos 3D, pode-se realiza-la no préprio Blender
ou em outro software de modelagem tridimensional que possibilite a exportacdao de
modelos em um desses formatos. Entre eles, 3ds Max, SolidWorks, Sketchup, AutoCAD,
Maya, Rhinoceros, Modo, Inventor, Cinema 4D, Zbrush e tantos outros servem como
fornecedores de inputs (entradas) e podem atuar paralelamente a este processo de
construcdo de ambientes 3D virtuais. Destaca-se, no entanto, que o ensino acerca do
processo de modelagem e atribuicdo de materiais nesses e em outros programas nao

faz parte desta sistematica.

4.4.1. Otimizagdes

Existem algumas praticas com relagdo aos modelos 3D criados ou importados no
Blender que podem otimizar o desempenho dos ambientes virtuais exportados. Assim,

isso exige menos capacidade de processamento dos dispositivos utilizados para a
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visualizacao do conteldo e diminuindo o tamanho do arquivo final. Os quatro tipos de
otimizacdo (Suavizacao de Superficies, Edicdo de Texturas, Duplicacdo Ligada e Niveis de
Detalhes) fazem parte do Capitulo 1 do livro ‘Ambientes Virtuais 3D Interativos’ entre as

paginas 65 e 72.

4.5. MATERIAIS E TEXTURAS

Os materiais virtuais buscam ter propriedades e funcionamento préximos aos de
materiais do mundo fisico. Ambos, descrevem a resposta da superficie de um objeto a
luz e também contém informacgdes sobre sua transparéncia, refletividade, parametros
fisicos e assim por diante.

As texturas de objetos virtuais também funcionam de forma semelhante as
texturas de objetos fisicos. Elas sdo imagens aplicadas as superficies dos objetos virtuais
e trabalham em conjunto com as caracteristicas dos materiais atribuidos a eles.
Tecnicamente, os pixels da imagem sdo atribuidos aos pontos da superficie do objeto
usando um mapeamento de textura. Por essa razao, as vezes sao chamadas de mapas.

O conjunto de programas Blender + Blend4Web possui uma grande variedade
de parametros para configuracdo de materiais e texturas. Os procedimentos basicos
para a criacao deles e aplicagdo em objetos 3D que possuam apenas materiais e texturas

simples estdo presentes no Capitulo 1 do livro no intervalo entre as paginas 72 e 90.

4.6. INSERCAO DE ELEMENTOS (LUZES, CAMERAS, SONS, TEXTOS E
ANOTAGOES)

Luzes e cameras sdo elementos essenciais em um ambiente virtual 3D, porque
sdo responsaveis pela iluminacdo e captura da cena, respectivamente. Ja os sons, o0s
textos e as anotagdes, mesmo ndo sendo fundamentais, ndo deixam de ser importantes
para a experiéncia de visualizagdo de muitos cenarios interativos.

O processo de insercao e configuracao bdsica desses elementos no espaco virtual

do Blender é apresentado entre as paginas 93 e 106 do livro (PERGHER; AYMONE, 2017).
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4.6.1. Luzes (Lamp)

Ailuminacdo de um ambiente prové dos diferentes tipos de luzes presentes nele,
também chamadas de lampadas. Os quatro tipos de luzes do Blender, que sdo
suportados também pelo Blend4Web (Point, Spot, Sun e Hemi - Figura 102), estdo
explicados em detalhes no Capitulo 2, pagina 93 a 96, do livro ‘Ambientes Virtuais 3D

Interativos’.

Figura 102 — Os quatro tipos de luzes do Blender suportados pelo Blend4Web. (A) Point, (B) Spot, (C) Sun

e (D) Hemi.
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4.6.2. Cameras (Camera)

O elemento camera é essencial para uma cena virtual. Todo o conteldo
referente a sua insergdo e configuragdo esta no livro ‘Ambientes Virtuais 3D Interativos’
(Capitulo 2 - pagina 96 a 99). Também no livro, hd uma explicacdo sobre a técnica de

fixagcdo de elementos em relagdo a camera (p. 100 e 101).

4.6.3. Sons (Speaker)

Basicamente, os sons no Blender podem ser de dois tipos: Positional Sound,
quando o som é emitido de uma posi¢do especifica do espacgo virtual, onde é mais
intenso, e Background Sound/Music, quando o som é projetado para todas as dire¢des
com a mesma intensidade. A adigdo de sons no ambiente virtual do Blender acontece
através do elemento Speaker (Autofalante em inglés) e os detalhes sobre ele se
encontram no Capitulo 2 do livro ‘Ambientes Virtuais 3D Interativos’, nas paginas 101,

102 e 103.

4.6.4. Textos (Text)

O Texto é um elemento de natureza bidimensional, entretanto pode ganhar uma
terceira dimensdo pelo processo de modelagem 3D virtual chamado Extrude (Extrusdo
em inglés). As instrucdes de como criar um texto no Blender, através do elemento
chamado Text (Figura 103), estdo nas paginas 103 e 104, do capitulo 2 do livro

‘Ambientes Virtuais 3D Interativos’.
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Figura 103 — Elemento Text, com texto padrao, sendo editado no Blender.
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4.6.5. Anotacdes (Anchor)

O recurso Anchors pode ser usado para anexar anotacdes a objetos 3D (Figura

104). Seu uso é melhor explicado nas pdaginas 105 e 106 (Capitulo 2) do livro ‘Ambientes

Virtuais 3D Interativos’.

Figura 104 — Exemplo de aplicagdo de anotag¢des aos elementos do ambiente virtual.

Mercury

Orbit.period: 365 days 6 hours
Rot.period: 23 hours 56 minutes
Mass: 5,9726-10%%g
Temperature: 22°C

‘ Satellites: 1

Fonte: BLEND4WEB (2016).
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4.7. CONFIGURAGAO DO AMBIENTE

As configuracdes do ambiente que envolve o cenario sdo inerentes ao espaco
virtual e, por isso, ndo estdo atreladas a nenhum elemento especifico. Elas definem
diversas caracteristicas do plano de fundo da cena e de sua iluminacdo. Em separado
estdo as opgdes que ativam e ajustam as sombras e os reflexos. Estes elementos trazem
maior realismo ao ambiente virtual, transmitindo informacdes sobre a posicdo dos
objetos e das fontes de luz. O conteudo do Capitulo 3 do livro ‘Ambientes Virtuais 3D

Interativos’ é destinado inteiramente a este assunto.

4.7.1. Céu (Sky)

O céu é basicamente o plano de fundo do espago virtual. E assim chamado, pois
gera um degradé que simula um verdadeiro céu e linha do horizonte. Nao é um
elemento que precise ser inserido ou criado, apenas tem de ser ativado e configurado,
segundo algumas propriedades bdsicas.

Dois tipos de céus sao apresentados e detalhados no livro ‘Ambientes Virtuais
3D Interativos’ (pagina 109 a 111), o Céu Simples e o Céu Procedural. Este ultimo
também habilita a visualizacdo de uma espécie de sol (Figura 105) que aparece em uma

posicao predefinida, mas que pode ser alterada com a insergao de uma luz do tipo Sun.

Figura 105 — Céu do tipo Procedural com simulagdo de sol.
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4.7.2. Sombras (Shadows)

As sombras (Figura 106) sdo importantes para um ambiente virtual realistico,
contudo forcam a realizacdo de muito calculos em tempo real para que o efeito seja
exibido na tela. Por isso, alguns dispositivos podem ter dificuldades para executar de
forma fluida um ambiente com grande nimero de sombras projetadas, sendo
necessdria a realizagdo de ajustes em suas configuragdes visando maior fluidez na
visualizacdo do ambiente posteriormente, no navegador web. Todo o conteudo da
sistematica sobre as sombras estd entre as paginas 111 e 114 do livro ‘Ambientes

Virtuais 3D Interativos’.

Figura 106 — Sombras projetadas pela coroa, célice e dados em um outro objeto.

4.7.3. Reflexos (Reflections)

Assim como as sombras, os reflexos (Figura 107) ndo sao essenciais para que um
ambiente virtual exista, mas também proporcionam uma maior sensacdo de realismo
para a cena. A configuragdao deste recurso se encontra nas paginas 114 a 117 do livro

‘Ambientes Virtuais 3D Interativos’.
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Figura 107 — Pré-visualizagdo, no Blender, de um material com alto grau de refletividade.

4.8. EFEITOS AO AR LIVRE (OUTDOOR EFFECTS)

Existem também alguns recursos adicionais denominados Outdoor Effects
(Efeitos ao ar livre em traducao literal) que conferem ainda mais realismo adicionando,
por exemplo, névoa, superficies de dgua, vento, estrelas e emissdo de particulas para
simular chuva, neve fumacga, etc. Estes efeitos compdem o Capitulo 4 (p. 121 a 140) do

livro ‘“Ambientes Virtuais 3D Interativos’.

4.8.1. Névoa (Mist)

O Mist, também chamado de Fog, é um recurso existente desde de tecnologias
anteriores, como o VRML. Ele serve para simular uma névoa ou neblina que paira sobre
a cena (Figura 108). E seu funcionamento é explicado nas pdginas 121 e 122 do livro

‘Ambientes Virtuais 3D Interativos’.

Figura 108 — A Mist faz com que a cena perca visibilidade a medida que se afasta a camera dela, devido a

névoa que fica cada vez mais densa.

V‘
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4.8.2. Agua (Water)

O Blend4Web possibilita também a criacdo de uma simulacdo animada de agua
aplicada na forma de um material a um objeto (Figura 109), geralmente um Plane (Plano
em inglés). Sendo ideal para a simulacdo de amplas superficies de agua ao ar livre

(oceano, lago...).

Figura 109 — Simulagdo de dgua gerada a partir do recurso Water.

Também, através de outra técnica, pode-se criar facilmente um efeito estatico
de dgua com ondas aplicado a um plano de dimensdes definidas, que ndo se estende
até o infinito. Ele pode ser posicionado no local pretendido simulando a superficie da

agua em reservatérios como uma piscina, por exemplo (Figura 110).

Figura 110 — Exemplo de efeito de dgua estatico aplicado em uma piscina virtual.
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Os dois tipos de simulacdo de dgua sdo detalhados no livro ‘Ambientes Virtuais

3D Interativos’, entre as pdginas 122 e 129.

4.8.3. Emissao de Particulas (Particles Emitter)

O Sistema de emissdo de particulas destina-se a criar uma simulacdo de
fendmenos causados pelo movimento de um grupo de objetos pequenos (particulas)
como fumaca, chuva, folhas caindo e tantos outros (Figura 111). Para que o efeito
aconteca, é necessario um emissor, um objeto tridimensional ou um plano, que definira
a localizacdo e a direcdo do fluxo de saida das particulas.

Ainser¢do dos elementos necessarios e a configuragdo do recurso de Emissao de
Particulas sdo explicadas da pagina 130 a 135 do livro ‘Ambientes Virtuais 3D

Interativos’.

Figura 111 — Exemplo de aplicagdo do efeito emissdo de particulas (neve caindo sobre vilarejo).

4.8.4. Vento (Wind)

Outro efeito muito interessante é o Wind que, quando presente na cena, simula

a acdo do vento em ambiente externo ou interno, funcionando mais ou menos como
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um ventilador (Figura 112). Esse vento criado afeta outros elementos interagindo com
o movimento de objetos com o recurso Wind Bending (ndo detalhado nesta sistematica)
ativado, com a dinamica do sistema de particulas deslocando as particulas emitidas e
com a dindmica das ondas (Waves) do recurso Water.

Nas paginas 136 e 137 do livro ‘Ambientes Virtuais 3D Interativos’ estdo as
instrucdes de uso deste recurso, que, como ja explicado, pode ser combinado com

outros, dependendo da intengdo do criador do ambiente virtual.

Figura 112 — Exemplo de utilizagdo do recurso Wind na simulagdo de uma bandeira ao vento (3 quadros

da animacdo).

4.8.5. Estrelas (Stars)

Algo que pode ser util em cenarios representados a noite é a criagdo de um céu
estrelado (Figura 113). Ele pode ser facilmente criado utilizando-se um tipo diferente de
material aplicado a um objeto 3D que envolva a cena. A técnica de utilizagdo deste
recurso é apresentada entre as paginas 137 e 140 do livro ‘Ambientes Virtuais 3D

Interativos’.

Figura 113 — Exemplo de céu estrelado circundando a cena composta por um cubo.
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4.9. CRIAGAO DE ANIMAGCOES

O Blend4Web suporta alguns tipos de animacdes, entre elas a ja referida Emissao
de Particulas (item 4.8.3). A Animacgao de Objetos, a Animagao de Vértices e a Animagao
por Seguimento de Caminho sdo outros exemplos em conjunto com um processo de
animagado, utilizando-se o recurso de efeitos de fisica de corpos rigidos do Blender.
Também é abordado o efeito chamado Object Outlining, que aplica um contorno
luminoso e animado ao redor de objetos. As animac¢fes de esqueletos, de fontes de
audio e de alteracdo de valores de materiais, apesar de serem suportadas pelo Blender
e Blend4Web, ndo atendem aos requisitos estipulados previamente e ndo sdo
comtempladas por esta sistematica.

O conteldo sobre animacdes na integra constitui o Capitulo 5 (p. 143 a 174) do

livro ‘Ambientes Virtuais 3D Interativos’.

4.9.1. Animacao de Objetos (Object Animation)

Em geral, uma animagdo ocorre quando parametros de um objeto sdo
modificados ao longo do tempo. A Animacao de Objetos é utilizada quando o objeto é
transformado como um todo, por exemplo, quando ele se desloca inteiramente de um
lugar para o outro (Figura 114) ou quando é rotacionado ou escalado, sem sofrer
deformacdo que modifique a sua malha. Todos os passos para criacdo deste tipo de
animacgoes estdo também no livro ‘Ambientes Virtuais 3D Interativos’, entre as paginas

143 e 147.

Figura 114 — Dois quadros de uma animagdo de objetos simulando um pér do sol através da alteragdo da

localizagdo da luz do tipo Sun ao longo do tempo.
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4.9.2. Animacdo de Vértices (Vertex Animation)

Enquanto a Animacdo de Objetos grava os estados do objeto por inteiro,
conforme sua Localizagdo, Rotacdo e Escala por meio dos Keyframes, a Animacao de
Vértices grava alteracdes em sua geometria. Nesse caso, cada quadro da animacdo é
constituido por uma malha do objeto em um estado de transformacao distinto. Devido
a isso, ndo é recomendado fazer uma longa animacdo desse tipo com objetos de
geometria muito detalhada, uma vez que pode aumentar bastante o tamanho do
arquivo final e a necessidade de processamento do hardware. A simulagdo de uma
bandeira que balanca ao vento ou de um tecido que cai sobre um objeto e se deforma
(Figura 115) sdo dois exemplos de animagdes possiveis com alteragao de malha.

O processo de desenvolvimento de animacdes de vértices é explicado no
intervalo da pagina 147 a 159 do livro ‘Ambientes Virtuais 3D Interativos’. Nesta parte
ainda ha a apresentacdo de relevantes técnicas, como a inser¢do de imagens como

planos e a definigao de pontos de fixagdao de tecidos simulados.

Figura 115 — Quadros de uma animagao simulando tecido, utilizando a animacgao de vértices.

4.9.3. Animacdo de Seguimento de Caminho (Path Animation)

Este € um tipo de animacdo bastante comum nos softwares de animacao
tridimensional desde de tecnologias de representagdo passadas, como o VRML. Consiste
em fazer com que um ou mais objetos percorram um caminho definido por uma linha

ou curva (Figura 116). O processo de criagao de animagdes de objetos que se deslocam
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por uma curva é simples e, no livro ‘Ambientes Virtuais 3D Interativos’, vai da pagina

160 a 166.

Figura 116 —Uma bola e um caminho (curva), pelo qual ela percorrera por meio da animagdo de

seguimento de caminho.

4.9.4. Animacao de Efeitos de Fisica (Physics)

Esse tipo de animacao simula efeitos simplificados de fisica de colisdo de corpos
rigidos sob o efeito da gravidade (Figura 117). Destaca-se, contudo, que apesar da
geracdo de simulagdes desse tipo a partir das ferramentas do Blend4Web ndo exigir
grandes esfor¢os e elas serem devidamente visualizadas dentro do Blender e pelo
recurso Fast Preview, os desenvolvedores do complemento Blend4Web optaram pela
ndo incorporacdo dessas simulagdes junto aos demais elementos no arquivo HTML
unico, quando exportado. Com isso, caso se deseje criar efeitos de fisica que sejam
manipuldveis durante a execu¢dao do ambiente no navegador, é necessario exportar o
ambiente no formato JSON e realizar os procedimentos necessarios de incorporacao
dele e do motor grafico em um arquivo HTML. Esse processo, além de gerar mais de um
arquivo final necessario para visualizacdo, também exige certo conhecimento prévio de
programacao HTML e, por isso, ndo é tratado aqui.

Para solucionar essa questdao sem eliminar inteiramente as possibilidades de uso

dos efeitos de fisica que o conjunto de programas disponibiliza, existe uma forma de
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transformacdo dessas simulacdes em animac¢des mais comuns, menos flexiveis,
compostas por keyframes. Esta técnica de geracdo da animacdo de efeitos de fisica e
conversdo dela em uma animacdo de objetos estd relatada no livro ‘Ambientes Virtuais

3D Interativos’ entre as paginas 167 e 171.

Figura 117 — Quadros da animagdo de um cubo e uma esfera caindo e colidindo em um plano.

@

4.9.5. Contorno de Objetos (Object Outlining)

O Blend4Web possui um recurso chamado Object Outlining, que aplica um
contorno colorido e luminoso que pisca ao redor de um determinado objeto. Pode ser

util para indicar que determinado objeto da cena é clicdvel (Figura 118), por exemplo.
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Este é mais um recurso opcional, mas que pode ser Util dependendo do ambiente
e das interacGes em desenvolvimento. Ele é descrito por completo da pagina 171 a 174

do livro ‘Ambientes Virtuais 3D Interativos’.

Figura 118 — Vasos em cima da mesa possuem um contorno que os realga, indicando que algo

acontecera caso sejam clicados pelo usuario.

4.10. CRIACAO DE INTERACOES

O sistema facilitado de desenvolvimento de interagdes trazido pelo
complemento Blend4Web a linguagem de blocos ja presente no Blender é um dos
grandes diferenciais deste conjunto de programas. Apesar de existirem outros softwares
com propostas semelhantes e que também utilizam linguagens visuais, este nao exige
nenhum conhecimento prévio de programacdo computacional para criacdo de

interacdes de variadas complexidades (Figura 119).
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Figura 119 — Exemplo de interagdo simples representada de trés diferentes formas. De cima para baixo,
conjunto de blocos da linguagem utilizada nos programas, diagrama simplificado do conjunto de blocos
(cinza) com ag¢des do usudrio e, por ultimo, diagrama com as ag¢des literais de cada bloco (cinza) e do

usudrio.
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4.10.1. Acesso ao Node Editor

Toda a construcdo das interagdes por meio da linguagem de blocos se da na
janela Node Editor (Figura 56) e é possivel acessa-la de trés maneiras, podendo ser
utilizada qualquer uma destas trés formas para acessar as outras janelas apresentadas

no item 4.3 (Interface Geral).
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1. O primeiro jeito de acessar a janela Node Editor é clicando no botdo Area
Type, localizado sempre em um dos cantos de cada janela do Blender e
representado por duas setas (uma para cima e outra para baixo) mais o
icone correspondente a janela que estd ativa (Figura 120). Assim, abre-se
um menu para escolha da janela Node Editor que substituira a janela ativa
naquele local;

Figura 120 — Selec¢do da janela Node Editor pelo menu de janela ativa, acessado pelo icone Area Type no

canto inferior esquerdo da janela 3D view.
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2. Asegunda forma de acesso a Node Editor é manter clicado e arrastar para
um dos lados o botdo triangular representado por trés linhas diagonais,
localizado também em um dos cantos de todas as janelas do Blender
(Figura 121) e muitas vezes ao lado do botdo Area Type. Isso faz com que
uma cépia da respectiva janela ativa se crie ao seu lado sem substitui-la.
Depois, é so utilizar o primeiro método explicado para entdo alterar uma
das duas janelas idénticas para a Node Editor;

Figura 121 — Indicagdo do botdo utilizado para abertura de uma nova janela.
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3. J4, o terceiro método é uma variagdo do segundo. Ao invés de apenas
clicar e arrastar o botdo triangular (Figura 121), pressiona-se ao mesmo
tempo a tecla SHIFT, fazendo com que uma cépia da janela se abra
separada das demais do programa, tornando-se independente (Figura
122) e podendo ser disposta onde parecer mais adequado ao usuario, até
mesmo em um segundo monitor, se for o caso. O passo seguinte é
também alterar a janela criada para a Node Editor como no primeiro
método.

Figura 122 — Janela Node Editor criada separada das demais.

4.10.2. Arvore de N6s (Node Tree)

Os blocos, também chamados de Nos, utilizados para a criagdo da ldgica das
interacdes sdo dispostos em uma Node Tree (Arvore de Nés em inglés), podendo existir

mais de uma em um mesmo projeto, mas apenas uma pode estar ativa por vez.

1. A primeira coisa a se fazer é clicar no icone Add new logic node tree (sinal
de “+”), em Properties > menu Scene > Logic Editor > Active Node Tree
(Figura 123), para criar uma nova Arvore de Nés, denominada por padréo
B4WLogicNodeTree;
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Figura 123 — Local de criagdo da Arvore de Nés.

2. Antes de comegar a inserir os blocos na Arvore de Nds criada, deve-se
torna-la ativa na janela Node Editor. Para isso, seleciona-se o botdo
Blend4Web logic, presente na barra inferior da janela Node Editor e, em
seguida, clica-se no botdo denominado Browse Node Tree to be linked do
lado esquerdo do botdo New. Um menu sera aberto com a Arvore de Nés
criada anteriormente (Figura 124). Selecionando-a aparecera na area de
edicdo da janela Node Editor o primeiro e indispensavel bloco chamado
Enter Point (Ponto Inicial) (Figura 125). Apds esse procedimento, esta
tudo pronto para inserir novos blocos e formar as légicas das interacdes
desejadas.

Figura 124 — Local de ativagdo da Arvore de Nés na janela Node Editor.

Browse Node Tree to be linked

Blend4Web logic
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Figura 125 — Janela Node Editor ja com o bloco de Ponto Inicial.
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4.10.3. Blocos/Nés (Nodes)

Com a Arvore de Noés criada e ativa, pode-se comegar a inserir na area de
trabalho da janela Node Editor os blocos necessarios para a criacdo das logicas de
interagdao. Os blocos disponiveis estdo divididos em submenus (Figura 126), agrupados
conforme seus propdsitos. Com excecdao de alguns poucos blocos que exigem
conhecimentos mais avancados do que os pretendidos para esta sistematica, cada bloco
serd apresentado individualmente antes da explanagao sobre as relagGes possiveis entre

eles e a construcdo das interacdes propriamente ditas (item 4.10.4).

OBS: Conforme novas versdes do Blend4Web s3o langadas é possivel que

os blocos sejam reorganizados em outros submenus que ndo os
apresentados aqui. Também é possivel que novos blocos, com novas
fungdes, sejam adicionados no futuro. Lembrando que a versao
utilizada aqui foia 17.08.
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Figura 126 — Menu de adi¢do de blocos divido em submenus (Atalho: SHIFT + A).
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OBS: Os alertas presentes nas imagens de alguns blocos, representados

por um sinal de exclamacdo dentro de um triangulo amarelo, indicam
e descrevem acdes necessdrias dentro de cada bloco. Eles somem
assim que o bloco em questdo estiver devidamente configurado.

Além disso, os pontos amarelos presentes nas margens esquerda e
direita dos blocos sdao os pontos de entrada (esquerda) e de saida
(direita) de dados do bloco, servindo também para a ligacdo com os
demais blocos. Essa ligacdo é realizada por meio de “fios” que se
ligam a esses pontos e serao melhores explicados na sequéncia.

Ainda, para o entendimento pleno do funcionamento das interacdes como um
todo é preciso compreender o que é uma Varidvel (Variable) no campo da programacao,
termo repetido diversas vezes na descricdo dos blocos a seguir. Pode-se imaginar que a
memoaria de um computador é composta por diversos espacos de armazenamento,
assim como um grande arquivo com varias gavetas. Uma varidvel pode ser entendida
como uma dessas “gavetas”, podendo cada uma guardar apenas um dado (nesse caso,
um numero ou uma sequéncia de caracteres). Essas varidveis precisam ser criadas ao
longo da programacado e identificadas com um nome, que é utilizado para indicar ao
computador a variavel a ser acessada em determinado momento. Se chamam varidveis
porque, em geral, os dados nelas contidos podem ser alterados e armazenados
novamente conforme for necessario (MANZANO; OLIVEIRA, 2005, p. 24 e 25).

Dentro do menu de adicdo de blocos (Figura 126), o submenu Control Flow

(Controle de Fluxo em inglés) agrupa os blocos relacionados diretamente com o controle
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do fluxo da execugdo dos procedimentos de légica. Possui quatro blocos com func¢des

distintas, porém o JS Callback ndo sera aqui explorado por motivos ja esclarecidos.

e Entry Point (Ponto Inicial - Figura 127):

E utilizado apenas para determinar o local onde a légica é iniciada e,
por esse motivo, é o Unico que ndo suporta entrada de dados, somente
saida (Next);

E necessério a presenca de pelo menos um Entry Point, mas é possivel
adicionar quantos forem necessdrios, um para cada procedimento de
légica criado dentro da Arvore de N&s;

Sua propriedade Run From Script ndo é relevante aqui.

Figura 127 — Bloco Entry Point (Ponto Inicial).

e Switch Select (Interruptor de Selegdo - Figura 128):

Pode ser utilizado para determinar que um ou mais objetos presentes
na cena possam ser clicados, criando um ponto de saida para cada um
com o nome do objeto mais a palavra Hit (Ex.: Cube Hit). O que estiver
apos esse ponto de saida sera executado caso o objeto seja clicado, ja
0 que estiver apds o ponto de saida Miss sera executado quando
nenhum objeto listado no bloco for clicado;

Para que a execucdo se mantenha dentro desse bloco enquanto os
objetos nele determinados ndo sejam clicados, deve-se utilizar o
chamado Reroute, encontrado em Add > Layout > Reroute. Os
Reroutes, explicados em detalhes na sequéncia, sdao pontos de ligacao
gue podem ser adicionados fora dos blocos e, nesse caso, utilizados
para se criar um caminho de retorno do ponto de saida Miss até o
ponto de entrada Previous.
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Figura 128 — Bloco Switch Select (Interruptor de Sele¢do) e caminho de retorno com pontos Reroute.

Conditional Jump (Pulo Condicional - Figura 129):

Pode ser utilizado para realizar a verificagdo de uma condigdo que,
caso seja verdadeira, da seguimento a execug¢ao pelo ponto de saida
True e, caso seja falsa, da seguimento pelo ponto de saida False;

Na opcdo Condition, é possivel definir a condicdo que deve ser
atendida entre os valores determinados para que a relacdo seja
considerada verdadeira. As condi¢gdes sao as seguintes: Igual (=),
Diferente (!=), Menor que (<), Maior que (>), Menor ou igual que (<=)
e Maior ou igual que (>=);

Os valores utilizados na relagdo segundo a condicdo escolhida sao
determinados nos operadores Operand1 e Operand2, podendo um ou
até mesmo os dois serem substituidos por valores presentes em
variaveis anteriormente criadas. Para isso, basta ativar a opgao
Variable no operador e selecionar a variavel desejada;

Ativando a opcao String Operands, é possivel relacionar textos, que
também podem ser guardados em variaveis, ao invés de nimeros;
Com esse bloco, pode-se também utilizar a técnica do Reroute, a
mesma do bloco Switch Select, para o caso de o resultado ser falso
(False), fazendo com que a execugado retorne até um bloco anterior, se
assim for o desejado.



153

Figura 129 — Bloco Conditional Jump (Pulo Condicional).

Equal (=) v

O submenu Animation (Animagdo em inglés) redne os blocos relacionados as
animacodes presentes na cena. Possui quatro blocos, porém serao aqui explorados sé os
dois que trabalham individualmente com as animag¢bes dos objetos e emissdes de
particulas. Os demais blocos controlam animagdes NLA e, como elas ndo sdo

aprofundadas nesta sistematica, eles também ndo tém suas fungbes descritas aqui.

e Play Animation (Reproduzir Animagao - Figura 130):

- Pode ser utilizado para dar inicio a reprodugdao de uma animagdo de
determinado objeto;

- A opgdo Environment Anim. ndo é relevante aqui;

- Clicando na barra abaixo de Object, escolhe-se em uma lista o objeto
gue possui a animacao que se pretende iniciar;

- Em Anim. Name, se especifica 0 nome da animagao a ser reproduzida
no caso de o objeto em questdo ter mais de uma animagao atrelada a
ele ou no caso de animacgao de emissao de particulas, onde é colocado
o nome do sistema de particulas ao qual se pretende dar inicio (Ex.:
ParticleSystem, ParticleSystem 2);

- Em Behavior, define-se o comportamento da reproducdo da animacgao
qgue pode ser: Finish Stop, quando o objeto animado se mantém em
seu estado final apds o término da reproducao; Finish Reset, quando o
objeto animado retorna a posicdao inicial apés o término da
reproducao; Loop, quando a reproducdo se repete indefinidas vezes
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automaticamente até que seja determinada sua parada com um bloco
posterior;

- A Ultima opcdo (Do Not Wait), quando ativada, determina que a

execuc¢do dos blocos subsequentes ocorra mesmo que a animagao ali
configurada ainda ndo tenha terminado;

- Ressalta-se que um bloco Play Animation deve ser adicionado para

cada objeto animado da cena quando se desejar iniciar cada animacao.

Figura 130 — Bloco Play Animation (Reproduzir Animac3o).
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Stop Animation (Parar Animacao - Figura 131):

- Pode ser utilizado para interromper a reproduc¢ao de uma animagao
de determinado objeto;

- A opcdo Environment Anim. ndo é relevante aqui;

- Assim como em Play Animation, a barra abaixo de Object serve para
selecionar o objeto com a animagdo que se pretende parar;

- Aopcao Set First Frame faz com que o objeto volte ao seu estado inicial
(primeiro quadro) assim que é interrompida a animagao.
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Figura 131 — Bloco Stop Animation (Parar Animagao).

No submenu Camera (Camera em inglés) encontram-se os blocos que realizam

alteracdes nas cameras da cena. Possui somente trés blocos que alteram a posicao, o

estilo de movimentacgdo e os limites dessas camaras.

Move Camera (Mover Camera - Figura 132):

Pode ser utilizado para mover uma camera de sua posi¢ao original até
o centro de um objeto determinado e direcionar seu foco para outro.
O movimento gerado é o resultado de uma interpolacdo suave entre o
estado inicial e o final;

Mesmo que o Blend4web ndo oferega nenhum recurso de troca entre
cameras durante a visualizagao, nem mesmo sendo possivel exportar
mais de uma cadmera, com esse bloco é possivel simular a presenga de
multiplas cameras no ambiente. Basta determinar diferentes pontos
para aonde a camera ira e diferentes focos, utilizando um bloco para
cada diferente movimentacdo. Pode-se ainda utilizar outros objetos da
cena como “gatilhos”, através do bloco Switch Select, para o
acionamento dos blocos Move Camera;

Em Camera, escolhe-se a cdmera que serd movida;

Em Destination, define-se um objeto que terd a sua posi¢cdo copiada
pela cdmera. As coordenadas da cdmera serdo as mesmas do objeto
escolhido apds o término do movimento;

Em Look at, seleciona-se o objeto para o qual a camera estara
apontada depois de ser movida;
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Ja em Duration, define-se o tempo (em segundo) que a camera levara
para realizar a movimentacdo. Quando definido para 0 (zero), a
camera simplesmente muda sua posicdo do inicio para o fim sem
nenhum estado intermediario. Pode-se ainda utilizar o valor de alguma
varidvel para determinar esse tempo, basta selecionar a opc¢do
Variable e escolher a varidvel desejada.

Figura 132 — Bloco Move Camera (Mover Camera).
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Set Camera Move Style (Definir Estilo de Movimento da Camera - Figura
133):

Pode ser utilizado para alterar o estilo de movimento de uma camera;
Em Camera, escolhe-se a camera que terd o seu estilo de
movimentacao alterado;

Em New Camera Move Style, define-se o estilo de movimentacdo que
a camera escolhida adotard quando a programagdo passar por esse
bloco. E possivel escolher entre os quatro estilos (Hover, Eye, Target,
Static) da se¢do 4.6.2 (Cameras);

As demais opcbdes desse bloco variam conforme o estilo de
movimentacdo selecionado. Para o estilo Static ndo ha nenhuma
configuragdo adicional.

Quando presentes, as demais opg¢des configuram a velocidade
(Velocities) e o ponto alvo da camera (Pivot ou Target). Para Pivot e
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Target é possivel selecionar um objeto ao invés de coordenadas,
utilizando a opc¢ao Use Object.

Ha também a possibilidade de se utilizar valores guardados em
variaveis para as propriedades desse bloco. Basta selecionar a opgao
Variable ao lado da propriedade desejada.

Figura 133 — Bloco Set Camera Move Style (Definir Estilo de Movimento da Camera).
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Set Camera Limits (Definir Limites de Camera - Figura 134):

Pode ser utilizado para definir os limites de movimenta¢ao de uma
camera;

Em Camera, escolhe-se a cdmera para a qual se definiram limites de
movimentacgao;

As propriedades restantes podem ser ativadas ou desativadas
conforme o desejado. Seus valores definem os limites de
movimentagdo, segundo os parametros do recurso de limitagdo do
movimento de cameras, encontrados na janela Properties > menu
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Camera > submenu Camera Move Style > Camera Limits e
apresentados no item 4.6.2 (Cameras):

Distance Limits: define os valores do parametro Distance
Limits para as cameras com estilo de movimentacdao do
tipo Target e Hover;

Hor. Rotation Limits: define os valores do parametro
Horizontal Rotation Limits para as cameras com estilo de
movimentagao do tipo Target e Eye;

Vert. Rotation Limits: define os valores do parametro
Vertical Rotation Limits para as cameras com estilo de
movimentacado do tipo Target, Hover e Eye;

Pivot Translation Limits: define os valores do parametro
Pivot Translation Limits para as cameras com estilo de
movimentacado do tipo Target;

Hor. Translation Limits: define os valores do parametro
Horizontal Translation Limits para as cameras com estilo
de movimentacgao do tipo Hover;

Vert. Translation Limits: define os valores do parametro
Vertical Translation Limits para as cameras com estilo de
movimentacado do tipo Hover;
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Figura 134 — Bloco Set Camera Limits (Definir Limites de Camera).
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O submenu Object (Objeto em inglés) traz uma série de blocos que trabalham a
visibilidade, movimentacao, transformacdes e materiais de objetos dentro da linguagem
visual. Possui oito blocos, porém dois (Apply Shape Key e Set Shader Node Param)
exigem conhecimentos ndo explorados nesta sistematica e, por isso, ndo estdo

presentes aqui.

e Show Object (Mostrar Objeto - Figura 135):

- Pode ser utilizado para mostrar objetos ocultos. Torna ativa a
visibilidade de objetos na cena;

- Em sua unica propriedade, Object, define-se o objeto que se deseja
tornar visivel.
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Figura 135 — Bloco Show Object (Mostrar Objeto).

e Hide Object (Ocultar Objeto - Figura 136):

- Com fungdo exatamente contraria ao Show Object, esse bloco pode
ser utilizado para ocultar objetos, desativando a visibilidade desses
objetos na cena;

- Também com uma Uunica propriedade chamada Object, define-se o
objeto que se deseja tornar invisivel.

Figura 136 — Bloco Hide Object (Ocultar Objeto).
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Transform Object (Transformar Objeto - Figura 137):

- Pode ser utilizado para transformar a localizacdo, o tamanho e os
angulos de Rotacdo de objetos ao longo de um periodo de tempo
definido;

- Em Object, define-se objeto que se pretende transformar;

- Em Space, escolhe-se o espaco de coordenadas que sera usado para
transformar o objeto. Existem trés op¢des: World, Local e Parent;

- Em Location, sdo definidas as coordenadas da localizacdo do objeto ao
fim da transformacao;

- Por sua vez, em Rotation, sdo escolhidos os angulos de Rotac¢do do
objeto ao fim da transformacao;

- Em Scale, especifica-se o tamanho do objeto apds transformado.

- Em Duration, define-se o tempo (em segundos) que levard a
transformacdo. Quando o valor for 0 (zero) a transformacdo se dara
imediatamente;

- Nesse bloco, também é possivel utilizar valores de varidveis (opc¢ado
Variable) para as propriedades de transformacao.

Figura 137 — Bloco Transform Object (Transformar Objeto).
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Move To (Mover Para - Figura 138):

Pode ser utilizado para mover um objeto até um elemento alvo, que
pode ser tanto outro objeto 3D como também uma fonte de luz, uma
camera, etc. Apés movido o objeto, este tera as mesmas coordenadas
do alvo;

Em Object, escolhe-se o objeto que se movimentara;

Em Destination, seleciona-se o elemento que servird de alvo para a
movimentacdo do objeto;

Em Duration, define-se o tempo (em segundos) que objeto levard para
realizar o movimento para o novo local. Se definido como 0 (zero) o
objeto simplesmente muda sua posi¢cdao instantaneamente. Pode-se
também utilizar aqui um valor guardado em uma varidvel previamente
criada (opcao Variable).

Figura 138 — Bloco Move To (Mover Para).
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Outline (Contorno - Figura 139):

Pode ser utilizado para controlar o efeito de contorno de objetos
(Object Outlining — item 4.9.5), que surge em volta de determinado
objeto quando clicado ou em qualquer momento desejado;
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Em Object, determina-se o objeto do qual se deseja controlar o
contorno;

Em Operation, escolhe-se a operacdo realizada pelo bloco quanto ao
contorno do objeto escolhido. S3o trés opgdes: Play, que determina o
inicio da visualizacdo do contorno; Stop, que determina o fim a
interrupcao do efeito; Intensity, que determina a intensidade do efeito
de contorno de acordo com um valor numérico que pode ser definido
ali mesmo ou vir de uma variavel (op¢ao Variable).

Figura 139 — Bloco Outline (Contorno).
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Inherit Material (Herdar Material - Figura 140):

Pode ser utilizado para copiar um material de um objeto do cenario e
aplica-lo em outro objeto especifico (Figura 141);

Em Source, escolhe-se o objeto que terd o seu material copiado. Assim
que for definido, surgirad logo abaixo um menu (Material) para definir
qgual dos materiais do objeto em questdo sera copiado. Mesmo que
exista mais de um material criado para cada objeto, apenas um podera
ser escolhido;

Em Destination, define-se qual objeto herdard o material copiado.
Abaixo, em Material, seleciona-se um material especifico desse objeto
gue tera seus atributos substituidos por aqueles copiados.
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Figura 140 — Bloco Inherit Material (Herdar Material).
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Figura 141 — Exemplo de aplicagdo do bloco Inherit Material. Ao clicar em um dos quadrados da paleta

de cores (esquerda), seu material é instantaneamente aplicado a carenagem do carro.

No submenu Operations (Operacdes em inglés) estdo trés blocos responsaveis
pela realizagdo de fungdes muito importantes para a constru¢do de ldgicas de
programacao mais elaboradas para as interacdes. Com eles pode-se realizar diferentes
operagdes com valores numéricos e sequéncias de caracteres, bem como criar variaveis

possiveis de serem utilizadas por outros blocos da linguagem.
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Variable Store (Armazenar Variadvel - Figura 142):

- Pode ser utilizado para salvar um valor numérico (Number) ou uma
sequéncia de caracteres (String) em uma variavel. Por sua vez, os
valores guardados em varidveis podem ser utilizados nos diferentes
campos ja vistos em outros blocos e em operag¢des de célculo;

- Com esse bloco pode-se criar uma nova variavel, ativando a opcao
New variable e definindo um nome a ela (New var.) ou alterar o valor
armazenado em uma variavel ja existente;

- No momento da criacdo de uma nova variavel é possivel ativar
também a opcdo Global, fazendo com que a varidvel em questdo seja
acessivel e possivel de ser modificada em qualquer parte da
programacio dentro da Arvore de Nés;

- No caso de ja existirem varidveis criadas ao longo da légica em
desenvolvimento conectada a esse bloco, o campo Var. name é onde
seleciona-se a que se deseja modificar;

- Em Var. type, define-se o tipo de dado que sera ou estd guardado na
variavel. Podendo ser um valor numérico (Number) ou uma sequéncia
de caracteres (String);

- Ja, o campo abaixo de Var. type é o local onde se determina o valor a
ser assumido pela variavel, quando a execugdo da programacao passar
por esse bloco.

Figura 142 — Bloco Variable Store (Armazenar Variavel).
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e Math Operation (Operacdao Matematica - Figura 143):

- Pode ser utilizado para executar uma operacdo matematica e
armazenar o resultado em uma variavel, previamente criada, do tipo
Number;

- Em Operation, seleciona-se o tipo de operagdao matematica a ser
realizada com os operadores (Operandl e Operand2). Sdo cinco as
opc¢des: Random, que gera um valor aleatdrio maior que o Operandl
e menor que o Operand2; Add, que soma os operadores; Multiply, que
multiplica os operadores; Subtract, que subtrai o Operand2 do
Operand1; Divide, que divide o Operand1 pelo Operand2;

- Tanto o Operand1 como o Operand2 podem ser valores numéricos ou
uma variavel (opcao Variable);

- Em Destination, escolhe-se uma variavel ja criada para armazenar o
valor resultante da operacdo matematica realizada nesse bloco.

Figura 143 — Bloco Math Operation (Operagdo Matematica).

e String Operation (Operacdo de Sequéncias de Caracteres - Figura 144):

- Pode ser utilizado para executar uma operagdo com duas sequéncias
de caracteres (Strings) e armazenar o resultado em uma variavel
previamente criada;

- Em Operation seleciona-se o tipo de operacdo a ser realizada com os
operadores. Dependendo do tipo escolhido, algumas opc¢des abaixo
podem ser adicionadas ou alteradas. S3o cinco as opg¢des de
operagles: Join, que une as sequéncias de caracteres dos dois
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operadores; Find, que procura no Operand2 a sequéncia de caracteres
do Operandl, caso encontre gera o valor -1; Replace, que substitui o
Operand?2 pela unido do Operandl e do Operand3; Split, que divide a
sequéncia do Operandl em duas, usando a sequéncia do Operand2
como marca de divisdo; Compare, que compara os operadores
segundo uma condi¢do determinada (lgual, Diferente, Menor que,
Maior que, Menor ou lgual a, Maior ou lgual a), caso o resultado seja
verdadeiro gera o valor 1 (um) como resultado, caso contrario resulta
no valor O (zero);

Qualquer operador pode ser tanto uma sequéncia de caracteres como
uma variavel (opg¢do Variable);

Em Destination, escolhe-se uma varidvel ja criada para armazenar o
valor resultante da operacdo de Strings realizada nesse bloco.

Figura 144 — Bloco String Operation (Operac¢do de Sequéncias de Caracteres).
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O submenu Sound (Som em inglés) engloba dois blocos responsaveis pelo

controle da reproducado de sons atribuidos a elementos do tipo Speaker (Autofalante).

Play Sound (Reproduzir Som - Figura 145):

Pode ser utilizado para iniciar a reproducdo de um som atrelado a um
autofalante especifico;
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- Em Speaker, seleciona-se o autofalante que sera reproduzido;

- A opcao Do Not Wait, quando ativada, determina que a execucao
passe para os blocos subsequentes, mesmo que a execugao do som
em questdo ainda ndo tenha terminado e ainda o mantém
reproduzido.

Figura 145 — Bloco Play Sound (Reproduzir Som).

1)) speaker

v Do Not Wait

e Stop Sound (Parar Som - Figura 146):

- Pode ser utilizado para interromper a reproduc¢do de um som atrelado
a um autofalante especifico;

- Em Speaker, seleciona-se o autofalante que terd a reproducdo
interrompida.

Figura 146 — Bloco Stop Sound (Parar Som).

ClY) Speaker
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No submenu Network (Rede em inglés), existem blocos relacionados a obtencao

de valores de paginas externas a cena e redirecionamentos para outros links, paginas

web ou arquivos disponiveis dentro do préprio dispositivo visualizador. Apesar de serem

guatro blocos, apenas um (Page Redirect) serd explorado, por ser o Unico de acordo com

os preceitos desta sistematica.

e Page Redirect (Redirecionamento de Pagina - Figura 147):

Pode ser utilizado para redirecionar o navegador web para outra
pagina HTML ou arquivo presente tanto na internet como no préprio
dispositivo visualizador. Esse bloco ndo possui nenhum parametro de
saida e, portanto, marca o final de um caminho, ja que o ambiente em
execucao sera substituido por outra pagina;

Caso se pretenda redirecionar o navegador para uma pagina HTML ou
um arquivo de qualquer outro tipo acessado pela internet, basta
adicionar o endereco eletrénico no campo Url;

Ja para o redirecionamento para arquivos presentes no dispositivo
visualizador (Computador, Smartphone, Tablet), basta colocar no
campo Url seu caminho completo (Ex.: D:\Pasta\Exemplo.pdf);

Esse bloco possibilita por exemplo, a criagdao de uma interagao com um
elemento na cena (Ex.: porta) que quando clicado leve até outro
ambiente também desenvolvido a partir do Blender + Blend4Web.
Essa técnica pode também ser utilizada como forma de otimizacdo do
processamento computacional necessario para a visualizacdo da cena.
Quando o ambiente desenvolvido conter muitos elementos e efeitos
gue o tornem dificil (“pesado”) de ser processado pelo hardware, pode
ser dividido em mais de um ambiente conectados, utilizando esse
bloco e aliviando assim a carga sobre ele;

Observa-se que utilizando caminhos de arquivos off-line do dispositivo
e ndo enderegos eletrénicos (sites), nem sempre o redirecionamento
funciona quando se estd na janela de testes do recurso Fast Preview e,
por isso, recomenda-se realizar uma exportacdo em HTML (item 4.11)
para testa-lo;

Ainda, o caminho Url desejado pode estar guardado em uma variavel.
Nesse caso, utiliza-se a opcdo Variable URL e seleciona-se a variavel
em questao.
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Figura 147 — Bloco Page Redirect (Redirecionamento de Pagina).

https://www.blend4web.com/

J4 o submenu Time (Tempo em inglés) traz quatro blocos que pretendem
controlar questdes relacionadas ao tempo nas interagdes. Aqui é apresentado apenas
um (Delay), enquanto os demais, com funcdes mais especificas, podem ser explorados

pelo usudrio por conta proépria, caso deseje.

e Delay (Atraso - Figura 148):

- Pode ser utilizado para realizar um atraso depois do bloco que o
antecede e antes de ir para o préximo bloco;

- O tempo desse atraso (medido em segundos) é o indicado em Value e
pode ser substituido pelo valor de alguma varidvel, criada
anteriormente com o bloco Variable Store, ativando a opgao Variable
e, depois, escolhendo a variavel desejada.

Figura 148 — Bloco Delay (Atraso).
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O submenu Debug (Depurar em inglés) possui atualmente apenas um bloco

chamado Console Print.

Console Print (Impressdo de Console - Figura 149):

Pode ser utilizado para “imprimir” valores de varidveis em conjunto
com um texto adicional (Message) na aba Console da janela de
ferramentas de desenvolvedor do navegador (Figura 150);

Ele se destina a testes e andlises da execucdo da programacao. A partir
dos valores impressos por esse bloco na aba Console, é possivel saber
o valor exato presente em determinada varidvel no instante em que a
execugao passar por ele;

Em Message, escreve-se a mensagem que se deseja que anteceda a
impressao dos valores;

Abaixo de Message, escolhe-se a varidvel que contém o valor que se
pretende imprimir. Para isso, ela deve ter sido criada anteriormente,
caso contrario é exibida a mensagem No var source no local;

Pode-se ainda imprimir o valor de mais de uma variavel ao mesmo
tempo. Basta clicar no botdo com o simbolo de um “+” (mais) e
escolher, no campo que sera criado, a varidvel que se deseja adicionar.

o n

Subtrai-se uma variavel da lista clicando no botdo “-” (menos) ao lado

dela.

Figura 149 — Bloco Console Print (Impressao de Console).




172

Figura 150 — Exemplo de mensagem impressa (ultima linha) na aba Console do navegador, utilizando o

bloco Console Print.

e
: | Conscle

® T top ¥ [ Preserve log # Show all messages
L L N £ e
B4W LOG: GET EXTENSIOM (WebGL 2) OES_element_index_wint
B4W LOG: LOAD IMAGE le@@x625 ../../tmp/preview/resources/2faallielce7@25b98e758c71495baBf1_:
B4W LOG: LOAD IMAGE l@@@xe25 ../../tmp/preview/resources/url_ade9d58269b61dad@980ec23Ff603at
B4l LOG: LOADED ALL IMAGES
B4W LOG: PHYSICS READY
B4W LOG: LOAD SOUND ../../tmp/preview/resources/Rev motor_95b7@7e50ab2764482a809875C5d54b7.
BaW LOG: LOAD SOUND ../../tmp/preview/resources/328581_frankum_ambience-music-x1 {online-al
B4W LOG: LOADED ALL SOUNDS
B4l LOG: THREAD @: LOADED CALLBACK
B4l LOG: START MLA
B4l LOG: Valores nas variaveis: {"R1":1,"R2":2,"R3":3}

O ultimo submenu, Layout (Leiaute em inglés), agrupa os blocos encarregados

de auxiliar na organizacdo da Arvore de Nés. Possui trés blocos que podem ser utilizados

para facilitar a leitura e o entendimento dos conjuntos de ldgicas de programacao.

e Empty (Vazio - Figura 151):

- N&o executa nenhuma operagao por conta propria, sendo apenas um
bloco de passagem simples. Pode ser utilizado para combinar varios
segmentos de ldgica (“fios”), que possuam o mesmo destino, em um
Unico caminho.

Figura 151 — Bloco Empty (Vazio).
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Reroute (Redirecionar - Figura 152):

Basicamente esses sdo pontos que direcionam a execucdo da logica de
programacao para o ponto de entrada de outro bloco ou outro ponto
Reroute;

Podem ser utilizados para criar estruturas ciclicas, como o exemplo
dado na descricdo do bloco Switch Select (Figura 128), ou para
organizar os caminhos dos blocos, facilitando seu entendimento;
Apds inseridos no espaco da Arvore de N&s, funcionam exatamente
como os pontos de entrada e saida dos blocos, podendo ser unidos por
“fios” de ligagao;

No caso da utilizacdao de mais de um ponto de redirecionamento para
a construcdo de um caminho, os “fios” entre Reroutes apresentam
setas indicando o sentido do fluxo da execugdo pela rota criada. Esse
sentido é sempre de um ponto de saida até um ponto de entrada do
mesmo bloco ou de outro.

Figura 152 — Exemplo de utilizagdo de pontos Reroute no redirecionamento de caminhos.

(] speaker
v Do Not Wait

Frame (Quadro - Figura 153):

E basicamente um quadro redimensionavel que possui um titulo
personalizdvel centralizado no topo;

Pode ser utilizado como moldura para grupos de blocos (Figura 154),
delimitando-os e identificando-os;
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Posiciona-se sempre atras dos outros blocos e é possivel
redimensiona-lo de duas maneiras. A primeira, clicando em um de
seus lados ou cantos e arrastando em qualquer dire¢cdo, ampliando ou
reduzindo o seu tamanho. E a segunda, arrastando os blocos desejados
para dentro do Frame, fazendo com que ele os englobe e ajuste
automaticamente o seu tamanho;

Para mové-lo basta manter pressionado o botdo direito do mouse
sobre ele e, entdo, arrasta-lo para outro local;

Quando o Frame estiver selecionado, o seu titulo pode ser alterado na
propriedade Label, localizada no menu disposto a direita da janela
Node Editor (Figura 155);

E possivel também atribuir um nome (n3o visivel) ao Frame. Basta
alterar o texto da propriedade Name no menu ao lado;

Também hd a possibilidade de atribuir uma cor a cada Frame. Isso o
distingue visualmente um dos outros. Para isso, é necessario ativar a
opcao Color no menu a direita e, em seguida, escolher a cor desejada.

Figura 153 — Bloco Frame (Quadro).
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Figura 154 — Exemplo de um Frame emoldurando um grupo de blocos responsaveis pelo controle de

uma interagdo da cena.

Figura 155 — Menu de propriedades do bloco Frame.

4.10.4. Construgao de Interagdes

Conhecendo-se as funcbes de cada bloco da linguagem visual de programacao
do Blender + Blend4Web, é necessdrio compreender os principios basicos de ligacdo

entre eles para enfim construir as interagdes do ambiente virtual.
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Ligacoes e Fluxo da Execugdao: Como ja mencionado, cada bloco tem
um ponto de entrada (a esquerda) e/ou um ou mais pontos de saida
(a direita) (Figura 156) e é através deles que os blocos recebem e
enviam, respectivamente, informagdes uns para os outros. Por sua
vez, as informacdes percorrem um caminho representado visualmente
por “fios” que se conectam aos blocos justamente pelos pontos de
entrada e saida. Para cria-los, basta clicar em um dos pontos e puxar o
fio até outro. Sendo que nunca serd conectado pontos de mesmo tipo
(Ex.: entrada - entrada ou saida - saida) e a execuc¢do das programacgdes
criadas flui sempre dos pontos de saida para os de entrada;

Figura 156 — Indicagdo dos pontos de entrada e de saida de um bloco.

Ponto \

de Entrada Ponto

Interacao 1 —»

de Saida

Multiplos Conjuntos de Blocos: Ressalta-se que é possivel, dentro do
mesmo espaco de construgdo, criar conjuntos de blocos totalmente
separados uns dos outros. Cada um pode constituir uma interacao do
ambiente (Figura 157). Também é possivel, porém, que os conjuntos
se comuniquem em determinadas partes ou compartilhem variavel
globais, se assim for necessario;

Figura 157 — Exemplo de cinco conjunto de blocos, um para cada interagdo.

Interacao 3 —> l e | 3

Interacido 4 — | ¢

T

Interagao 5
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Necessidade de um Ponto Inicial (Entry Point): uma exigéncia da
linguagem é que cada conjunto de blocos inicie em um Entry Point
(Ponto Inicial) diferente, pois somente um fio pode partir de cada
ponto inicial. Portanto, o Entry Point é essencial e marca o local onde
comeca cada interacao, sendo executado automaticamente assim que
o ambiente é carregado. Recomenda-se que esse seja o primeiro bloco
a ser inserido no espaco de construcdo quando se inicia o
desenvolvimento de uma nova interacao;

Redirecionamento Ciclico: além da necessidade do Ponto Inicial, ha
uma técnica muito Util e, por vezes, necessaria para a construcao dos
conjuntos de blocos, aqui chamada Redirecionamento Ciclico. Ela
consiste na utilizagdao dos pontos Reroute (Redirecionar) para criar um
caminho de retorno de um ponto de saida até um de entrada que
esteja localizado mais atrds, no mesmo bloco ou em blocos anteriores.
Esse caminho contraria o sentido normal da execucdo (esquerda para
direita), gerando um fluxo ciclico. Nota-se ainda que um Unico ponto
de entrada aceita mais de uma ligacdo, o que ndo acontece com os de
saida.

Aplica-se essa técnica em duas distintas situacdes. A primeira, quando
um bloco tem mais de um ponto de saida, como Switch Select
(Interruptor de Selecdo), por exemplo. Entdo, had duas ou mais
possibilidades de seguimento para a execu¢do da programacdo. Se
uma das saidas ficar “aberta”, sem blocos ligados em sua continuacao,
a execuc¢ao pode travar e parar de funcionar, caso ndo seja possivel
avancar pelos demais pontos de saida disponiveis.

Utilizando o exemplo do bloco Switch Select, tem-se ao menos um
ponto de saida acionado pelo cligue em um objeto especificado
(“Objeto” Hit) e outro ponto de saida (Miss) por onde a execucao flui
guando o objeto em questao nao é clicado. Quando a execugdo chega
a esse bloco, em uma fracdo de segundo ele verifica se o objeto esta
sendo clicado e, caso ndo ocorra o clique dentro deste instante de
verificacdo, o programa imediatamente da prosseguimento no ponto
de saida Miss. Nessa situacdo, se ndo houver nenhum caminho ligado
ao ponto Miss, a execuc¢do dessa interacao trava sem que seja possivel
seguir adiante ou reinicia-la. Para resolver isso, é preciso criar, com a
ajuda dos pontos Reroute, um caminho ciclico que conduza a execugdo
do ponto de saida Miss até o ponto de entrada do mesmo bloco (Figura
158). Assim, enquanto ndo houver clique no objeto, o programa é
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levado novamente ao inicio do bloco, realizando a verificacdo da
condicdo continuamente.

Figura 158 — Exemplo de caminho ciclico no bloco Switch Select.

A segunda situacdo que exige a utilizacdo da técnica de
Redirecionamento Ciclico se dd, quando ao fim de um caminho de
blocos, que constitui a légica de uma interacdo ou em qualquer parte
dele, deseje-se fazer com que a execugao retorne a um bloco anterior.
Incluindo a possibilidade de retorno até mesmo ao inicio do conjunto
de blocos. Um exemplo dessa situacao é quando uma interagao pode
ser realizada repetidas vezes. Para isso, cria-se um caminho ciclico do
ponto de saida do ultimo bloco até o primeiro ponto de entrada do
conjunto (Figura 159). Caso esse ciclo ndo exista e o referido ponto de
saida figue em aberto, a interagdao s6 é executada uma vez,
permanecendo seus atores (objetos) no estado que assumiram apds o
ultimo bloco.
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Figura 159 — Exemplo de estrutura de blocos onde o caminho ciclico é utilizado do Ultimo ponto de saida

até o primeiro ponto de entrada.

Como explicado na descricdo do ponto Reroute (item 4.10.3), os fios
entre dois deles apresentam uma seta indicando o sentido do fluxo da
execu¢ao naquele caminho. Todos os caminhos, mesmo os sem seta
indicativa, possuem sentido Unico, sempre de um ponto de saida para
um de entrada. Outra observacdo importante diz respeito a fios que
ficam vermelhos quando se cria um caminho ciclico. Isso pode ser
desconsiderado desde que a programacdo esteja sendo executada
corretamente. Nem sempre é um indicativo de que algo esta errado;

- Esbogo das Interagbes: para usudrios com pouca experiéncia na
linguagem de blocos, recomenda-se que antes de iniciar a inser¢ao de
blocos no programa o usuario esboce um simples esquema que
represente todas as agdes necessdrias para que a interagdo acontega.
Essas agdes nada mais sao do que resultado da decomposi¢ao da
interagdo em partes possiveis de serem representadas com os blocos
apresentados. Para exemplificar, pode-se esquematizar a seguinte
interacdo: iniciar a execu¢do de um som ao clicar em um objeto e ao
clicar nele novamente parar a execucdo desse som, adicionando ao
objeto um contorno indicando que ele é clicavel, enquanto o som
estiver desligado, conforme a Figura 160. E possivel verificar que, apds
a decomposicdo e estruturacdo da interagao, cada pequena a¢ao pode
ser substituida por um bloco da linguagem de programacdo (Figura
161). Isso facilita a visualizagdo do conjunto de blocos a ser construido
(horizontalmente, de preferéncia) no programa.
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Figura 160 — Esquema da interagdo de exemplo decomposta nas menores partes possiveis.

Inicio

!

Mostrar
contorno no .
objeto

v

Tornar o objeto
clicavel
caso se houver

contrario clique
retornar ¢

Iniciar a
execucao
do som

v

Ocultar
contorno no
objeto

!

Tornar o objeto

clicavel
caso se houver
contrario clique
retornar ¢

Parar a
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som
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Figura 161 — Substituicdo das a¢Bes que compdem a interagdo de exemplo por blocos (em cinza) da

linguagem visual de programacao.

Entry
Point
Outline
(Play) < 0
Switch Select
¢ 8 p!
caso se houver
contrario clique
retornar ¢
Play Sound
¢ /N
Outline
(Stop)
Switch Select
't 3 p!
caso se houver
contrario clique
retornar l
Stop Sound O

Como exemplo, é valido demonstrar ao menos uma das tantas
aplicacGes das variaveis (Variables em inglés) na linguagem de blocos
como forma de apresentacdo. A partir do exemplo dado, o usuario
pode aprofundar-se e utiliza-las nos mais diversos arranjos.

Como explicitado na descricdao do bloco Variable Store (Armazenar
Variavel), as varidveis criadas podem ser utilizadas na realizacdo de
operagdes matematicas e em comparagdes entre valores. Como
exemplo, tem-se a seguinte interacdo: acionar a anima¢do de uma
porta abrindo somente apds o clique em dois interruptores distintos.
Para ilustra-la, utiliza-se o mesmo tipo de esquema de acles
decompostas utilizado anteriormente (Figura 162). E, mais uma vez,
substitui-se posteriormente cada acdo por um bloco da linguagem
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visual (Figura 163), construindo (horizontalmente, de preferéncia) o

conjunto de blocos necessario para representar esta interacao dentro
do programa.

Figura 162 — Esquema das a¢Ges da segunda interagao exemplo utilizando variaveis.
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Figura 163 — Substituigcdo das a¢des que compdem a segunda interagdo de exemplo por blocos (em

cinza) da linguagem visual de programacao.
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Math Operation
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Conditional Jump
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R3 éigual a 3.00)
SR
caso contrario retornar até se R3 for
N onde seja necessario para 3.00
que o interruptor faltante
seja possa ser clicado l

Play Animation

4.11. EXPORTACAO

A exportacdo do conteldo criado com os programas Blender e Blend4Web para
um arquivo HTML é a ultima etapa do processo de criacdo de ambientes tridimensionais
virtuais utilizando a tecnologia WebGL. Ela pode ser utilizada somente apds a conclusao
do desenvolvimento do ambiente virtual tridimensional para se criar um arquivo final,

porém recomenda-se que se realizem exportacdes regulares durante a criacdo do
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ambiente, como forma de verificacdo e garantia de que todos os elementos se
comportam como o planejado no arquivo em formato final.

O procedimento de exportacao utilizado neste trabalho tem como objetivo
converter o ambiente criado com os programas Blender e Blend4Web em um Unico
arquivo no formato HTML. Por utilizar a tecnologia WebGL, esse arquivo é executavel
em navegadores web sem a necessidade de qualquer complemento (plug-in) ou de
conexado ativa com a internet. Por isso, pode ser facilmente distribuido e visualizado em
computadores, tablets e smartphones. Para realizar a exportacdo, basta seguir o
caminho Info > File > Export, até a op¢ao Blend4Web (.html) (Figura 164). Abrira, entao,
uma nova janela para a escolha do nome no arquivo e do local no qual ele serd salvo
(Figura 165), restando apenas clicar no botdao B4W Export HTML, no canto superior

direito, para finalizar.

Figura 164 — Caminho até a opg¢do de exportagdo em HTML.
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Figura 165 — Exemplo de tela apresentada para a escolha do nome do arquivo e do local para a

exportacdo.

o
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Estando todos os recursos corretamente configurados, conforme as informacdes
da presente apostila, ndo havera problemas nesse processo. Por isso, a importancia de
se utilizar com frequéncia o recurso Fast Preview e de se realizar exportacdes periddicas
para evitar que existam erros que impecam a exportacdo final. Caso algum recurso
esteja mal ajustado, no entanto, uma mensagem de erro aparecera na tela (Figura 166)
com uma breve descri¢cao do problema e um indicativo de qual elemento esta causando
o erro de exportacio. E possivel ainda obter a descri¢do detalhada do erro e sua provavel
causa acessando o manual online do software Blend4Web na se¢do Add-on > Critical

Export  Errors  (https://www.blend4web.com/doc/en/addon.html#critical-export-

errors).

Figura 166 — Exemplo de tela apresentando um erro encontrado durante a exportagao.



https://www.blend4web.com/doc/en/addon.html#critical-export-errors
https://www.blend4web.com/doc/en/addon.html#critical-export-errors




Capitulo 5

RESULTADOS E TESTES

A fim de testar e comprovar a aplicabilidade das técnicas da sistematica proposta
na criacdo de ambientes tridimensionais virtuais por designers, o autor deste trabalho
desenvolveu ambientes experienciais utilizando todos os recursos demonstrados. Este
capitulo apresenta a andlise dos resultados obtidos a partir destes ambientes-teste e os
desafios enfrentados durante a construcdo, que exigiram ajustes na exposi¢do escrita
de alguns processos.

Os ambientes-teste criados tém por propdsito reunir todos os recursos do
conjunto de programas Blender + Blend4Web, expostos neste trabalho. Para isso, foram
concebidas uma cena interna (uma espécie de museu) e duas externas ao ar livre, uma
de dia e outra a noite, interligadas e navegaveis entre si.

Ainda neste capitulo demonstra-se o atual potencial da tecnologia utilizada no
neste trabalho comparando as mesmas cenas nas tecnologias WebGL e VRML. Sao
discutidas as principais diferengas entre elas e os avangos em termos de qualidade visual
e de interagao.

Por fim retomam-se os requisitos que guiaram a escolha das ferramentas
constituintes da sistematica proposta e verifica-se o cumprimento ou ndo dos mesmos
conforme os resultados obtidos no teste experiencial. Esta verificagcdo pretende validar

a sistemdatica como ferramenta apta a ajudar na resolucdo do problema desta pesquisa.

5.1. AMBIENTES-TESTE

S3do apresentados a seguir os trés ambientes criados utilizando a sistematica

desenvolvida neste trabalho. Cada um concentrou um conjunto de recursos, listados e
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ilustrados na sequéncia. Apds isso sdo relatados os recursos comuns a todas as cenas
criadas com os programas Blender e Blend4Web, que inserem a tecnologia WebGL nos
atuais padrdes de qualidade para ambientes voltados a execucdo por navegadores web.

Para utilizar o maior nimero de recursos possiveis, foram desenvolvidas cenas
em diferentes condicGes. Um ambiente externo durante o dia (Figura 167), outro

ambiente externo durante a noite (Figura 176) e um ambiente interno (Figura 183).

5.1.1. Ambiente externo durante o dia (Figura 167)

Este ambiente contempla recursos de variados tipos: Ambiente (Figura 168),
lluminacdo (Figura 168a), Material (Figura 169), Efeitos ao Ar Livre (Figura 170),
Animacado (Figura 171, Figura 172, Figura 173 e Figura 174), Interagao (Figura 175),

Camera, Som e Otimizacgao.

Figura 167 — Visdo geral do ambiente externo durante o dia.

e [Ambiente] Céu procedural com representacdo visual do sol (Figura
168a);
e [lluminagao] Luz do tipo Sol na mesma posicao da representacdo visual

do sol no céu (Figura 168a);
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e [Ambiente] Sombras projetadas pelos objetos a partir da luz do sol
(Figura 168b);

Figura 168 — Detalhes do céu procedural (A) e das sombras projetadas pela luz do sol (B).

e [Material] Reflexos simples da iluminagdo em objetos com materiais mais
reflexivos (oceano, agua da piscina, bandeira) (Figura 169);

Figura 169 — Detalhes dos reflexos da luz do sol no oceano, na dgua da piscina (esquerda) e na bandeira

(direita).

e [Efeitos ao Ar Livre] Simulagao animada de oceano (Figura 170b);
e [Efeitos ao Ar Livre] Simulacdo estatica de agua na piscina com efeito de
refragao (Figura 170b);

Figura 170 — Detalhes do oceano (A) e da agua da piscina (B).
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e [Animag¢ao] Animacdo de Vértices simulando uma bandeira do Rio
Grande do Sul com vento forte (Figura 171);

Figura 171 — Trés quadros da animacgdo de vértices que simula o tecido de uma bandeira com vento

forte.

e [Animagao] Animagdo de Seguimento de Caminho simulando uma bola
flutuando na agua da piscina (Figura 172);

Figura 172 —Visualizagdo da bola e do caminho (curva) da animagdo ainda no modo de edigdo.

¢ [Animagao] Animacdo de Emissao de Particulas simulando a dgua que sai
do bebedouro (Figura 173);
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Figura 173 — Emissdo de particulas simulando a agua que sai do bebedouro.

e [Animagao] Animacao aplicada a luz do tipo Sol, simulando o pér do sol
(Figura 174);

Figura 174 — Dois quadros da animagdo de po6r do sol.

e [Interagdo] Simulacdo de multiplas cameras através de diferentes

movimentacles pré-configuradas da camera principal, acionadas por
cligues em objetos especificos (bandeira, dgua da piscina, bebedouro,
banco) (Figura 175);
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Figura 175 — Visdo das quatro posi¢gdes da camera quando sdo clicados os objetos: bandeira (A), 4gua da

piscina (B), bebedouro (C), banco (D).

[Material] Diversas texturas aplicadas aos objetos (arvores, gramado,
solo, piso, bancos, bandeira, piscina, pedras);

[Efeitos ao Ar Livre] Representacdo do movimento ocasionado pelo
vento nas arvores (Wind Bending);

[Camera] Camera com estilo de movimentacdo do tipo Target e com
angulos de movimentagao limitados;

[Som] Som de passaros do tipo posicional sendo emitido da arvore de
maior tamanho, onde tem maior intensidade;

[Otimizagdo] Copias de objetos idénticos utilizando a Duplicacdo Ligada
(arvores, bancos, postes, pedras);

[Otimizagdo] Suavizacdo das malhas dos objetos (Smooth);

[Interagdo] Acionamento da animac¢do do pér do sol através de um
gatilho/botdo (banco), movimentando também a camera para uma
melhor visualizagao;

[Interagao] Acionamento das saidas de agua do bebedouro por meio do
cligue em botdes;

[Interagao] Redirecionamento para o ambiente interno com um clique na
porta do edificio.
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5.1.2. Ambiente externo durante a noite (Figura 176)

O ambiente noturno é composto por recursos de: Ambiente (Figura 177 e Figura
178), Efeitos ao Ar Livre (Figura 177, Figura 178 e Figura 179), Objeto (Figura 177),
Material (Figura 179), Animacdo (Figura 180 e Figura 181), Interacdo (Figura 182),

lluminagcdo, Camera, Som e Otimizacao.

Figura 176 — Visdo geral do ambiente externo durante a noite.

e [Ambiente] Céu simples com degradé (Figura 177);

o [Efeitos ao Ar Livre] Simulacdo de estrelas no céu (Figura 177);

o [Objeto] Representacdo da lua com uma esfera posicionada na mesma
direcdo da fonte de luz principal (Figura 177);
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Figura 177 — Detalhe do céu em degradé com as estrelas e a lua.

o [Efeitos ao Ar Livre] Leve efeito de neblina que se intensifica na medida
em que a camera se afasta da cena (Figura 178);

e [Ambiente] Sombras projetadas pelos objetos a partir da luz da lua
(Figura 178);

Figura 178 — Detalhes do efeito de neblina, que fica mais ou menos densa conforme a distancia entra a

camera e o centro do cenario; sombras projetadas pela luz da lua.

e [Material] Reflexos simples da iluminagcdo em objetos com materiais mais

reflexivos (oceano, dgua da piscina) (Figura 179);

e [Efeitos ao Ar Livre] Simula¢do animada de oceano (Figura 179a);

o [Efeitos ao Ar Livre] Simulacdo estdtica de dgua na piscina com efeito de
refracdo (Figura 179b);
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Figura 179 — Detalhes dos reflexos das luzes no oceano (A) e na dgua da piscina (B).

e [Animagdo] Animagdo de Vértices simulando uma bandeira do Rio
Grande do Sul com vento fraco (Figura 180);

Figura 180 — Dois quadros da animagao de vértices, que simula o tecido de uma bandeira com vento

fraco.

¢ [Animacgao] Animacdo de Emissao de Particulas simulando a dgua que sai
do bebedouro (Figura 181);

Figura 181 — Emissdo de particulas simulando a agua que sai do bebedouro.
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[Interagao] Simulacdo de multiplas cameras através de diferentes
movimentacdes pré-configuradas da camera principal, acionadas por
cligues em objetos especificos (bandeira, agua da piscina, bebedouro)
(Figura 182);

Figura 182 — Visdo das trés posi¢des da cdmera quando sdo clicados os objetos: bandeira (A), agua da

piscina (B), bebedouro (C).

[Material] Diversas texturas aplicadas aos objetos (arvores, gramado,
solo, piso, bancos, bandeira, piscina, pedras);

[luminagdo] Diferentes tipos e fontes de iluminacao (lua, postes, spots
no edificio, bebedouro);

[Efeitos ao Ar Livre] Representacdo do movimento ocasionado pelo
vento nas arvores (Wind Bending);

[Camera] Camera com estilo de movimentacdo do tipo Target e com
angulos de movimentacao limitados;

[Som] Som de grilos do tipo posicional, emitido da arvore de maior
tamanho, onde tem maior intensidade;
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[Otimizagao] Cépias de objetos idénticos utilizando a Duplicacdo Ligada
(drvores, bancos, postes, pedras);

[Otimizagdo] Suavizacdo das malhas dos objetos (Smooth);

[Interagao] Acionamento das saidas de agua do bebedouro por meio do
clique em botdes;

[Interagao] Apagar das luzes do edificio quando as luzes de todos os
postes estiverem apagadas;

[Interagao] Apagar e acender das luzes de cada poste individualmente
com um clique neles;

[Interagdo] Redirecionamento para o ambiente interno com um clique na
porta do edificio.

5.1.3. Ambiente interno (Figura 183)

O recursos presentes no ambiente interno sdo divididos nas seguintes

categorias: lluminacdo (Figura 184), Ambiente (Figura 185), Objeto (Figura 186),

Material (Figura 187, Figura 188 e Figura 189), Animacgao (Figura 189), Notas (Figura

190), Camera, Som, Otimizacao e Interacgao.

Figura 183 — Visdo geral do ambiente interno.




198

¢ [lluminagdo] Diferentes tipos e fontes de iluminagdo (sol/janelas, spots,
lampadas do teto) (Figura 184);

Figura 184 — Luzes provenientes do sol (A) e dos spots acima dos expositores (B).

e [Ambiente] Sombras projetadas pelos objetos (Figura 185);

Figura 185 — Sombras projetadas pelos objetos em um dos expositores.

e [Objeto] Objetos com geometrias mais detalhadas (mulher, objeto de
museu digitalizado) (Figura 186);
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Figura 186 — Objetos com um numero significativamente maior de poligonos em relagdo aos demais da

cena.

e [Material] Textura de rugosidade aplicada ao objeto de museu
digitalizado (Figura 187);

Figura 187 — Detalhe da textura de rugosidade aplicada ao objeto de museu digitalizado.

e [Material] Objetos (coroa, taca) altamente reflexivos, que projetam a

imagem de outros objetos (dados, expositor) (Figura 188);
e [Material] Reflexos simples da iluminacdo em certos objetos (pido)
(Figura 189);
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¢ [Animagao] Contorno, aplicado a alguns objetos, que pisca indicando a
presenca de uma interacdo em determinado local (Object Outlining)

(Figura 189);

Figura 188 — Coroa e taga refletindo objetos proximos (dados e expositor), devido aos materiais

altamente reflexivos.

Figura 189 — Reflexos da iluminagdo em objetos como o pido; contorno, no pido, indicando a presenga

de interagdo.

?
A
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e [Notas] Diversas anotac¢des com titulo e descricdo, indicando recursos e
interacdes presentes na cena (Figura 190);

Figura 190 — Anotagdo com titulo (A) e descrigdo (B), explicando uma das interagGes da cena.

@ Clique na chave de luz para que um
interruptor funcional surja na tela.
|
e e

e [Ambiente] Céu procedural (visto pela janela);

e [Material] Diversas texturas aplicadas aos objetos (mulher, piso, rebaixo,
paredes, quadro, pido, bancos, objeto de museu digitalizado);

e [Camera] Camera com estilo de movimentagdo do tipo Hover e com
angulos de movimentagao limitados;

e [Som] Som (musica) do tipo ambiente emitido com a mesma intensidade
em todo o ambiente;

e [Otimizagdo] Copias de objetos idénticos utilizando a Duplicacdo Ligada
(expositores, bancos, janelas, spots, portas);

e [Otimizagao] Suavizacdo das malhas dos objetos (Smooth);

¢ [Animagdo] Animagdo de Objeto simulando o movimento de giro do pido;

¢ [Interagdo] Acionamento das animagdes de abertura das portas ao clicar
nelas e consequente redirecionamento para o ambiente externo, durante
o dia, apos clicar nas duas portas;

e [Interagdo] Acionamento e parada da animagdo do pido através de
cliques nele;

e [Interagao] Interruptor de luzes funcional que surge frente a cdmera ao
clicar no interruptor posicionado ao lado da porta. Ele controla o acender
e o0 apagar das luzes principais da sala e dos spots direcionados para os
expositores;

e [Interagdao] Substituicdo do material da coroa ao clicar nos dados
proximos a ela.
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5.2. COMPARAGAO WEBGL E VRML

Analisando os ambientes-teste que utilizam o WebGL em conjunto com os
mesmos ambientes no formato da tecnologia VRML, de imediato se nota a primeira
limitacdo do VRML em relacdo ao WebGL. Ele exige a instalacdo de um plug-in no
computador em que sera executado, enquanto o WebGL funciona nos principais
navegadores do mercado sem nenhum outro complemento. Esta limitacdo também
impossibilita a execu¢do de arquivos “.wrl” em dispositivos mdveis, a ndo ser que estes
possuam aplicativos especificos para este fim. Tudo isso torna mais dificil a distribuigao
das cenas VRML em relacdo ao WebGL que pode ser executado em uma gama maior de
dispositivos sem grandes dificuldades.

Os ambientes Interno (Figura 191), Externo-Dia (Figura 192) e Externo-Noite
(Figura 193), quando comparados os diferentes arquivos e tecnologias, apresentaram
enormes discrepancias em termos de qualidade de representacao grafica. Sendo clara,
praticamente em todos os aspectos, a superioridade dos arquivos WebGL, gerado com
o auxilio da sistematica elaborada neste trabalho, em relacdo aos outros ambientes

VRML.
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Figura 191 — Visdo geral do Ambiente Interno nos trés diferentes formatos: (a) WebGL, (b) VRML (3ds

Max), (c) VRML (Blender).
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Figura 192 — Visdo geral do Ambiente Externo Dia nos trés diferentes formatos: (a) WebGL, (b) VRML
(3ds Max), (c) VRML (Blender).

-4 Cortona
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Figura 193 — Visdo geral do Ambiente Externo Noite nos trés diferentes formatos: (a) WebGL, (b) VRML
(3ds Max), (c) VRML (Blender).

——
~< Cortona3D

~4 Cortona
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No geral, em todas as trés cenas (Interno - Figura 191, Externo-Dia - Figura 192,
Externo-Noite - Figura 193), quando comparados os ambientes em WebGL e VRML ha
diferencas claras na qualidade visual de geometrias, materiais e iluminacdo.
Visivelmente os ambientes em VRML ficam bem abaixo do nivel de realismo possivel
guando utilizada a sistematica desenvolvida. Aqui o mérito é da tecnologia WebGL que
gerencia e aproveita melhor o processamento gréfico dos atuais computadores,

smartphones e outros (Figura 194).

Figura 194 — Mesmo ambiente (Ambiente Externo Dia) sendo executado em diferentes dispositivos

(Computador e Smartphone).

A discrepancia entre as duas tecnologias em termos de qualidade grafica é
evidente e, no geral, pode ser analisada segundo trés principais aspectos: geometria,
materiais e iluminagao. Além disso, existem diferengas com relagao aos sons, cameras,
animacoes, interacdes e recursos extra (Tabela 10). Ainda sendo possivel realizar um
breve comparativo entre a qualidade geral das cenas e o tamanho final (em megabytes)

dos arquivos dos ambientes VRML e WebGL.
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Tabela 10 — Sintese da comparagdo entre as tecnologias VRML (Blender), VRML (3ds Max) e WebGL.

VRML - .wrl VRML - .wrl WebGL - .html
(Blender) (3ds Max) (Blender + Blend4Web)
Objetos facetados, Objetos mais detalhados e

Geometria

Objetos facetados,
sem alisamento.

sem alisamento.

com superficies suavizadas.
Texturas com cor, contraste

Materiais e

Alguns mapeamentos

Texturas sofrem

compactacdo e ed

imensao fieis as imagens

Texturas de textura ndo
suportados; distorgao. utilizadas.
Texturas
compactadas e
distorcidas.
lluminagao Luzes ndo foram Luzes com aspecto lluminagdo e sombras com
exportadas. mais bruto e sem efeitos de suavizagdo e
produgdo de interagao realistica entre
sombras. diferentes fontes de luz.
Sons Sons do tipo Sons do tipo Sons do tipo Posicional e
Posicional e Posicional e Ambiente, com diversas
Ambiente. Ambiente. propriedades configuraveis.
Cameras Cameras de Cameras de Cameras de diferentes tipos,
diferentes tipos, com | diferentes tipos, com com configuragdes mais
configuragdes configuragdes detalhadas e limitagdo de
simples. simples. movimento.
Animagoes Animagoes simples de | Animagdes simples de Animag0es simples de
deslocamento, deslocamento, objetos, animacGes de
rotacdo e escala de rotacdo e escala de vértices, efeito de emissdo de
objetos 3D, luzes e objetos 3D, luzes e particulas e simulagdo de
cameras. cameras. efeitos de fisica.
Interacdes Interagdo somente a InteragGes pré- Possibilidade de criagdo de
definidas para o interagOes de diversas

nivel de navegagao na
cena.

redirecionamento de
paginas, reprodugdo
de sons, acionamento
por aproximacgao e
clique e controle de
animagdes.

complexidades, através da
linguagem visual de
programacao dos softwares.

AnotacGes; contorno em

Recursos Extra

Sem outros recursos.

Sem outros recursos.

objetos; simulagdo de

estrelas; simulagdes de vento;
representacgdo de sol;

simulagdo de agua; niveis de

qualidade de visualizagdo da
cena; visualizagdo em 3D
anaglifo; visualizagdo para
6culos de realidade virtual;

navegacao através de teclado,

mouse, tela de toque, joystick

e giroscopio.
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5.2.1. Geometria

Em todos os ambientes VRML (Figura 191 (b) e (c), Figura 192 (b) e (c), Figura 193
(b) e (c)) os objetos ndo possuem um alisamento de suas geometrias, o que gera objetos
facetados. J&4 com um melhor aproveitamento do hardware grafico dos dispositivos, o
WebGL consegue processar melhor as geometrias e apresenta-las com um numero de

detalhamento e suavizacdo muito maior (Figura 191 (a), Figura 192 (a), Figura 193 (a)).

5.2.2. Materiais e Texturas

Os materiais e texturas nos ambientes VRML (b, c) também parecem menos
realisticos quando comparados aos cendrios WebGL (a). Muitas das propriedades como
cor, contraste e reflexdo possuem aspecto menos natural no VRML (b, c) e texturas
também sofrem com distor¢des e diminuicdo de resolucdo no momento da exportagao,
utilizando esta tecnologia. A qualidade é ainda pior nos ambientes VRML exportados

somente com o Blender (c).

5.2.3. lluminagao

A forma com que cada tecnologia trabalha com a iluminagdo talvez seja o que
mais chama aten¢do no momento de compara-las. Assim como no tratamento das
geometrias, o WebGL (a) processa melhor as informacdes das diferentes luzes da cena
aplicando efeitos de suavizacdo e tronando mais realista a interacdo dos raios luminosos
com os objetos. Ja o VRML (b, c), apesar de suportar praticamente os mesmos tipos de
luzes que seu sucessor (Spot, Sun, Point), apresenta-as de forma mais bruta, sem
grandes refinos.

Ainda relacionado as luzes, a criacdo de sombras projetadas e reflexos ndo é

suportada pelo VRML, enquanto na sistematica proposta com o WebGL a ativacao
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destes elementos é bastante facilitada, resultando em um aspecto préximo a realidade
fisica.

Observa-se que quase todas as luzes, bem como os céus, ndo estdo presentes
nas cenas exportadas em VRML com software Blender (c). Isso torna por exemplo, a
visualizagao da cena noturna muito semelhante a diurna e diminui ainda mais o nivel de
realismo. Para que fosse possivel visualizar estas cenas no navegador, foi necessario

ativar a opgao Headlight do plug-in Cortona3D, que habilita uma iluminacdo global.

5.2.4. Sons

Quanto aos sons, basicamente se apresentam da mesma maneira no VRML e no
WebGL. Ambos possuem os mesmos tipos de sons (Background e Posicional) e os
executam de forma semelhante. Neste quesito o WebGL leva uma pequena vantagem,
pois o conjunto de programas Blender + Blend4Web oferece um maior nimero de

opcOes para configurar as propriedades dos sons presentes no ambiente.

5.2.5. Cameras

Com as cameras acontece algo muito parecido com os sons. As duas tecnologias
trazem tipos de camera quase idénticos, porém no WebGL elas podem ser configuradas
mais detalhadamente, podendo até limitar seus movimentos com facilidade. A maior
diferenca fica por conta da possibilidade de exportacdo de vdrias cameras nos
ambientes VRML criados com o programa 3Ds Max, enquanto nas cenas WebGL, criadas
através da sistematica desenvolvida, é possivel exportar apenas uma camera por vez,
podendo simular o efeito de multiplas cameras utilizando o bloco Move Camera em uma

l6gica de interagao.
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5.2.6. Animacgoes

Quanto as animacgdes, percebe-se que no VRML somente as animacgdes simples
de deslocamento, rotacdo e escala de objetos 3D, luzes e camera foram exportadas, pois
sdo as unicas suportadas por ele. Enquanto isso nos ambientes em WebGL, além destas,
foi possivel a criacdo de animagdes com modificacdo na malha dos objetos (Animacgao

de Vértices), efeito de emissdo de particulas e simulacdo de efeitos de fisica.

5.2.7. Interacoes

Em se tratando de interagdes, ja era possivel cria-las utilizando o VRML, porém
para o publico leigo em programacao computacional as opgdes se restringem bastante.
Existem programas como o 3ds Max que até hoje trazem ferramentas de simples
insercao de interagdes no ambiente a ser exportado em VRML, mas estas sdao totalmente
pré-definidas e bem limitadas. Chamadas de sensores, elas servem para redirecionar o
ambiente para outras paginas HTML ou ambientes VRML quando se clica em
determinado objeto (Anchor), determinar como serdo reproduzidos os sons presentes
no ambiente (AudioClip), determinar que ao se aproximar de certa regido uma animacao
seja iniciada (ProxSensor), permitir que o clique em determinado objeto acione uma
animacado (TouchSensor) e criar controles de tempo para as animacgodes (TimeSensor).

No WebGL, a situacdo da criacdo de interagdes mais avancadas também era
destinada apenas aqueles que detinham o conhecimento de linguagem escritas de
programacao. No entanto, o complemento Blend4Web, que atua em conjunto software
de manipulacdo tridimensional Blender, tornou mais simples esta tarefa com uma
linguagem visual de bloco de facil compreensdao. Assim, as cenas em WebGL deste
trabalho possuem, no total, quatorze intera¢Ges diferentes, elaboradas somente com
esta linguagem, sem a exigéncia de quaisquer conhecimentos prévios de programacao
computacional. Estas sdao apenas uma amostra das capacidades dos programas, sendo
ainda possivel desenvolver interagdes mais avancadas apenas com novos arranjos das

ferramentas aqui apresentadas.
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5.2.8. Recursos Extra

Verifica-se que outros muitos recursos presentes na sistematica que utiliza o

WebGL nao sdo suportados ou possuem grande complexidade de cria¢do utilizando o

VRML. Estes auxiliam na criacdo de ambientes com maior nivel de realismo e ampliam

as possibilidades de criagao dos usuarios. Sdo eles:

Além

mantiveram

Criacdo de anotagdes com titulo e descrigao;

Criagdo de contorno em objetos;

Simulac¢do de estrelas;

SimulagGes com a influéncia do vento;

Representacdo do sol no céu;

Simulacdo de agua (animada e estatica);

Geracdo automatica de diferentes niveis de qualidade de visualizacdo da
cena (Low, High, Ultra);

Geragdo automatica de visualizacdo em 3D anaglifo?s;

Geragdo automatica de visualizacdo para dculos de realidade virtual
como o Google Cardboard e similares, desde que o dispositivo utilizado
tenha giroscopio;

Navegacdo através de teclado, mouse, tela de toque, joystick e
giroscépio.

dos ja citados, existem dois recursos do padrdao mais antigo que se

praticamente idénticos nesta sistematica de criacdo com o WebGL,

utilizando como comparacdo a criacao de ambientes VRML através do programa 3ds

Max. O primeiro é o Mist ou Fog (Névoa em inglés), que simula uma espécie de neblina

com propriedades configurdveis, que se torna mais densa na medida em que se afasta

a cdmera da cena. Este pode ser observado no ambiente externo durante a noite. O

segundo é a Duplicacao Ligada ou Clone, um recurso de otimiza¢do do software 3ds Max

e suportado pelo VRML, que cria cdpias de objetos aproveitando diversas informacdes

16 0 3D Anaglifo é uma dentre as diversas tecnologias de visualizago tridimensional que pretendem dar
ao usuario uma sensacao de profundidade em imagens planas exibidas por televisores, celulares e tantos
outros aparelhos. Nesta, sdo utilizadas cores complementares, vermelho e azul, na imagem para que
guando visualizada com 6culos especiais, com as mesmas cores uma em cada lente, a pessoa possa
observar a profundidade esperada (SILVA; SCHULER, 2011, p. 03).
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do objeto original. Isso reduz a quantidade de informagdes exportadas, diminuindo
substancialmente a exigéncia de processamento para a visualiza¢cdo. Por isso, sempre

que possivel, este recurso foi utilizado para a realizacdo de cdpias de objetos 3D e luzes.

5.2.9. Qualidade Geral x Tamanho de Arquivo

Por fim, pode-se comparar o tamanho final, em megabytes (MB), dos arquivos
“wrl” (VRML) e “.html” (WebGL) (Tabela 11) desde que sejam feitas algumas
consideracdes. Com excecdo de uma cena (Ambiente Interno — VRML — 3ds Max), os
arquivos exportados em VRML se mostram bem menores que o “.html” (WebGL).
Contudo, deve-se ressaltar que estes sdao constituidos em sua quase totalidade por
objetos 3D, cameras e luzes. Com apenas uma animagao de objeto simples (giro do pido)
na cena do ambiente interno e sem quaisquer interacdes a ndo ser a movimentacdo de
camera. Sem contar a evidente menor qualidade deles, em relagdo ao ambiente WebGL,
em todos os aspectos.

J& o arquivo “.html” traz consigo todos os recursos presentes na sistematica
elaborada, com praticamente o mesmo nivel de exigéncias de conhecimentos prévios
dos usuarios. Ainda, configura o que ha de mais atual neste nicho em nivel comercial e
por tudo isso é justificavel seu maior tamanho. Todavia nota-se que mesmo sendo
maiores, ndo oferecem dificuldade compartilhamento e execucdo, visto que podem ser
distribuidos sem problemas por meios online e offline. Para motivos de ilustragdo, o
maior arquivo HTML, de 36,90 MB, leva em torno de 20 segundos para ser baixado com
uma internet de 15 Mb/s (megabits por segundo) e ocupa apenas 0,92% de um pendrive

com capacidade maxima de 4 GB (gigabytes), por exemplo.

Tabela 11 — Tamanhos, em megabytes (MB), dos arquivos das cenas utilizadas para comparagao.

VRML - .wrl VRML - .wrl WebGL - .html
(Blender) (3ds Max) (Blender + Blend4Web)
Externo Dia 7,70 MB 10,00 MB 19,60 MB
Externo Noite 4,94 VB 4,84 MB 16,70 MB
Interno 18,20 MB 46,20 MB 36,90 MB
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5.3. DIAGRAMAS DAS INTERAGOES

Semelhante ao que foi feito para ilustrar, na sistematica, o conteudo explicativo sobre a
construcdo de interagbes (item 4.10.4), reuniu-se todas as intera¢Oes desenvolvidas
para os ambientes-teste na forma de diagramas. Através deles pretende-se reforcar
como interagem os blocos da linguagem visual do Blender + Blend4Web e fornecer mais
exemplos para que os usudrios possam, entdo, criar suas proprias interagdes. Estes
diagramas ndao acompanham esta disserta¢cdao, mas podem ser encontrados no Apéndice
B do livro digital ‘Ambientes Virtuais 3D Interativos’ (ISBN 978-85-61965-48-8),
elaborado por Bruno Spanevello Pergher e José Luis Farinatti Aymone e que contém na
integra a sistemdtica elaborada durante o presente trabalho de pesquisa.

Cada interacdo é apresentada por uma descricdo e dois diagramas. Ambos os
diagramas demonstram a sequéncia légica dos passos necessdrios para constituir
determinada interacdo no ambiente virtual. Lembrando que o nimero de passos e a
organizacao estrutural dos mesmos podem variar conforme as necessidades e
preferéncias do usuario para com os objetivos da cena. Os conjuntos de intera¢des aqui
expostos servem apenas de exemplo e inspiracao.

O Diagrama de Acoes retrata, de forma literal, todas as acdes individuais que o
programa e o usudrio realizardo para que a referida interacdo aconteca. Ja o Diagrama
de Blocos substitui as acdes executadas pelo programa por blocos disponiveis na
linguagem visual de programacdo dos programas estudados. Por exemplo, a acdo de
Inicio do Diagrama de Acdes é substituida pelo bloco Entry Point (Ponto Inicial) no
Diagrama de Blocos. Ja as acGes de Executar uma Animagdo e de Tornar um Objeto
Clicdvel sdo trocadas pelos blocos Play Animation (Reproduzir Animacdo) e Switch Select
(Interruptor de Sele¢do), respectivamente.

Visando facilitar a relagdo entre as ac¢des literais do programa representadas no
Diagrama de AcOes e os blocos de programacdo que as substituem no Diagrama de
Blocos, estas foram inseridas em blocos preenchidos com a cinza. Assim, diferenciando-
as das acgles executadas pelo usudrio, por meio de cliques por exemplo, que
permanecem sem alteracBes nos dois diagramas ja que sdo interferéncias/entradas

externas e por isso ndo sao representadas por blocos da linguagem.
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No Diagrama de Blocos ainda foram acrescentadas representacdes dos pontos
Reroute (Redirecionar) e do sentido do fluxo da execugdo da programacdo quando
utilizada a técnica de Redirecionamento Ciclico, explicada no item 4.10.4. Ambas as

representagdes sao indicadas também em legenda que acompanha os diagramas.



Capitulo 6

CONSIDERACOES FINAIS

A revisdo bibliografica realizada mostrou clara a importancia da atualizacao
constante dos conhecimentos, habilidades e ferramentas de projeto, de estudantes e
profissionais do Design. Visando acompanhar as evolugdes tecnoldgicas cada vez mais
frequentes. No campo do Design Virtual, os ultimos anos foram repletos de novidades,
devido especialmente a consolidagao da Realidade Virtual e da Realidade Aumentada,
que transformaram significativamente as exigéncias na drea de criagao e distribuicdo de
ambientes tridimensionais virtuais interativos.

Para atender aos atuais requisitos de criacdo, surgiram novas tecnologias de
representacdo e descricdo de cenas 3D virtuais, como o WebGL, que substituiram os
antigos padrdes e linguagens. O WebGL é promissor, sendo mais robusto e adaptavel
gue seus antecessores. Entre as tantas novidades trazidas por ele estdo, o melhor
gerenciamento do processamento grafico dos dispositivos visualizadores, viabilizando a
criacdo de ambientes com maior qualidade visual, e a possibilidade de execu¢ao do
conteddo nos principais navegadores web da atualidade, em computadores,
smartphones e tablets, dispensando o uso de quaisquer complementos (plug-ins).

Quando comparado a tecnologias antecessoras de mesmo propdsito, a descri¢do
de cenas tridimensionais virtuais de forma online ou off-line, os contetdos que utilizam
o padrdo WebGL possuem uma ampla vantagem em relacdo a qualidade final e
flexibilidade de execucdo. Porém, verificou-se que apesar de ser o sucessor natural de
tecnologias como o VRML e representar o estado da arte naquilo em que se prop0e,
ainda é dificultada a criacdo de conteludo WebGL por aqueles que ndo possuem
conhecimentos prévios de programacgdo computacional, como a grande maioria dos

designers.
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Originalmente, e na maioria dos casos ainda hoje, os ambientes virtuais WebGL
eram construidos quase inteiramente através de linguagens escritas de programacgao,
com repentinas manipulacdes de elementos tridimensionais de forma menos textual.
Com o passar do tempo foram surgindo novos softwares que buscaram facilitar o
desenvolvimento de ambientes 3D WebGL por leigos em programacado. Entretanto, a
quase totalidade dos programas encontrados nao atende adequadamente a todos os
requisitos deste trabalho, elaborados com base na revisdo bibliografica prévia.

De todas as 34 ferramentas levantadas, quase todas (33) tiveram de ser
descartadas por ndo cumprirem requisitos obrigatdrios do trabalho. As principais
deficiéncias delas sdao a impossibilidade de criar animacgdes e a falta de recursos de
criacdo de interagcbes. Mesmo quando possuiam estas capacidades, exigiam a
manipulacdo de cédigos de programacdo para tal. Além do mais, muitas sequer
puderam ser avaliadas por completo, por nao funcionaram em algum dos principais
sistemas operacionais (Windows, Mac OS, Linux) em suas versdes atuais ou por apenas
possuirem versdes pagas.

Apesar do grande numero de ferramentas descartadas, restou uma, composta
na verdade por dois softwares (Blender + Blend4Web) que trabalham em conjunto. Ja
de inicio estes softwares se diferenciaram dos demais por possuirem versées
profissionais completas inteiramente gratuitas e com atualiza¢cGes frequentes (em
média a cada 3 ou 4 meses). Além disso, ambos possuem completos manuais online,
amplas e ativas comunidades online que estdo sempre dispostas a ajudar em caso de
duvidas e problemas, até mesmo com a participacao dos desenvolvedores. Também é
possivel encontrar diversos tutoriais em texto e video, que ensinam a utilizar muitos
recursos.

O programa Blender junto ao seu complemento Blend4Web apresentaram
resultados muito satisfatérios ja nos primeiros testes experienciais. Unindo bons
recursos e facilidade de uso por usuarios ja familiarizados com outros softwares de
modelagem 3D, se mostraram capazes de atender todos os seis requisitos obrigatdrios
para a proposicdo da sistematica e trés dos quatros requisitos desejaveis. Deixou a

desejar somente por ndo ser de cddigo-aberto o arquivo HTML final gerado por eles.
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A partir da descoberta e exploracdo do conjunto de programas, ndo restaram
duvidas quanto a sua escolha como solucdo do problema de ligacdo de uma tecnologia
(WebGL) muito mais proxima de programadores e designers. Todos 0s recursos
disponiveis foram testados e classificados conforme os critérios do trabalho para
determinar quais fariam parte da sistematica.

Uma atencao especial foi dada a um recurso muito importante dos programas, a
Linguagem Visual de Programacdo que utiliza blocos de fun¢Ges pré-definidas para a
construcdo das mais distintas interagdes. Este € um recurso chave, que possibilita a
criacdo de interacdes sem a necessidade de conhecimentos prévios de programacao
computacionais.

As capacidades do Blender, com objetos 3D, luzes, cdmeras, animagao e outros,
aliadas as do Blend4Web, com sua facilitada linguagem visual de programacdo e
exportacdo do conteddo empregando o WebGL, surpreenderam positivamente. Com
isso os trés pilares da criacdo de ambientes 3D virtuais (modelagem, animacdo e
interacdo) puderam ser contemplados consistentemente.

Apds um breve tempo de experimentacdo dos programas ja foi possivel iniciar a
construcdo da sistematica que surpreendeu pelo grande nimero de recursos que
puderam ser desvendados e relatados para uso dos designers. Por vezes, durante o
processo de construcao da sistemdtica, o conteudo escrito foi reformulado e novos
recursos foram sendo acrescentados na medida que eram realizadas adequacdes
segundo os requisitos do trabalho.

Outra etapa inesperadamente positiva foi a de entendimento da linguagem
visual de programacao por blocos. O que no inicio deste trabalho vinha se mostrando
como um dos maiores desafios, ou talvez o maior, no final foi superado de forma muito
satisfatoria. Esta boa avaliacdo vem do ndo conhecimento de nenhum outro sistema de
construcdo de ldgicas de interacdo em cenas 3D tdo facilitado e que ofereca tantas
possibilidades. Com apenas algumas horas de uso, um novo usudrio destes programas
pode construir interagdes com grau elevado de complexidade utilizando por exemplo,
saltos condicionais e criacdo de variaveis.

Tendo encontrado uma solucdo facilitada e ao mesmo tempo robusta para o

desenvolvimento das interacdes, ndao foi mais necessdria a criacdo de conjuntos de
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interagdes pré-determinadas para serem disponibilizadas aos usuarios, semelhante aos
sensores do VRML, como o vislumbrado inicialmente. O método elucidado faz com que
designers possam compreender em pouco tempo a manipulacdo de todos os blocos da
linguagem visual através da andlise de exemplos, como os apresentados no Apéndice B
do livro ‘Ambientes Virtuais 3D Interativos’. Ampliando as capacidades de criacdo dos
designers neste quesito, aumentando a autonomia e flexibilidade na geracdo de
interagdes completamente novas.

Apds a estruturacdo de toda a sistematica, buscou-se aprimorar os resultados
obtidos inicialmente e também testar todos os processos descritos, verificando as
relacdes dos recursos quando em conjunto em uma mesma cena. Para isso, trés novos
ambientes-teste foram elaborados unindo agora todos os recursos apresentados. Os
resultados, descritos no Capitulo 5, confirmaram o poder dos softwares e das
tecnologias envolvidas. As poucas desvantagens, como a impossibilidade de exportagao
de mais de uma camera e a dificuldade de utilizacdo da simulacao de efeitos de fisica,
foram contornadas facilmente, com o bloco de interagdo Move Camera e a técnica
experimental de animacdo criada, respectivamente. Provou-se que a sistematica
proposta estd apta para ser utilizada no ambito estudantil e profissional na area do
Design Virtual, sendo composta por todos os recursos presentes nas tecnologias
anteriores e muito mais.

A respeito do programa Blender e seu complemento Blend4Web, as constantes
atualiza¢cGes de ambos, por um lado traz a corre¢ées e adicdo de funcbdes com frequéncia
e por outro, podem alterar parte do exposto neste trabalho. Contudo, pode-se perceber
que as atualizacGes que ocorreram durante o periodo de desenvolvimento desta
pesquisa, ndao alteraram nenhum recurso existente de maneira significativa. Ainda,
tendem a aumentar as possibilidades de uso dos softwares no futuro, em decorréncia
do aprimoramento e acréscimo de fung¢des que buscardo utilizar todas as capacidades
do WebGL.

Resumindo, a busca por uma ligacao frequente entre uma tecnologia muito mais
proxima de programadores (WebGL) e o Design se mostrou um desafio que foi
naturalmente enfrentado conforme as muitas ligacdes e possibilidades entre elas se

salientavam. A descoberta dos softwares Blender e Blend4Web foi fundamental para a
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construcdo de uma sistematica com a qual fosse possivel obter resultados com étimo
nivel de qualidade grafica e funcional.

Ainda, a sistematica resultante deste trabalho foi organizada e publicada na
forma de um livro digital intitulado “Ambientes Virtuais 3D Interativos — utilizando
Blender + Blend4Web” pela Editora Marca Visual com o ISBN 978-85-61965-48-8.
Objetiva-se com este livro, difundir o conhecimento construido de forma didatica a
todos os interessados no assunto.

Espera-se que este trabalho ajude designers e demais interessados, a aperfeicoar
seus ambientes virtuais tridimensionais e inseri-los em um contexto mais atual e
promissor. Vislumbra-se também o potencial da sistemadtica, em especial a parte de
construcdo de interagGes, para estimular o pensamento légico e introduzir conceitos de

programacao de forma pratica e incorporada aos projetos de Design.

6.1. SUGESTOES PARA TRABALHOS FUTUROS

O assunto deste trabalho é extenso e sofre transformacg¢des continuas. Por isso
ainda ha muito a ser explorado, gerando novas pesquisas e auxiliando ainda mais os
designers na criacdo e distribuicdo de ambientes tridimensionais virtuais interativos.

Entdo, sugerem-se algumas possiblidades de pesquisa para futuros trabalhos na area:

e Explorar a aplicacdo da sistematica proposta e do conjunto de softwares
Blender + Blend4Web como um todo, no desenvolvimento de outras
aplicagdes, como jogos digitais;

e Explorar as vantagens e de se utilizar cédigos de programacdo escrita
(script) em conjunto com o sistema visual de criacdo de interagcGes dos
programas Blender e Blend4Web;

e Testar o uso de diferentes dispositivos e ferramentas (Oculos de RV,
Controles de Videogames, QR Codes, Arduino...) para interacdo com os
conteudos criados com os programas Blender e Blend4Web;
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e Se necessario, realizar uma atualiza¢do ou aprimoramento da sistematica
aqui proposta, adicionando novos recursos que estejam adequados aos
requisitos deste trabalho;

e Elaborar novas sistematicas de uso de diferentes programas que possam
ser uteis aos designers, aprimorando suas capacidades de criagao.
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Apéndice A

TABELA DE SOFTWARES ANALISADOS

Tabela contendo a listagem completa dos softwares analisados segundo os

critérios estipulados.
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